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Préface

Le système de bibliothèque modulaire StorageTek SL8500 d'Oracle est une solution de
stockage d'entreprise qui permet le stockage et l'extraction entièrement automatisés de
cartouches de bande.

Ce guide suppose que vous êtes déjà familiarisé avec les modules et les composants de la
bibliothèque SL8500. Pour des informations de présentation et de planification, reportez-vous
au SL8500 Overview and Planning Guide sur : 

http://www.oracle.com/technetwork/documentation/tape-storage-
curr-187744.html

Accessibilité de la documentation
Pour plus d’informations sur l’engagement d’Oracle pour l’accessibilité à la documentation,
visitez le site Web Oracle Accessibility Program, à l'adresse http://www.oracle.com/
pls/topic/lookup?ctx=acc&id=docacc.

Accès aux services de support Oracle
Les clients Oracle qui ont souscrit un contrat de support ont accès au support électronique
via My Oracle Support. Pour plus d'informations, visitez le site http://www.oracle.com/
pls/topic/lookup?ctx=acc&id=info ou le site http://www.oracle.com/pls/
topic/lookup?ctx=acc&id=trs si vous êtes malentendant.

http://www.oracle.com/technetwork/documentation/tape-storage-curr-187744.html
http://www.oracle.com/technetwork/documentation/tape-storage-curr-187744.html
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs


16



Chapitre 1. Installation de StorageTek Library Console · 17

1 
Installation de StorageTek Library Console

StorageTek Library Console (SLC) Oracle est une application offrant une interface graphique
pour configurer, surveiller et gérer la bibliothèque de bandes SL8500.

Remarque:

Les données clients stockées sur les cartouches ne sont jamais disponibles pour SLC ni pour la
bibliothèque. L'interface de données externe des lecteurs de bande est séparée de l'infrastructure de la
bibliothèque.

• Sélection d'une version de SLC
• Téléchargement du pack de supports de SLC
• Installation de la version autonome de SLC
• Installation de la version Web de SLC

Sélection d'une version de SLC
Vous pouvez exécuter les procédures décrites dans ce document avec l'une ou l'autre des
versions suivantes de SLC, sauf indication contraire :

• Autonome : SLC s'exécute à distance à partir de tout système disposant d'une connexion
réseau à la bibliothèque.

• Web : SLC est installé sur un serveur, ce qui permet aux clients individuels d'utiliser un
navigateur pour y accéder.

• Panneau opérateur local : SLC est préinstallé dans la bibliothèque, ce qui permet aux
opérateurs de celle-ci d'accéder à la plupart des fonctions SLC directement à partir de la
bibliothèque.

Téléchargement du pack de supports de SLC
Le pack de supports inclut le serveur SLC Web, le client SLC Web et la version autonome de
SLC.

1. Accédez au Software Delivery Cloud d'Oracle à l'adresse :

http://edelivery.oracle.com

2. Cliquez sur Sign In/Register.

http://edelivery.oracle.com
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3. Lisez les conditions et restrictions. Acceptez ces conditions.
4. Recherchez SLC, puis sélectionnez Oracle StorageTek Library Console. Cliquez sur

Select Platform.
5. Sélectionnez GENERIC (All Platforms), puis cliquez sur Select.
6. Vérifiez qu'Oracle StorageTek Library Console est répertorié sous Selected Products, puis

cliquez sur Continue.
7. Cliquez sur Select Alternate Release. Sélectionnez une version de SLC, puis cliquez sur

Continue.
8. Lisez les conditions et restrictions. Acceptez ces conditions, puis cliquez sur Continuer.
9. Enregistrez le fichier zip. Extrayez le pack de supports dans l'emplacement de votre

choix.

Installation de la version autonome de SLC
1. Avant de procéder à la mise à jour, désinstallez toute version précédente de SLC.
2. Téléchargez le pack de supports de la version autonome de SLC et extrayez-le (voir la

section la section intitulée « Téléchargement du pack de supports de SLC »).
3. Sélectionnez le fichier du programme d'installation de SLC pour votre système

d'exploitation (voir le fichier README du pack de supports).
4. Consultez les informations. Cliquez sur Next.
5. Indiquez l'emplacement où SLC doit être installé. Cliquez sur Next.
6. Indiquez l'emplacement où créer les icônes de raccourci de SLC. Cliquez sur Next.

Remarque:

Sur Solaris, vous ne pouvez pas choisir le répertoire root par défaut. Oracle recommande /u-sr/
bin ou un emplacement semblable.

7. Vérifiez l'exactitude des informations. Cliquez sur Install.
8. Cliquez sur Done.

Plates-formes prises en charge

• Solaris 10 SPARC, Solaris 10 x86
• Windows Server 2008 SP2 64 bits, Windows 2012 Enterprise Server
• Windows 7 SP1 64 bits, Windows 8 64 bits, Windows 8.1 64 bits
• Oracle Unbreakable Linux 5 (2.6.18) 32 bits
• SUSE Enterprise Linux 10.2 (2.6.16) 32 bits

Considérations relatives à la sécurité

SLC communique avec l'interface de bibliothèque principale (PLI) via SSL, qui offre
un chemin de communication sécurisé entre la bibliothèque et la session SLC. Ainsi, un
utilisateur réseau non autorisé ne peut pas surveiller l'activité de la bibliothèque.
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Installation de la version Web de SLC
Seules les mises à jour de la version Web de SLC doivent être installées sur le serveur. Vous
pouvez mettre à jour le serveur SLC Web pendant son exécution. Une fois les mises à jour
installées, elles sont téléchargées automatiquement quand un client lance l'application.

1. Téléchargez le fichier .war du serveur SLC Web et extrayez-le (voir la section la section
intitulée « Téléchargement du pack de supports de SLC »).

2. Déployez le fichier sur le serveur (voir le fichier README du pack de supports).

Configuration requise minimum du navigateur

• Internet Explorer 8 (sur Windows 7 : 64 bits)
• Firefox 17.0.2 ESR (sur Windows 7 : 64 bits)

Considérations relatives à la sécurité

Le logiciel SLC Web est signé numériquement, ce qui garantit qu'il a bien été émis par
Oracle Corporation et qu'il n'a pas été modifié ni endommagé depuis sa création. En tant que
processus Java Web Start, SLC Web comprend les fonctionnalités de sécurité fournies par la
plate-forme Java 2.

Important:

Vous êtes chargé d'implémenter tous les systèmes de sécurité appropriés supplémentaires, tels que pare-
feux et accès utilisateur.
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2 
Connexion à SLC

Remarque:

Après un basculement RE, connectez-vous à l'aide de l'adresse IP ou de l'alias DNS du contrôleur de la
bibliothèque nouvellement actif (le contrôleur de secours précédent).

• Première connexion après l'installation de la bibliothèque
• Connexion à SLC autonome
• Connexion à SLC Web
• Connexion au panneau opérateur local
• Modification d'un mot de passe utilisateur

Première connexion après l'installation de la bibliothèque
1. Avec l'ID utilisateur admin, connectez-vous à SLC avec les huit premiers caractères d'un

mot de passe d'activation fourni par Oracle.
2. Modifiez le mot de passe admin

a. Sélectionnez Tools > User Mgmt
b. Renseignez les champs de mot de passe.
c. Cliquez sur Modify.

Connexion à SLC autonome
1. Pour démarrer SLC sur votre système, vous pouvez :

• Double-cliquer sur l'icône du bureau SLC.
• Sélectionner Start > RunSLConsole ou Launch > RunSLConsole.

2. Entrez vos informations de connexion. Cliquez sur Log on.

Connexion à SLC Web
Pour vous connecter à l'aide d'un navigateur, téléchargez Mozilla Firefox sur le site http://
www.mozilla.com. Sur les plates-formes Solaris, vous pouvez également vous connecter à
SLC Web à l'aide de la ligne de commande.

1. Obtenez l'alias DNS ou l'adresse IP du serveur SLC.
2. Choisissez une méthode de connexion :

http://www.mozilla.com
http://www.mozilla.com
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• Ligne de commande : uniquement disponible sur Solaris. Dans la fenêtre de terminal,
saisissez :

javaws http://server_ID:port_ID/opel/slc.jnlp
• Navigateur : disponible sur Windows ou Solaris. Dans un navigateur sur le système

client, accédez à l'application SLC Web Start :

http://server_ID:port_ID/opel

Où :
• server_ID : adresse IP ou alias DNS du serveur SLC.
• port_ID : ID de port de l'application SLC, généralement 8080.
• opel : nom (racine du contexte) de l'application SLC Web sur le serveur.

3. Cliquez sur Launch Now.
4. Indiquez ce qu'il faut faire avec le fichier slc.jnlp . Sélectionnez l'un des éléments

suivants :
• Open with Java Web Start Launcher pour lancer SLC directement.
• Save to Disk pour enregistrer le fichier slc.jnlp sur votre client et vous connecter à

SLC ultérieurement.
5. Si vous exécutez SLC Web pour la première fois, complétez la boîte de dialogue

d'avertissement de signature numérique (vérifiez l'éditeur et cliquez sur Run).
6. Entrez vos informations de connexion SLC. Cliquez sur Log on.

Connexion au panneau opérateur local
Seul un utilisateur à la fois peut se connecter au panneau opérateur local.

1. Si la fenêtre est vide, touchez l'écran à un endroit quelconque pour activer l'écran Login.
2. Entrez vos informations de connexion.
3. Cliquez sur Log on.

Modification d'un mot de passe utilisateur
Chaque site comprend un ensemble défini d'ID utilisateur : admin (administrateur client),
service (représentant du support technique Oracle) et oem (technicien de service après-vente
tiers). Chaque ID utilisateur se voit affecter un ensemble d'autorisations, qui détermine l'accès
aux utilitaires dans SLC. 

1. Connectez-vous à SLC à l'aide du compte à modifier.
2. Sélectionnez Tools > User Mgmt
3. Complétez les champs suivants : Current Password, New Password et Retype

Password.
4. Cliquez sur Modify.
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3 
Activation des fonctionnalités facultatives

Les fichiers d'activation de matériel permettent d'activer des fonctionnalités facultatives de la
bibliothèque comme les mises à niveau de capacité et le partitionnement. Vous devez installer
un fichier d'activation de matériel pour chaque fonctionnalité que vous avez acquise.

• Téléchargement d'un nouveau fichier d'activation de matériel
• Installation d'un nouveau fichier d'activation de matériel
• Affichage des fichiers d'activation de matériel actuels
• Suppression d'un fichier d'activation de matériel
• Activation des fonctionnalités sur une bibliothèque disposant d'un microprogramme

antérieur à FRS_7.00

Téléchargement d'un nouveau fichier d'activation de matériel

Utilisez cette procédure uniquement pour les bibliothèques avec le microprogramme FRS_7
.00 et versions supérieures. Pour les bibliothèques dont le microprogramme est antérieur à ces
versions, reportez-vous à la section la section intitulée « Activation des fonctionnalités sur
une bibliothèque disposant d'un microprogramme antérieur à FRS_7.00 ».

1. Accédez au Software Delivery Cloud d'Oracle à l'adresse :

http://edelivery.oracle.com

2. Cliquez sur Connexion / Enregistrement.
3. Lisez les conditions et restrictions. Acceptez ces conditions.
4. Recherchez SL8500, puis sélectionnez le fichier d'activation de matériel. Cliquez sur

Select Platform.
5. Sélectionnez GENERIC (All Platforms), puis cliquez sur Select.
6. Vérifiez que le fichier d'activation de matériel approprié est répertorié sous Selected

Products, puis cliquez sur Continue.
7. Sélectionnez la version disponible. Cliquez sur Continuer.
8. Lisez les conditions et restrictions. Acceptez ces conditions, puis cliquez sur Continuer.
9. Enregistrez le fichier zip puis procédez à son extraction dans l'emplacement souhaité.

http://edelivery.oracle.com
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Installation d'un nouveau fichier d'activation de matériel
Remarque:

A compter du microprogramme FRS_8.31 et de SLC 6.25, un unique fichier d'activation de matériel de
partitionnement active le partitionnement dans l'ensemble du complexe de bibliothèques.

1. Connectez-vous à la bibliothèque cible par le biais de SLC.
2. Sélectionnez Tools > Hardware Activation.
3. Cliquez sur l'onglet Install Hardware Activation Keys.
4. Accédez au fichier d'activation de matériel.
5. Vérifiez les détails du fichier d'activation de matériel. Cliquez sur Install.
6. Vérifiez que le fichier d'activation a été correctement installé (voir la section la section

intitulée « Affichage des fichiers d'activation de matériel actuels »).

Remarque:

Des tâches supplémentaires devront éventuellement être réalisées afin de pouvoir utiliser la nouvelle
fonction (voir les sections Chapitre 4, Configuration de la capacité  et Chapitre 5, Partitionnement
de la bibliothèque).

Affichage des fichiers d'activation de matériel actuels
Remarque:

Pour afficher un journal de toutes les activités d'activation matérielle, utilisez l'utilitaire Reports (voir
la section la section intitulée « Affichage de rapports sur la bibliothèque et les périphériques à l'aide de
l'utilitaire de rapports »).

1. Connectez-vous à la bibliothèque cible.

A compter du microprogramme FRS_8.31 et de SLC 6.25, tous les fichiers d'activation
de matériel d'un complexe de bibliothèques sont affichés dans un seul écran. Vous pouvez
vous connecter à n'importe quelle bibliothèque du complexe.

2. Sélectionnez Tools > Hardware Activation.
3. Cliquez sur l'onglet Current Hardware Activation Keys.

Suppression d'un fichier d'activation de matériel
La suppression d'un fichier d'activation de matériel est rarement nécessaire et peut avoir un
impact notable sur le fonctionnement de la bibliothèque. La présence de fichiers d'activation
de matériel supplémentaires dans la bibliothèque ne pose aucun problème (des fichiers
d'activation de capacité dépassant la capacité physique de la bibliothèque par exemple).

1. Connectez-vous à la bibliothèque cible par le biais de SLC.
2. Sélectionnez Tools > Hardware Activation.
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3. Cliquez sur l'onglet Delete Hardware Activation Files.
4. Sélectionnez le fichier d'activation à supprimer.
5. Vérifiez que le fichier d'activation correct est sélectionné et cliquez sur Delete.

Remarque:

Des tâches supplémentaires devront peut-être être réalisées après la suppression du fichier (voir la
section la section intitulée « Suppression d'une partition »).

Activation des fonctionnalités sur une bibliothèque disposant
d'un microprogramme antérieur à FRS_7.00

Pour les bibliothèques SL8500 disposant d'un microprogramme antérieur à la version FRS
_7.00, contactez le support technique Oracle pour activer des fonctionnalités facultatives.
Pour la version FRS_7.00 ou supérieure du microprogramme, suivez les procédures décrites
dans la section la section intitulée « Téléchargement d'un nouveau fichier d'activation de
matériel ».
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4 
Configuration de la capacité

Remarque:

Le contrôleur de la bibliothèque affecte automatiquement la capacité dans une bibliothèque partitionnée.
La capacité peut uniquement être configurée dans une bibliothèque non partitionnée.

• Application de la configuration de capacité par défaut dans une bibliothèque unique
• Création d'une configuration de capacité personnalisée dans une bibliothèque unique
• Création d'une configuration de capacité personnalisée dans une bibliothèque complexe
• Résolution des problèmes de cartouches orphelines causés par les modifications de la

capacité
• Instructions pour l'activation de capacité personnalisée
• Effet sur les hôtes HLI après modification de la configuration de capacité

Application de la configuration de capacité par défaut dans une
bibliothèque unique

Pour les bibliothèques simples non partitionnées avec un seul hôte, la bibliothèque peut
automatiquement activer la capacité une fois le fichier d'activation matérielle installé.

A partir du microprogramme FRS_8.31, la configuration par défaut active la capacité à partir
des unités externes jusqu'à ce que la licence de capacité ait été totalement utilisée.

1. Afin d'éviter les conflits, concertez-vous avec les autres utilisateurs de la bibliothèque
avant de configurer la bibliothèque.

2. A partir d'une SLC autonome ou Web, sélectionnez Tools > Select Active Cells.
3. Cliquez sur l'onglet Design By Library .
4. Cliquez sur Apply Default Capacity.

Remarque:

L'application de la capacité par défaut retire tous les lecteurs du pool de validation de média. Pour
ajouter de nouveau les lecteurs, reportez-vous à la section la section intitulée « Définition du pool de
validation de média ».

Attention:

Si des avertissements s'affichent, NE validez PAS les modifications. Cliquez sur Details >>, puis
effectuez les déplacements de récupération sur les cartouches orphelines (reportez-vous à la section
la section intitulée « Déplacement de cartouches (déplacements de récupération) »).



Création d'une configuration de capacité personnalisée dans une bibliothèque unique

28

5. Reconfigurez les applications hôtes de la bibliothèque afin qu'elles reconnaissent les
modifications (voir la documentation du logiciel hôte).

Création d'une configuration de capacité personnalisée dans
une bibliothèque unique

Remarque:

Vous pouvez cliquer sur Refresh pour ignorer les modifications qui n'ont pas été validées et restaurer
la dernière configuration enregistrée. Vous devez appliquer la configuration pour l'enregistrer dans le
contrôleur de la bibliothèque.

1. Afin d'éviter les conflits, concertez-vous avec les autres utilisateurs de la bibliothèque
avant de configurer la bibliothèque.

2. A partir d'une SLC autonome ou Web, sélectionnez l'onglet Tools > Select Active Cells >
Design By Library.

3. Sélectionnez les zones de la bibliothèque dans les listes déroulantes. Cliquez ensuite sur
Add (pour sélectionner la zone pour activation) ou sur Remove (pour désactiver la zone).

4. Lorsque vous avez terminé la configuration, cliquez sur Apply User Design.

Attention:

Si des avertissements s'affichent, NE validez PAS les modifications. Cliquez sur Details >>, puis
effectuez les déplacements de récupération sur les cartouches orphelines (reportez-vous à la section
la section intitulée « Déplacement de cartouches (déplacements de récupération) »).

5. Reconfigurez les applications hôtes de la bibliothèque afin qu'elles reconnaissent les
modifications (voir la documentation du logiciel hôte).

Icônes de capacité pour une bibliothèque unique

Icône SLC Description

 (rectangle blanc) Inactive : pas de licence pour cet emplacement pour l'instant

 (rectangle blanc avec un triangle) Active : emplacement disposant d'une licence

 (rectangle violet) Sélectionnée : emplacement désigné pour l'activation ou la
désactivation

 (rectangle rouge foncé) Pas d'activation nécessaire : ressource active par défaut

Création d'une configuration de capacité personnalisée dans
une bibliothèque complexe

Remarque:

Vous pouvez cliquer sur Refresh pour ignorer les modifications qui n'ont pas été validées et restaurer
la dernière configuration enregistrée. Vous devez appliquer la configuration pour l'enregistrer dans le
contrôleur de la bibliothèque.
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1. Afin d'éviter les conflits, concertez-vous avec les autres utilisateurs de la bibliothèque
avant de configurer la bibliothèque.

2. A partir d'une SLC autonome ou Web, sélectionnez Tools > Active Cells.

Remarque:

Le fait de cliquer sur Reset Capacity supprime la configuration de capacité actuelle et tous
les lecteurs du pool de validation de média, et nécessite la création d'une nouvelle capacité
personnalisée.

3. Sélectionnez les zones de la bibliothèque (vous pouvez cliquer sur les boutons Rail ou
Library, ou cliquer sur des zones individuelles). Puis, cliquez sur Add (pour l'activation)
ou sur Delete (pour la désactivation).

Les sections en rouge indiquent la capacité active. Les sections en blanc indiquent la
capacité inactive. Le plus petit incrément d'activation de capacité est un quart de rail pour
un maximum de 16 régions par bibliothèque.

4. Lorsque vous avez terminé la configuration, cliquez sur Apply User Design.

Attention:

Si des avertissements s'affichent, NE validez PAS les modifications. Cliquez sur Details >>, puis
effectuez les déplacements de récupération sur les cartouches orphelines (reportez-vous à la section
la section intitulée « Déplacement de cartouches (déplacements de récupération) »).

5. Reconfigurez les hôtes de la bibliothèque afin qu'ils reconnaissent les modifications (voir
la documentation du logiciel hôte).

Icônes de capacité pour un complexe de bibliothèques
Icône SLC Description

 (rectangle blanc)
Non allouée : pas de licence pour cette zone de rail pour l'instant

 (rectangle rouge)
Allouée : zone de rail disposant d'une licence.

 (bordure noire)
Sélectionnée : zone désignée, prête à être activée ou désactivée

Figure 4.1. Exemple d'activation de capacité de complexe de bibliothèques

Légende de la figure :

1. Sélectionne l'ensemble de la bibliothèque
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2. Sélectionne la moitié d'un rail
3. Moitié de rail actif (le rouge indique la capacité allouée)
4. Quart de rail inactif (le blanc indique la capacité non allouée)
5. Quart de rail inactif sélectionné (indiqué par la bordure noire épaisse)

Résolution des problèmes de cartouches orphelines causés par
les modifications de la capacité

La modification de la capacité active de la bibliothèque peut provoquer des erreurs de
cartouche orpheline. Une cartouche devient orpheline lorsqu'elle est inaccessible à l'hôte.

Pour résoudre les problèmes liés aux cartouches orphelines, vous pouvez :

• Générer un rapport sur les cartouches orphelines (voir la section la section intitulée
« Génération des rapports de capacité active »)

• Effectuer un audit de la bibliothèque (voir la section Chapitre 10, Audit de la bibliothèque)
• Effectuer des déplacements de récupération sur une cartouche (voir la section la section

intitulée « Déplacement de cartouches (déplacements de récupération) »)

Pour les bibliothèques partitionnées, voir la section la section intitulée « Résolution des
cartouches orphelines résultant de modifications du partitionnement ».

Instructions pour l'activation de capacité personnalisée
• Sélectionnez les ressources de stockage en constituant des blocs les plus grands possibles

(rails, côtés de la bibliothèque ou parois de la bibliothèque). Evitez de sélectionner des
lecteurs et des baies de stockage individuels.

• Pour un accès optimal aux lecteurs, activez en même temps les parois internes et externes
de la bibliothèque, et activez des emplacements de stockage situés à proximité des lecteurs
de bande.

• Si l'importation et l'exportation rapides de cartouches est une priorité pour vous, activez
des emplacements de stockage situés à proximité des ports d'accès aux cartouches (CAP).

• Evitez de désactivez un emplacement contenant une cartouche ou de déplacer
manuellement une cartouche vers un emplacement inactif. Une cartouche orpheline serait
créée.

Effet sur les hôtes HLI après modification de la configuration de
capacité

Lancez un audit via le logiciel hôte après modification de la configuration de capacité.

Après l'activation de la capacité, la bibliothèque affectée est temporairement mise hors
ligne avant de revenir en ligne. Lorsqu'elle est hors ligne, la bibliothèque cesse d'accepter
de nouvelles tâches entrantes de l'hôte, mais termine les tâches déjà acceptées. Il n'est pas
nécessaire de déconnecter et de reconnecter l'hôte HLI.
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Le contrôleur de la bibliothèque envoie un message asynchrone à tous les hôtes, en les
avertissant que la configuration de la bibliothèque a changé. Les hôtes ACSLS doivent
effectuer un audit d'une bibliothèque non partitionnée pour prendre en compte la nouvelle
capacité. Les hôtes peuvent continuer à traiter les tâches au cours de l'audit.
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5 
Partitionnement de la bibliothèque

Le partitionnement de la bibliothèque réserve des ressources de la bibliothèque (lecteurs,
emplacements et CAP de chargement en masse) à l'usage exclusif d'un hôte spécifié. Le
partitionnement est une fonctionnalité facultative mise en oeuvre à l'aide d'un fichier
d'activation de matériel (voir la section Chapitre 3, Activation des fonctionnalités
facultatives).

Lorsque vous allouez des emplacements à une partition, le contrôleur de la bibliothèque
active automatiquement ces emplacements. Veillez donc à ce que la capacité acquise soit
suffisante pour la conception du partitionnement. Les partitions peuvent être non contigües.

Remarque:

Les CAP de rotation sont une ressource de bibliothèque partagée, de sorte que vous ne pouvez pas
les affecter à une partition (voir la section la section intitulée « Partage de CAP dans une bibliothèque
partitionnée »).

• Partitionnement de la bibliothèque à l'aide de SLC
• Partage de CAP dans une bibliothèque partitionnée
• Résolution des cartouches orphelines résultant de modifications du partitionnement
• Optimisation des performances de la bibliothèque lors du partitionnement

Partitionnement de la bibliothèque à l'aide de SLC
Remarque:

Les modifications du partitionnement n'entrent en vigueur que lorsque vous les appliquez à l'aide de
l'onglet Commit. Pour annuler les modifications non validées, cliquez sur Refresh.

• Ajout d'un ID de partition
• Modification du nom d'une partition
• Suppression d'une partition
• Allocation de ressources dans une partition pour une bibliothèque unique
• Allocation de ressources dans une partition pour un complexe de bibliothèques
• Validation des modifications de partitionnement

Ajout d'un ID de partition

1. Arrêtez toutes les opérations en cours sur l'hôte.
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2. Sélectionnez l'onglet Tools > Partitions > Summary (Step 2).
3. Dans la zone Partition Allocation Summary, cliquez sur Add Partition.
4. Sélectionnez un ID de partition dans la liste déroulante et entrez un nom de partition. Il

n'est pas nécessaire que les ID des partitions se suivent.
5. Cliquez sur OK.
6. Pour une bibliothèque unique, passez à la section la section intitulée « Allocation de

ressources dans une partition pour une bibliothèque unique ».

Pour un complexe de bibliothèques, passez à la section la section intitulée « Allocation de
ressources dans une partition pour un complexe de bibliothèques ».

Suppression d'une partition

Lorsque vous supprimez une partition, toutes les ressources qui lui sont affectées sont
signalées comme disponibles, toutes les connexions hôtes de la partition sont supprimées et
l'ID de la partition est supprimé.

1. Sortez les cartouches de données valides de la partition à supprimer (reportez-vous à la
section intitulée « Déplacement de cartouches (déplacements de récupération) »).

2. Arrêtez toutes les opérations en cours sur l'hôte.
3. Sélectionnez l'onglet Tools > Partitions > Summary (Step 2).
4. Dans le tableau Partition Allocation Summary, sélectionnez la partition à supprimer.
5. Cliquez sur Delete Partition.
6. Pour une bibliothèque unique, cliquez sur l'onglet Design by Library (Step 3). Ensuite,

cliquez sur Verify.

Attention:

Si des avertissements s'affichent, cliquez sur Details >> et effectuez des déplacements de
récupération sur les cartouches orphelines (reportez-vous à la section intitulée « Déplacement de
cartouches (déplacements de récupération) »). Ensuite, vérifiez de nouveau la conception.

Pour un complexe de bibliothèques, la vérification est automatique.
7. Si aucun avertissement ne s'affiche, passez à la section la section intitulée « Validation

des modifications de partitionnement ».

Modification du nom d'une partition

1. Sélectionnez l'onglet Tools > Partitions > Summary (Step 2).
2. Dans le tableau Partition Allocation Summary, sélectionnez la partition à modifier.
3. Cliquez sur Modify Partition.
4. Entrez le nom de la partition. Cliquez sur OK.
5. Passez à la section la section intitulée « Validation des modifications de

partitionnement ».
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Allocation de ressources dans une partition pour une
bibliothèque unique

1. Sélectionnez l'onglet Tools > Partitions > Design by Library (Step 3).
2. Sélectionnez un ID de partition dans la liste déroulante.
3. Sélectionnez les zones de la bibliothèque à l'aide des listes déroulantes. Cliquez sur Add

(pour procéder à l'allocation) ou sur Remove (pour annuler l'allocation).

Remarque:

Vous pouvez affecter des CAP de chargement en masse à une partition. Les CAP de chargement en
masse sont les rectangles les plus grands situés aux extrémités de chaque rail. La lettre S indique un
CAP partagé.

4. Pour affiner la partition, sélectionnez Remove Array ou Add Array dans la deuxième
liste déroulante. Puis, cliquez sur les lecteurs, les baies ou les CAP de chargement en
masse à modifier.

5. Répétez les étapes 2 à 4 pour chaque ID de partition.

Remarque:

Avant de réaffecter une ressource d'une partition à une autre, vous devez supprimer la ressource de la
partition initiale.

6. Une fois la conception de partition terminée, cliquez sur Verify.

Attention:

Si des avertissements s'affichent, cliquez sur Details >> et effectuez des déplacements de
récupération sur les cartouches orphelines (reportez-vous à la section intitulée « Déplacement de
cartouches (déplacements de récupération) »). Ensuite, vérifiez de nouveau la conception.

7. Si aucun avertissement ne s'affiche, passez à la section la section intitulée « Validation
des modifications de partitionnement ».

Spécifications pour le partitionnement d'une bibliothèque
unique

• Vous pouvez créer jusqu'à huit partitions.
• Le plus petit incrément d'emplacement est une baie.
• Le plus petit incrément de lecteur est un lecteur.

Allocation de ressources dans une partition pour un
complexe de bibliothèques

1. Sélectionnez l'onglet Tools > Partitions > Design (Step 3).
2. Sélectionnez une partition dans les options situées dans l'angle supérieur gauche (s'il

n'y a aucune partition, reportez-vous à la section la section intitulée « Ajout d'un ID de
partition »).
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3. Sélectionnez les ressources de la bibliothèque. Vous pouvez cliquer sur les boutons Rail
ou Library, ou cliquer sur des zones individuelles.

Remarque:

Vous pouvez affecter des CAP de chargement en masse à une partition. Les CAP de chargement en
masse sont les rectangles les plus grands situés aux extrémités de chaque rail. La lettre S indique un
CAP partagé.

4. Cliquez sur Add (pour procéder à l'allocation) ou sur Delete (pour annuler l'allocation).
5. Répétez les étapes 2 à 5 pour chaque partition.

Remarque:

Avant de réaffecter une ressource d'une partition à une autre, vous devez supprimer la ressource de la
partition initiale.

6. Passez à la section la section intitulée « Validation des modifications de
partitionnement ».

Spécifications pour le partitionnement d'un complexe de
bibliothèques

• Jusqu'à 16 partitions au total avec un maximum de huit par bibliothèque.
• Le plus petit incrément d'emplacement est un quart de rail (par exemple, la paroi intérieure

du rail 1 sur le côté gauche de la bibliothèque)
• Le plus petit incrément de lecteur est un lecteur.
• Les délimitations de partition peuvent s'étendre sur les PTP.

Validation des modifications de partitionnement

Aucune modification n'est apportée à la configuration du partitionnement tant que ces
procédures ne sont pas terminées.

1. Pour éviter tout conflit de configuration, vous devez rendre la bibliothèque indisponible
pour les autres utilisateurs et arrêter les opérations sur l'hôte avant de valider les
modifications du partitionnement.

2. Sélectionnez l'onglet Commit (Step 4).
3. Cliquez sur Apply.

Attention:

Si des avertissements s'affichent, NE validez PAS les modifications. Cliquez sur Details >>. Puis,
effectuez des déplacements de récupération sur les cartouches orpheline (reportez-vous à la section
la section intitulée « Déplacement de cartouches (déplacements de récupération) »).

4. Mettez à jour toutes les applications hôtes affectées afin qu'elles reconnaissent les
modifications (voir la documentation du logiciel hôte).
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Signification des icônes de partitionnement SLC
Tableau 5.1. Icônes de partitionnement de bibliothèque

Icône Description

 (rectangle blanc)
Disponible — zone de rail non encore affectée à une partition

 (rectangle de couleur)
Allouée — zone de rail affectée à une partition

 (rectangle blanc avec un S)
CAP de chargement en masse partagés

Partitionnement d'un complexe de
bibliothèques uniquement

 (bordure noire épaisse)

Sélectionnée — zone sélectionnée pour modification. Le fait de
cliquer sur Add affecte la zone à une partition. Le fait de cliquer sur
Delete rend la zone disponible pour d'autres partitions.

Figure 5.1. Exemple de partitionnement d'un complexe de bibliothèques

Légende de la figure :

1. Sélectionne l'ensemble de la bibliothèque
2. Sélectionne la moitié d'un rail
3. Moitié de rail alloué à la partition rouge
4. Quart de rail disponible
5. Quart de rail sélectionné (indiqué par la bordure noire épaisse)

Partage de CAP dans une bibliothèque partitionnée
Dans une bibliothèque partitionnée, les hôtes peuvent partager les CAP. Chaque hôte peut
réserver le CAP en fonction de ses besoins, puis le libérer quand il n'en a plus besoin. Un
hôte peut réserver un CAP lorsque celui-ci est vide, fermé, verrouillé et qu'il n'est pas déjà
réservé par une autre partition. Le mode d'insertion automatique de CAP est désactivé dans
les bibliothèques partitionnées car il peut gêner le système de réservation (voir la section
Mode d'insertion automatique).

Si la partition ne libère pas la réservation de CAP et que vous ne pouvez pas terminer
la commande d'insertion ou d'éjection dans ACSLS ou ELS, un administrateur de la
bibliothèque doit annuler la réservation (voir la section la section intitulée « Annulation d'une
réservation de CAP par une partition »).
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Résolution des cartouches orphelines résultant de
modifications du partitionnement

Dans les bibliothèques partitionnées, une cartouche orpheline se trouve dans un emplacement
non alloué à l'hôte d'origine. Des cartouches orphelines peuvent apparaître à la suite d'une
modification de la taille d'une partition, de la suppression d'une partition ou de la migration
d'une cartouche vers une emplacement ou un lecteur qui n'est affecté à aucune partition.

Dans une bibliothèque partitionnée, les cartouches orphelines peuvent entraîner des pertes de
données. Si un hôte repère une cartouche orpheline dans sa partition, il risque de la considérer
comme un volume de travail et d'écraser les données qu'elle contient.

SLC vous avertit lorsque des cartouches orphelines sont identifiées. Pour résoudre les
problèmes liés aux cartouches orphelines, vous pouvez :

• Générer un rapport sur les cartouches orphelines (voir la section la section intitulée
« Génération des rapports de capacité active »).

• Effectuer un audit de la bibliothèque (voir la section Chapitre 10, Audit de la bibliothèque).
• Effectuer un déplacement de récupération sur la cartouche (voir la section la section

intitulée « Déplacement de cartouches (déplacements de récupération) »).

Optimisation des performances de la bibliothèque lors du
partitionnement

• Partitionnez des emplacements de stockage en constituant des blocs les plus grands
possibles (rails, côtés de la bibliothèque ou parois de la bibliothèque). Partitionnez des
rails de bibliothèque complets pour limiter l'utilisation d'ascenseurs. Dans un complexe de
bibliothèques, restreignez chaque partition à une bibliothèque pour limiter le recours aux
PTP.

• Pour un accès optimisé aux lecteurs, activez simultanément les parois intérieures et
extérieures de la bibliothèque.

• Evitez de partitionner des lecteurs et des baies d'emplacements de stockage individuels. Ne
sélectionnez et désélectionnez les ressources individuellement que si vous souhaitez ajuster
une capacité déjà largement définie dans des blocs de plus grande dimension.

• Pour une insertion et une éjection accélérées, partitionnez les emplacements de stockage
à proximité des CAP. Pour un accès accéléré aux données stockées, partitionnez les
emplacements de stockage à proximité des lecteurs.
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6 
Fonctionnement d'un port d'accès aux cartouches

(CAP)

Les ports d'accès aux cartouches (CAP) permettent d'insérer ou d'éjecter des cartouches.
Il existe deux types de CAP : CAP de chargement en masse et CAP de rotation. Pour une
présentation des types de CAP, reportez-vous au SL8500 Overview and Planning Guide.

• Insertion de cartouches à l'aide d'un CAP
• Ejection de cartouches à l'aide d'un CAP
• Verrouillage/déverrouillage d'un CAP
• Annulation d'une réservation de CAP par une partition
• Modification des messages de CAP de chargement en masse
• Activation et désactivation d'un CAP de chargement en masse
• Modes des CAP
• Instructions d'utilisation des CAP

Voir aussi

• la section intitulée « Partage de CAP dans une bibliothèque partitionnée »

Insertion de cartouches à l'aide d'un CAP
Les magasins CAP sont amovibles. Vous pouvez placer des cartouches dans n'importe quel
ordre dans n'importe quel emplacement de magasin ; le moteur du hub doit être orienté vers le
bas et l'étiquette de la cartouche vers vous.

Attention:

Les magasins CAP doivent être debout quand vous chargez les cartouches. Positionner le magasin CAP
sur sa face arrière lors du chargement des cartouches peut provoquer des erreurs de robot en raison d'un
alignement incorrect des cartouches.

Attention:

Pour préserver votre matériel, ne forcez pas pour ouvrir ou fermer le CAP. N'insérez pas de cartouches
non étiquetées et ne placez pas de cartouches à l'envers.

1. Initiez l'opération d'insertion sur l'hôte (voir la documentation du logiciel hôte).



Ejection de cartouches à l'aide d'un CAP

40

2. Lorsque l'indicateur de déverrouillage s'allume, appuyez sur le bouton CAP.
3. Placez les cartouches dans le CAP avec le moteur du hub vers le bas et le code-barres

vers vous.
4. Si vous utilisez un CAP de chargement en masse, fermez la porte du CAP et appuyez sur

le bouton CAP.

Si vous utilisez un CAP de rotation, appuyez sur le bouton CAP pour fermer le CAP.

La bibliothèque déplace la cartouche du CAP vers un emplacement de stockage,
enregistre l'emplacement de la cartouche et envoie l'emplacement à l'hôte. Une fois le
CAP vide, la bibliothèque rétablit son état par défaut.

Utilisation des CAP pour optimiser les performances de la
bibliothèque

• Placez les cartouches qui nécessitent de nombreuses insertions et éjections sur les rails
adjacents aux magasins CAP.

• Chargez les magasins adjacents au rail où les cartouches seront placées.
• Pour mieux identifier les cartouches correspondant aux différents rails, placez des

étiquettes à l'extérieur du CAP pour indiquer le type de cartouche correspondant à chaque
magasin.

• Insérez les cartouches à l'aide du magasin CAP adjacent au rail souhaité, où se trouvent des
lecteurs de bande compatibles.

Ejection de cartouches à l'aide d'un CAP
Attention:

Pour préserver votre matériel, ne forcez pas pour ouvrir ou fermer le CAP.

1. Initiez l'opération d'éjection sur l'hôte (voir la documentation du logiciel hôte).
2. Lorsque l'indicateur de déverrouillage s'allume, appuyez sur le bouton CAP.

La porte du CAP s'ouvre.
3. Retirez toutes les cartouches du CAP.
4. Si vous utilisez un CAP de chargement en masse, fermez la porte du CAP et appuyez sur

le bouton CAP.

Si vous utilisez un CAP de rotation, appuyez sur le bouton CAP pour fermer le CAP.
5. Le Robot poursuit le remplissage du CAP jusqu'à ce que toutes les cartouches que vous

avez spécifiées soient exportées. Répétez les étapes 2 à 4.

Une fois toutes les cartouches éjectées de la bibliothèque, le Robot contrôle le CAP pour
s'assurer qu'il est vide (le robot ne lit pas les étiquettes des cartouches lors des opérations
d'exportation). Ensuite, la bibliothèque supprime l'emplacement de la cartouche de la base
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de données du contrôleur de la bibliothèque et de celle de l'hôte. L'état par défaut du CAP
est rétabli.

Verrouillage/déverrouillage d'un CAP
Normalement, le logiciel hôte déverrouille ou verrouille un CAP. Toutefois, vous pouvez
utiliser la procédure suivante si vous ne parvenez pas à déverrouiller le CAP au moyen de
l'hôte. Un CAP déverrouillé est réservé par la bibliothèque et est indisponible pour tous les
hôtes jusqu'à ce qu'il soit verrouillé.

Remarque:

Si le CAP est réservé par un hôte, l'hôte doit lever la réservation du CAP avant que vous puissiez le
déverrouiller.

1. Tentez de déverrouiller le CAP à l'aide du logiciel hôte.
2. Si vous ne parvenez pas à déverrouiller le CAP au moyen de l'hôte, dans SLC,

sélectionnez Tools > Diagnostics.
3. Développez le dossier CAP. Cliquez sur le CAP à modifier.
4. Cliquez sur l'onglet Access.
5. Dans la liste déroulante Locked, sélectionnez :

• False pour déverrouiller.
• True pour verrouiller.

6. Cliquez sur Apply.

Annulation d'une réservation de CAP par une partition
Si la partition ne libère pas la réservation de CAP et que vous ne pouvez pas terminer la
commande d'insertion ou d'éjection sur l'hôte, effectuez la procédure suivante pour annuler la
réservation de CAP.

Remarque:

Si vous n'effectuez pas toutes les étapes de la procédure, le CAP pourrait devenir indisponible pour toutes
les partitions.

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Développez le dossier CAP et cliquez sur le CAP à redéfinir.
3. Cliquez sur l'onglet Unreserve. Notez l'ID de partition du CAP.
4. Cliquez sur Apply pour annuler la réservation.
5. Si le CAP est verrouillé, déverrouillez-le (voir la section la section intitulée

« Verrouillage/déverrouillage d'un CAP »).
6. Ouvrez le CAP. Retirer les éventuelles cartouches.
7. Fermez le CAP. La bibliothèque vérifie que le CAP est vide. L'état du CAP passe à

"unreserved", ce qui rend le CAP disponible pour l'ensemble des partitions.
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8. Déterminez si vous devez insérer de nouveau les cartouches dans la bibliothèque. Veillez
à insérer les cartouches dans la partition appropriée.

Modification des messages de CAP de chargement en masse
SLC peut afficher un message de notification de CAP basé sur un numéro de message envoyé
depuis ACSLS ou ELS au cours d'une insertion ou d'une éjection. Le message s'affiche sur la
page Systems Details CAP Status après que le CAP se déverrouille (voir la section la section
intitulée « Affichage du statut et des propriétés des périphériques »).

Vous devez configurer le message dans SLC (voir ci-dessous) et envoyer le numéro du
message avec une demande d'insertion ou d'éjection à partir de l'hôte (voir la documentation
du logiciel hôte).

Création d'un message de CAP de chargement en masse

1. Dans SLC, sélectionnez Tools > Configuration.
2. Cliquez sur l'onglet Cap Usage Messages.
3. Cliquez sur Add.
4. Entrez un numéro de message (entre 4 et 99).
5. Entrez le message (80 caractères au maximum). Cliquez sur OK.

Remarque:

Les messages dont la longueur dépasse 18 caractères seront tronqués sur la page d'état de CAP.
Toutefois, dans la page d'état, vous pouvez cliquer sur le message pour afficher une fenêtre
contextuelle du message complet.

6. Cliquez sur Apply.

Modification ou suppression d'un message de CAP de
chargement en masse existant

Remarque:

Vous ne pouvez pas modifier ni supprimer les quatre premiers messages.

1. Dans SLC, sélectionnez Tools > Configuration.
2. Cliquez sur l'onglet Cap Usage Messages.
3. Sélectionnez un message dans la liste, puis cliquez sur Modify ou sur Delete.
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4. Cliquez sur Apply.

Activation et désactivation d'un CAP de chargement en masse
La bibliothèque n'utilisera pas un CAP de chargement en masse désactivé pour insérer ou
éjecter des cartouches. Par exemple, si vous ne parvenez pas à faire fonctionner les CAP
supérieurs, vous devez désactiver les CAP sur le rail 1.

1. Dans SLC, sélectionnez Tools > Configuration.
2. Cliquez sur l'onglet Enable/Disable CAP.
3. Sélectionnez Enable ou Disable pour le CAP.
4. Cliquez sur Apply.

Modes des CAP

Mode d'insertion automatique

Seules les bibliothèques HLI non partitionnées prennent en charge le mode d'insertion
automatique (pour l'activation du mode d'insertion automatique, voir la documentation du
logiciel hôte).

Le mode d'insertion automatique permet à un utilisateur de la bibliothèque de bandes
d'ouvrir un CAP et de réaliser une opération d'insertion sans émettre une demande d'insertion
explicite. En mode d'insertion automatique, les CAP sont déverrouillés et ne nécessitent pas
de réservation par l'hôte.

Mode manuel

Le mode manuel représente la méthode la plus sûre pour réaliser des opérations sur les CAP.
En mode manuel, un CAP est verrouillé par le système par défaut et son voyant est éteint.
Pour lancer une opération d'insertion et d'éjection en utilisant un CAP manuel, vous devez
saisir une demande d'insertion ou d'éjection explicite avant d'appuyer sur le bouton CAP
Open sur le pavé numérique.

Instructions d'utilisation des CAP
• Insérez les cartouches avec une orientation correcte (le moteur du hub doit être orienté vers

le bas et l'étiquette de la cartouche vers vous). Des emplacements dans le CAP peuvent être
omis lors du chargement des cartouches.

• Vérifiez que toutes les cartouches sont correctement étiquetées avant de les insérer dans un
CAP. N'insérez pas de cartouches non étiquetées.

• Pour insérer les cartouches avec plus d'efficacité, chargez les magasins CAP avant
d'émettre la commande d'insertion.

• Si un seul CAP est nécessaire pour accomplir la tâche souhaitée, n'utilisez pas plusieurs
CAP. L'ouverture de plusieurs CAP augmente la durée de l'audit.
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• Si un robot adjacent au CAP n'est pas fonctionnel, ce CAP (ou cette portion du CAP de
rotation) est inaccessible.
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7 
Configuration des lecteurs

• Configuration du nettoyage des lecteurs
• Configuration des numéros de série du tiroir de lecteur
• Optimisation des performances de la bibliothèque via la mise en place des lecteurs

Configuration du nettoyage des lecteurs 
Le nettoyage des lecteurs de bande de la bibliothèque doit se faire régulièrement au moyen
d'une cartouche de nettoyage afin d'éviter l'apparition d'erreurs de lecture ou d'écriture. A
compter du microprogramme FRS_7.00 pour SL8500 et de SLC 5.50, les applications hôtes
(telles que ACSLS ou ELS) doivent gérer le nettoyage des lecteurs.

Toutefois, à compter du microprogramme FRS_8.31 pour SL8500 et de SLC 6.25, les
lecteurs de validation de média seront automatiquement nettoyés par la bibliothèque. Aussi,
une bibliothèque qui utilise la fonctionnalité de validation de média nécessite des cartouches
de nettoyage dans les emplacements système réservés. Vous pouvez insérer des cartouches
de nettoyage de validation de média à l'aide de SLC (reportez-vous à la section la section
intitulée « Importation ou exportation des cartouches de nettoyage et de diagnostic »). En
outre, vous pouvez gérer les cartouches de nettoyage à l'aide de la CLI (reportez-vous à la
section  cleaning de l'Annexe B, Référence de l'interface de ligne de commande).

Configuration du nettoyage des lecteurs gérés par l'hôte

1. Dans SLC, sélectionnez Tools > Configuration. Désactivez le nettoyage automatique
pour la bibliothèque et toutes les partitions. Cliquez sur Apply. (La fonction de nettoyage
automatique est désactivée par défaut).

Remarque:

A compter de la version FRS_7.00 du microprogramme SL8500 et de la version 5.50 de SLC,
l'activation/la désactivation du nettoyage automatique n'est pas disponible via SLC. Cette fonction
est uniquement disponible pour l'administrateur de la bibliothèque via la Interface de ligne de
commande (CLI).

2. Activez le nettoyage automatique à partir de l'hôte.
a. Pour ELS, reportez-vous au manuel ELS System Programmer's Guide pour activer la

fonction de nettoyage.
b. Pour ACSLS, le nettoyage automatique est activé par défaut. Reportez-vous au

manuel ACSLS Administrator's Guide.
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3. Utilisez les commandes ACSLS ou ELS pour insérer des cartouches de nettoyage dans la
bibliothèque.

Remarque:

N'utilisez pas la page Import/Export de SLC pour insérer des cartouches de nettoyage pour le
nettoyage géré par l'hôte.

4. Pour surveiller le statut des cartouches de nettoyage et des lecteurs, utilisez les
commandes ACSLS ou ELS correspondantes.

5. Utilisez les commandes ACSLS ou ELS pour éjecter des cartouches de nettoyage de la
bibliothèque. Vous ne pouvez pas éjecter les cartouches de nettoyage gérées par l'hôte par
le biais de la page Import/Export de SLC.

Configuration des numéros de série du tiroir de lecteur
1. Sélectionnez Tools > Configuration.
2. Cliquez sur l'onglet Drive Tray S/N.
3. Cliquez sur Refresh pour afficher les données actuelles.
4. Pour modifier un numéro de série individuel du tiroir de lecteur :

a. Double-cliquez sur le champ Drive Tray S/N.
b. Saisissez le numéro de série du tiroir de lecteur. Passez à l'étape 6.

5. Pour modifier plusieurs numéros de série de tiroir de lecteur à la fois, vous pouvez
modifier un fichier CSV :
a. Cliquez sur Export puis enregistrez le fichier à l'emplacement de votre choix.
b. Ouvrez le fichier et modifiez uniquement les numéros de série du tiroir de lecteur. Ne

modifiez aucune autre valeur. Enregistrez les modifications.
c. Dans SLC, cliquez sur Import. Localisez le fichier .csv mis à jour, puis cliquez sur

Open.
6. Cliquez sur Apply, puis sur Yes.

Optimisation des performances de la bibliothèque via la mise
en place des lecteurs

• Placez plusieurs types de lecteurs sur chaque rail afin de réduire l'activité de PTP et de
l'ascenseur.

• Regroupez les lecteurs de bande et les cartouches compatibles sur le même rail.
• Pour les applications à fort taux de montage, ne placez pas seize lecteurs sur un rail. Cela

peut augmenter les temps d'attente avant que le robot ne soit disponible. Les applications à
fort taux de montage peuvent nécessiter la mise en cluster de lecteurs sur plus d'un rail.

• Dans une bibliothèque d'unités robotiques redondante, commencez par installer les lecteurs
dans les colonnes extérieures (± 2). Cela permet aux deux robots d'accéder aux lecteurs au
même moment.



Chapitre 8. Gestion des cartouches · 47

8 
Gestion des cartouches

• Déplacement de cartouches (déplacements de récupération)
• Localisation des cartouches
• Affichage des informations de la cartouche
• Importation ou exportation des cartouches de nettoyage et de diagnostic
• Types de cartouches
• Manipulation des cartouches
• Optimisation des performances de la bibliothèque via la mise en place des cartouches

Voir aussi :

• la section intitulée « Insertion de cartouches à l'aide d'un CAP »
• la section intitulée « Ejection de cartouches à l'aide d'un CAP »
• la section intitulée « Résolution des cartouches orphelines résultant de modifications du

partitionnement »
• la section intitulée « Résolution des problèmes de cartouches orphelines causés par les

modifications de la capacité »

Déplacement de cartouches (déplacements de récupération)
Le déplacement d'une cartouche à l'aide de SLC met uniquement à jour l'emplacement de
la cartouche dans la base de données du contrôleur de la bibliothèque. Vous devez réaliser
un audit à partir du logiciel hôte pour mettre à jour la base de données de l'hôte afin d'éviter
l'échec des montages.

Pour afficher un tableau de toutes les cartouches de la bibliothèque, voir la section la section
intitulée « Affichage des informations de la cartouche ».

Attention:

Pour éviter les pertes de données, déplacez les cartouches avec précaution dans les bibliothèques
partitionnées. Déplacer involontairement une cartouche d'une partition à une autre rend la cartouche
orpheline et la nouvelle partition peut écraser les données existantes.

1. Dans SLC, sélectionnez Tools > Diagnostics. Sélectionnez le dossier Library dans
l'arborescence du périphérique.
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2. Cliquez sur l'onglet RcvrMove.
3. Sélectionnez le mode d'emplacement source :

• Pour VOLID, entrez l'ID de volume de la cartouche à déplacer.
• Pour Location, sélectionnez l'emplacement actuel de la cartouche (CAP,

Emplacement, Lecteur, Emplacements réservés).
4. Sélectionnez le type d'emplacement de destination (CAP, Emplacements de stockage,

Lecteur et Emplacements réservés) et sélectionnez l'adresse de destination.

Remarque:

Sélectionnez Drive uniquement si la source est un CAP ou un emplacement réservé.

Ne déplacez pas les cartouches de données dans des emplacements réservés. Les emplacements
réservés doivent uniquement contenir des cartouches de diagnostic ou de nettoyage.

5. Cliquez sur Start.
6. Lancez un audit de la bibliothèque depuis le logiciel hôte pour mettre à jour la base de

données de l'hôte (reportez-vous à la documentation du logiciel de gestion de bandes).

Localisation des cartouches
Vous pouvez localiser une cartouche en fonction de l'ID de volume, de l'adresse de
bibliothèque interne ou de l'adresse HLI.

Pour afficher un tableau de toutes les cartouches de la bibliothèque, voir la section la section
intitulée « Affichage des informations de la cartouche ».

Localisation d'une cartouche par ID de volume

1. Dans SLC, sélectionnez Tools > Diagnostics. Sélectionnez le dossier Library dans
l'arborescence du périphérique.

2. Cliquez sur l'onglet Search.
3. Sélectionnez VOLID.
4. Entrez l'ID de volume (utilisez * comme caractère générique).
5. Dans la liste déroulante Requester, sélectionnez le format des résultats de la recherche :

• default pour afficher les résultats au format de l'adresse interne de la bibliothèque.
• hli0 ou hli1 pour afficher les résultats au format de l'adresse HLI-PRC.

6. Sélectionnez le type de cartouche.
7. Cliquez sur Search.

Localisation d'une cartouche par adresse

1. Dans SLC, sélectionnez Tools > Diagnostics. Sélectionnez le dossier Library dans
l'arborescence du périphérique.

2. Cliquez sur l'onglet Search.
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3. Sélectionnez Location.
4. Sélectionnez les critères de recherche dans la liste déroulante, puis entrez l'adresse (les

caractères génériques sont incorrects).
5. Dans la liste déroulante Requester, sélectionnez le type d'adresse entré dans le champ

Location.
6. Cliquez sur Search.
7. Cliquez sur . . . pour afficher les détails de la cartouche.

Affichage des informations de la cartouche
1. Dans SLC, sélectionnez Tools > Reports.
2. Développez le dossier Status Summary dans l'arborescence de navigation.
3. Sélectionnez Cartridge Table.

Voir aussi

• la section intitulée « Affichage de rapports sur la bibliothèque et les périphériques à l'aide
de l'utilitaire de rapports »

Importation ou exportation des cartouches de nettoyage et de
diagnostic

Attention:

La bibliothèque considère les cartouches de nettoyage utilisées comme nouvelles. Pour préserver votre
matériel, ne réimportez pas des cartouches de nettoyage utilisées.

La bibliothèque stocke les cartouches de nettoyage et de diagnostic dans des emplacements
système réservés. Les applications de bibliothèque hôtes ne peuvent pas accéder à ces
cartouches. La bibliothèque peut exécuter une seule opération d'importation ou d'exportation
de cartouche de diagnostic ou de nettoyage à la fois. Le contrôleur de la bibliothèque réserve
le CAP pour toute la durée de l'opération.

Avant de procéder à l'importation, vérifiez que toutes les cartouches sont correctement
étiquetées. Les identifiants de volume de cartouche de diagnostic doivent comporter
huit caractères dont les deux premiers doivent être DG. Les trois premiers caractères des
cartouches de nettoyage doivent être CLN.

Importation de cartouches de nettoyage ou de diagnostic

Remarque:

A compter du microprogramme FRS_7.00 pour SL8500 et de SLC 5.50, les applications hôtes (telles que
ACSLS ou ELS) doivent gérer le nettoyage des lecteurs. Pour le nettoyage géré par l'application hôte,
n'utilisez pas la procédure suivante. A la place, insérez les cartouches de nettoyage à l'aide du logiciel
hôte.
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1. Vérifiez que la bibliothèque dispose de suffisamment d'emplacements système vides.
La récupération du robot et l'initialisation de la bibliothèque requièrent un emplacement
système vide de chaque côté de la bibliothèque.

2. Vérifiez que le CAP est vide, non réservé par un hôte, fermé et verrouillé (voir la section
la section intitulée « Affichage du statut et des propriétés des périphériques »).

3. Dans SLC, sélectionnez Tools > Diagnostics.
4. Développez le dossier CAP dans l'arborescence du périphérique. Sélectionnez un CAP à

utiliser
5. Cliquez sur l'onglet Import/Export.
6. Dans la section Operation, sélectionnez Import Cleaning/Diagnostic cartridges.
7. Dans la liste "Select favored rail for import", sélectionnez le rail de stockage de votre

choix ou No affinity.

Remarque:

La bibliothèque insère les cartouches de nettoyage et de diagnostic dans les emplacements système
sur le rail sélectionné si l'espace est disponible. Autrement, la bibliothèque répartit les cartouches
entre tous les emplacements système.

8. Cliquez sur Start.
9. Chargez les cartouches dans le CAP (voir la section la section intitulée « Insertion de

cartouches à l'aide d'un CAP »).

Exportation de cartouches de nettoyage ou de diagnostic

1. Vérifiez que la bibliothèque dispose de suffisamment d'emplacements système vides.
La récupération du robot et l'initialisation de la bibliothèque requièrent un emplacement
système vide de chaque côté de la bibliothèque.

2. Vérifiez que le CAP est vide, non réservé par un hôte, fermé et verrouillé (voir la section
la section intitulée « Affichage du statut et des propriétés des périphériques »).

3. Dans SLC, sélectionnez Tools > Diagnostics.
4. Développez le dossier CAP dans l'arborescence du périphérique. Sélectionnez un CAP à

utiliser
5. Cliquez sur l'onglet Import/Export.
6. Sélectionnez le type d'opération d'exportation.
7. Cliquez sur Start.
8. Lorsque la notification de déchargement apparaît, déchargez le CAP (voir la section la

section intitulée « Ejection de cartouches à l'aide d'un CAP »).

Types de cartouches
• Cartouches de données : pour stocker les données des clients.
• Cartouches de diagnostic : utilisées par les représentants du service technique pour

effectuer des tests d'écriture/lecture sur les lecteurs (voir la section la section intitulée
« Importation ou exportation des cartouches de nettoyage et de diagnostic »)
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• Cartouches de nettoyage : utilisées pour nettoyer le chemin de la bande et lire/écrire sur les
têtes des lecteurs de bande (voir la section la section intitulée « Configuration du nettoyage
des lecteurs  »)

Etiquettes de cartouches

Pour plus d'informations sur les standards d'étiquetage de média, reportez-vous à la section
Barcode Technical Brief sur OTN. Toutes les cartouches de la bibliothèque doivent être
munies d'une étiquette externe lisible. Le robot signale une erreur lorsqu'il rencontre une
étiquette illisible.

Les cartouches non étiquetées ne sont pas prises en charge. La bibliothèque éjecte via le
CAP toute cartouche non étiquetée qu'elle identifie. Une cartouche non étiquetée ou de type
inconnu ne peut pas être montée dans un lecteur.

Manipulation des cartouches
Attention:

Une manipulation incorrecte des cartouches peut entraîner une perte de données ou endommager un
composant de la bibliothèque.

• Maintenez les cartouches propres et inspectez-les avant chaque utilisation afin de vous
assurer qu'elles ne présentent aucun dommage.

• N'ouvrez jamais une cartouche.
• Ne manipulez pas la bande qui est hors de la cartouche.
• N'exposez pas directement la bande ou la cartouche aux rayons du soleil, à l'humidité ou

aux champs magnétiques.

Inspection d'une cartouche

Avant d'insérer une cartouche dans un lecteur de bande ou une bibliothèque, inspectez-la
systématiquement. Une cartouche défectueuse ou sale peut endommager un lecteur de bande.
N'utilisez jamais une cartouche endommagée. Recherchez les éléments suivants :

• Poussière ou débris
• Boîtier fissuré ou brisé
• Commutateur de protection d'écriture endommagé
• Présence de liquide dans la cartouche
• Etiquettes mal fixées ou dépassant le bord de la cartouche

Nettoyage de la partie extérieure de la cartouche

Nettoyez la poussière, les salissures et l'humidité de la cartouche à l'aide d'un chiffon non
pelucheux. Utilisez les chiffons de nettoyage de bande Oracle StorageTek pour nettoyer les
cartouches. Ces chiffons sont imprégnés d'alcool isopropylique. Evitez tout contact entre la
solution et la bande ou toute pénétration de solution dans la cartouche.
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Attention:

Risque de dommages des cartouches. N'utilisez pas d'acétone, de trichloroéthane, toluène, xylène,
benzène, cétone, méthyléthylcétone, chlorure de méthylène, éthyldichlorure, esters, acétate d'éthyl ou
autres produits chimiques similaires pour retirer les étiquettes des cartouches ou nettoyer les cartouches.

Stockage des cartouches

Stockez les cartouches dans un environnement propre. Ne retirez pas une cartouche de son
emballage de protection avant de devoir l'utiliser. Utilisez le ruban d'ouverture pour retirer
l'emballage au lieu d'un instrument coupant. Avant d'utiliser une cartouche, assurez-vous
qu'elle ait passé au moins 24 heures dans son environnement d'utilisation.

Optimisation des performances de la bibliothèque via la mise
en place des cartouches

• Regroupez les cartouches et les lecteurs compatibles sur le même rail. Montez les
cartouches dans les lecteurs de bande situés sur le même rail et limitez la distance que
les cartouches doivent parcourir. Limitez les opérations d'ascenseur entre les rails d'une
bibliothèque et les opérations de PTP entre les bibliothèques.

• Assurez-vous que chaque rail dispose d'un nombre suffisant d'emplacements libres, de
cartouches de données, de cartouches de travail et de lecteurs de bande pour pouvoir
supporter les périodes de forte utilisation.

• Retirez les cartouches inactives de la bibliothèque. Retirez les cartouches utilisées plus
rarement des lecteurs de bande et rapprochez celles utilisées plus fréquemment des
lecteurs.

• Chargez les magasins adjacents au rail où les cartouches seront placées.
• Utilisez Library Content Manager (LCM) pour gérer automatiquement les emplacements

vides pour les clients z/OS.
• Utilisez l'option float disponible dans les logiciels de gestion d'hôte (ACSLS et HSC).
• Placez les cartouches qui nécessitent de nombreuses insertions et éjections sur les rails

adjacents à un CAP. Dans les bibliothèques avec des CAP de rotation, placez les cartouches
inactives sur le rail supérieur.
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9 
Validation de média

Pour valider l'intégrité des cartouches T10000 à l'aide de la fonction de validation de média
(MV), vous devez définir un pool de lecteurs T10000C ou D. Ce pool n'est pas considéré
comme une partition, il ne contient aucune cartouche et les hôtes ne peuvent pas accéder aux
lecteurs qu'il contient.

Remarque:

Les lecteurs MV sont nettoyés automatiquement, quel que soit le statut de nettoyage automatique de la
bibliothèque. Un représentant du service Oracle doit s'assurer de la présence des cartouches de nettoyage
dans la bibliothèque.

• Conditions requises pour la validation de média
• Définition du pool de validation de média
• Démarrage ou reprise de la validation de média
• Arrêt d'une validation
• Mise à jour des informations de l'hôte après modification du pool MV

Conditions requises pour la validation de média
• Microprogramme SL8500 FRS_8.31 et SLC FRS_6.25 au minimum
• Pool désigné de lecteurs T10000C ou T10000D au niveau TTI 5.40 ou supérieur
• Carte HBT à grande quantité de mémoire
• STA 2.0 au minimum pour automatiser la validation de média (facultatif)

Définition du pool de validation de média
Remarque:

Les hôtes ne peuvent pas accéder aux lecteurs se trouvant dans le pool de validation de média.

1. Pour un complexe de bibliothèques, vous pouvez vous connecter à n'importe quelle
bibliothèque du complexe pour modifier le pool MV. Assurez-vous que toutes les
bibliothèques du complexe sont en ligne.

2. Vérifiez que les hôtes n'utilisent pas les lecteurs que vous voulez ajouter au pool.
3. Dans SLC, sélectionnez Tools > Media Validation. Cliquez sur l'onglet Slot Selection.
4. Cliquez sur Refresh pour afficher la dernière configuration.
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5. Placez 10 lecteurs au maximum dans le pool. Mettez en surbrillance les emplacements de
lecteur, puis cliquez sur Add ou Remove.

Remarque:

Lors de l'ajout de lecteurs au pool MV, la bibliothèque (ou la partition concernée) est mise hors ligne.

6. Cliquez sur Apply.
7. Si vous utilisez une bibliothèque partitionnée, affectez de nouveau les emplacements

de lecteur supprimés du pool à une partition (voir Chapitre 5, Partitionnement de la
bibliothèque).

8. Reconfigurez les applications hôtes (voir la section intitulée « Mise à jour des
informations de l'hôte après modification du pool MV »).

Icônes du pool de lecteurs de validation de média
Icône de lecteur SLC Signification

Emplacement de lecteur vide

L'emplacement contient soit un type de lecteur non valide, soit un type de
lecteur correct dans un état non valide

Type de lecteur correct (T10000C ou T10000D) dans un état valide

Numéro de partition de l'emplacement de lecteur

L'emplacement de lecteur se trouve dans le pool de validation de média

Démarrage ou reprise de la validation de média
Vous ne pouvez valider qu'une cartouche à la fois par session SLC. Pour automatiser
le processus, utilisez StorageTek Tape Analytics 2.0 ou supérieur (reportez-vous à la
documentation relative à STA).

1. Connectez-vous à la bibliothèque. Pour un complexe de bibliothèques, connectez-vous à
la bibliothèque contenant le lecteur qui sera utilisé pour la validation.

2. Dans SLC, sélectionnez Tools > Media Validation. Cliquez sur l'onglet Media
Validation.

3. Sélectionnez un lecteur. Si aucun lecteur n'est répertorié, reportez-vous à la section la
section intitulée « Définition du pool de validation de média ».

Remarque:

Si vous ne parvenez pas à sélectionner un lecteur, celui-ci est peut-être de type incorrect, ou son état
est non valide.

4. Sélectionnez une cartouche dans la liste ou entrez un VOLSER dans le champ d'étiquette
de la cartouche.

5. Sélectionnez un type de validation (reportez-vous à la section Types de validation pour
une description).
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Remarque:

Sélectionnez Complete Resume ou Complete Plus Resume pour reprendre une validation complète
à l'endroit où elle s'est arrêtée.

6. Cliquez sur Start. La validation commence si le chargement de la cartouche aboutit.

Une fois la validation terminée, la cartouche retourne dans son emplacement d'origine.
Si l'emplacement d'origine est perdu, la bibliothèque déplace la cartouche vers un
emplacement système pour la récupération de l'hôte.

Types de validation

Type de
validation

Description Démarrage Durée approximative par
cartouche

Basic Verify Montage et démontage pour déterminer si la
MIR est illisible ou désynchronisée

S/O 2 minutes

Standard
Verify

Lit :

- 1 000 enregistrements à partir du début de
la bande

- Le wrap contenant l'EOD, puis le contenu
de l'EOD

- Les wraps les plus à l'extérieur et les bandes
du haut et du bas pour vérifier les bords

Début de la bande 30 minutes maximum

Rebuild MIR Lit les données à la vitesse de la bande Position non
valide dans la
MIR

T10000C — 5 heures

T10000D — 9 heures

Complete BOT Lit les données à la vitesse de la bande Début de la bande T10000C — 6 heures

T10000D — 9 heures au
maximum

Complete Plus
BOT1

Vérifie le CRC de validation d'intégrité des
données pour déterminer s'il existe

Début de la bande T10000C — 6 heures pour
les ratios de compression
inférieurs à 2.5:1.

T10000D — 9 heures pour
les ratios de compression
inférieurs à 3:1.

1Un système de gestion de la décompression et Oracle Key Manager sont requis.

Arrêt d'une validation
Si l'hôte demande une cartouche en cours de validation, la validation s'arrête. Vous pouvez
également utiliser SLC pour arrêter la validation.

1. Connectez-vous avec le compte utilisateur qui a lancé la validation.
2. Dans SLC, sélectionnez Tools > Media Validation.
3. Sélectionnez l'onglet Media Validation.
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4. Cliquez sur Stop.

Une fois la validation interrompue, la cartouche est renvoyée dans son emplacement
d'origine. Si l'emplacement d'origine est perdu, la bibliothèque déplace la cartouche vers
un emplacement système pour la récupération de l'hôte.

Mise à jour des informations de l'hôte après modification du
pool MV

• Pour ACSLS, vous devez lancer la reconfiguration après la modification du pool MV.
Utilisez l'utilitaire config drives <panel_id>. Pour plus d'informations, reportez-
vous au ACSLS Administrator's Guide.

• Pour ELS, aucune action n'est requise après la modification du pool MV. Les hôtes ELS
sont reconfigurés automatiquement.

Effet de la modification du pool MV sur les hôtes HLI

Après l'ajout de lecteurs au pool MV, la bibliothèque (ou la partition affectée) est mise hors
ligne. Les messages "Configuration Changed", "LSM Ready", puis "Not Ready" sont envoyés
aux hôtes affectés par la bibliothèque. ELS retire automatiquement les lecteurs déplacés
vers le pool MV depuis sa configuration. ACSLS met automatiquement à jour l'état des
lecteurs déplacés vers le pool MV sur hors ligne, mais ACSLS nécessite que vous lanciez la
reconfiguration.

Après la suppression de lecteurs d'un pool MV, la bibliothèque et les partitions demeurent
en ligne. S'il s'agit d'une bibliothèque non partitionnée, les emplacements de lecteur sont
disponibles immédiatement pour les hôtes. Les hôtes ELS démarrent la reconfiguration, mais
les hôtes ACSLS nécessitent que vous lanciez la reconfiguration. S'il s'agit d'une bibliothèque
partitionnée, vous devez allouer l'emplacement de lecteur retiré du pool MV à une partition
(voir la section Chapitre 5, Partitionnement de la bibliothèque).
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10 
Audit de la bibliothèque

Un audit permet de vérifier les emplacements des cartouches et de mettre à jour de la base de
données de la bibliothèque, qui contient l'ID de volume, l'emplacement actuel et l'état vérifié
pour chaque cartouche.

La bibliothèque effectue automatiquement un audit après la fermeture d'une porte d'accès ou
son initialisation.

Remarque:

Le lancement d'un audit depuis SLC permet uniquement de mettre à jour la base de données de la
bibliothèque. Vous devez lancer l'audit depuis l'hôte pour mettre à jour la base de données de l'hôte.

• Exécution d'un audit physique de l'ensemble de la bibliothèque
• Exécution d'un audit physique sur une plage de cellules
• Exécution d'un audit vérifié sur une plage de cellules
• Signification de l'indicateur d'audit

Voir aussi

• la section intitulée « Affichage des informations de la cartouche »

Exécution d'un audit physique de l'ensemble de la bibliothèque
Remarque:

Vous ne pouvez pas arrêter un audit physique après son démarrage.

Pour un audit de l'ensemble de la bibliothèque, le robot vérifie tous les emplacements (de
stockage, CAP, de lecteur, réservés), met à jour la base de données des cartouches et fait
passer l'état "verified" des emplacements de cartouche à true.

Ne lancez pas cet audit pendant les périodes d'activité de pointe (voir Effets d'un audit de
l'ensemble de la bibliothèque ci-dessous). L'audit dure environ 0,5 seconde par emplacement
de cartouche.

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Sélectionnez le dossier Library dans l'arborescence du périphérique.
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3. Cliquez sur l'onglet Audit.
4. Sélectionnez Yes dans la section Entire Library (sélectionnez No dans les sections

Physical Audit et Verified Audit).
5. Cliquez sur Audit.

Effets d'un audit de l'ensemble de la bibliothèque

Bien qu'un audit de l'ensemble de la bibliothèque se déroule en tâche de fond et qu'il
n'interrompe pas les opérations de la bibliothèque, il requiert le partage des ressources du
robot. Il est possible que, lors de l'exécution de l'audit, les opérations de la bibliothèque
prennent un peu plus de temps. Il peut y avoir un léger délai lors du traitement d'une demande
qui requiert des informations sur un emplacement qui n'a pas encore été audité car la
bibliothèque auditera l'emplacement avant de traiter la demande.

Exécution d'un audit physique sur une plage de cellules
Remarque:

Vous ne pouvez pas arrêter un audit physique après son démarrage.

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Sélectionnez le dossier Library dans l'arborescence du périphérique.
3. Cliquez sur l'onglet Audit.
4. Sélectionnez Yes dans la section Physical Audit (sélectionnez No dans les sections Entire

Library et Verified Audit).
5. Dans les listes déroulantes, sélectionnez l'adresse interne des emplacements de début et

de fin de l'audit.
6. Cliquez sur Audit.

Exécution d'un audit vérifié sur une plage de cellules
Un audit vérifié valide l'état d'un emplacement de cartouche ou d'une plage d'emplacements
dans la base de données des cartouches. Si une adresse de cartouche présente false comme
état de vérification, un audit physique de cet emplacement est effectué et la base de données
des cartouches est mise à jour.

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Sélectionnez le dossier Library dans l'arborescence du périphérique.
3. Cliquez sur l'onglet Audit.
4. Sélectionnez Yes dans la section Verified Audit (sélectionnez No dans les sections Entire

Library et Physical Audit).
5. Dans les listes déroulantes, sélectionnez l'adresse interne des emplacements de début et

de fin de l'audit.
6. Cliquez sur Audit.
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Signification de l'indicateur d'audit
La SLC affiche un indicateur de progression et le message ''Audit in progress'' pour indiquer
qu'un audit est en cours d'exécution. Lorsque vous voyez cet indicateur, n'ouvrez pas la porte
d'accès de la bibliothèque. Cette action entraînerait le redémarrage de l'audit.

L'indicateur d'audit s'affiche uniquement lorsqu'un audit est initié automatiquement (la
porte d'accès à la bibliothèque a été ouverte et fermée, la bibliothèque mise sous tension ou
réinitialisée). L'indicateur n'affiche pas les audits initiés depuis la SLC ou l'hôte.
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11 
Affichage des informations sur la bibliothèque et

les périphériques

SLC affiche uniquement les dernières informations sur la bibliothèque et les périphériques
enregistrées dans la base de données du contrôleur de la bibliothèque. Cliquez sur Refresh
pour mettre à jour SLC avec les dernières données de configuration.

• Affichage du statut opérationnel de la bibliothèque
• Affichage des propriétés et de la configuration de la bibliothèque
• Affichage du statut et des propriétés des périphériques
• Affichage du type du panneau opérateur local
• Signification des indicateurs de statut de la bibliothèque et des périphériques dans SLC

Voir aussi

• Chapitre 12, Génération de rapports et de journaux
• la section intitulée « Affichage des informations de la cartouche »

Affichage du statut opérationnel de la bibliothèque
1. Dans SLC, sélectionnez Tools > System Detail. Sélectionnez le dossier Library dans

l'arborescence du périphérique.
2. Cliquez sur l'onglet Status.
3. Sélectionnez un onglet secondaire :

• General - affiche l'état de fonctionnement actuel de la bibliothèque. Ces valeurs sont
mises à jour à chaque opération d'un hôte, opération en arrière-plan ou opération de
l'utilisateur. Vous pouvez mettre à la bibliothèque en ligne ou hors ligne à partir de cet
onglet (reportez-vous à la section intitulée « Mise hors ligne de la bibliothèque » et à la
section intitulée « Mise en ligne de la bibliothèque »).

• Complex - affiche l'état de fonctionnement actuel d'un complexe de bibliothèques.
• Status Module - affiche les alertes de statut de la bibliothèque. Cette fonctionnalité est

uniquement disponible si le service est actif sur la bibliothèque. Voir aussi la section
intitulée « Effacement des alertes de statut de la bibliothèque ».

• HLI - affiche le statut actuel des ports de l'interface HLI sur la bibliothèque. Ces
informations incluent le socket TCP/IP local, l'adresse IP locale, le statut de connexion,
le statut du port ainsi que les transmissions envoyées et reçues à partir de la connexion.
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• Internal Networks - affiche le statut des ports.

Affichage des propriétés et de la configuration de la
bibliothèque

1. Dans SLC, sélectionnez Tools > System Detail. Sélectionnez le dossier Library dans
l'arborescence du périphérique.

2. Cliquez sur l'onglet Properties.
3. Sélectionnez un onglet secondaire :

• General - affiche la configuration physique, mécanique, logique et réseau de la
bibliothèque.

• Complex - affiche les informations relatives à l'adresse IP d'un complexe de
bibliothèques.

• Library Controller - affiche les détails du contrôleur de la bibliothèque, y compris le
numéro de série et les versions du microprogramme.

• Drive Controller - affiche les détails du contrôleur des lecteurs, y compris le numéro
de série et les versions du microprogramme.

Affichage du statut et des propriétés des périphériques
Vous pouvez afficher des informations sur les CAP, les lecteurs, les robots, Redundant
Electronics, l'alimentation électrique et la porte de sécurité. L'utilitaire de rapports de SLC
permet également d'afficher des informations sur les périphériques (reportez-vous à la section
la section intitulée « Affichage de rapports sur la bibliothèque et les périphériques à l'aide de
l'utilitaire de rapports »).

1. Dans SLC, sélectionnez Tools > System Detail.
2. Sélectionnez le dossier du périphérique dans l'arborescence du périphérique.
3. Pour des informations sur le statut et les propriétés, développez le dossier du

périphérique. Sélectionnez un périphérique.
4. Sélectionnez un onglet. Reportez-vous aux informations ci-dessous correspondant au

périphérique sélectionné.

Remarque:

Pour une bibliothèque de CAP de chargement en masse, sélectionnez le dossier de CAP et cliquez
sur Status pour afficher tous les CAP en même temps et les messages d'insertion/éjection de CAP
de chargement en masse (voir la section la section intitulée « Modification des messages de CAP de
chargement en masse »).

Onglets de statut et de propriétés des périphériques

• Onglet Status - affiche l'état de fonctionnement actuel du périphérique
• Onglet Properties - affiche les informations de configuration du périphérique, y compris

le numéro de série et les niveaux de microprogramme actuels
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Onglets Drive

Seuls les lecteurs disposent des onglets d'informations système suivants.

• Display - affiche les données de réseau, le Virtual Operator Panel (VOP) pour les lecteurs
T10000 et T9840D, et le statut du voyant du lecteur.

• Drive Tray - affiche le statut actuel d'un tiroir de lecteur.

Statut du lecteur Signification

Empty Aucune cartouche n'est montée dans le lecteur.

Unloaded La cartouche est prête pour être démontée.

Ready La cartouche est chargée.

NotCommunicating La carte de contrôleur ne peut pas communiquer avec le lecteur.

rewindUnload Le lecteur effectue des opérations de rembobinage et de déchargement.

Statut de la carte Redundant Electronics

"A" indique l'emplacement de carte de gauche et "B" indique l'emplacement de carte de droite
dans la vue arrière de la bibliothèque.

• hbca : contrôleur de la bibliothèque, emplacement A (gauche)
• hbcb : contrôleur de la bibliothèque, emplacement B (droit)
• hbta : contrôleur des lecteurs, emplacement A (gauche)
• hbtb : contrôleur des lecteurs, emplacement B (droit)

1. Statut de la carte Signification

Duplex: Software ready,
switch possible

Le contrôleur actif de la bibliothèque fonctionne correctement.

Not installed La carte n'est pas installée dans la bibliothèque.

Ok La carte de contrôleur active ou de secours fonctionne correctement.

Pre-standby: software not
ready

La carte de contrôleur de secours de la bibliothèque charge le code de secours
et n'est pas disponible pour un basculement automatique ou manuel pour le
moment.

Standby: software ready La carte de contrôleur de secours de la bibliothèque fonctionne correctement et
peut être utilisée pour un basculement automatique ou manuel.

Affichage du type du panneau opérateur local
1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Sélectionnez la bibliothèque dans l'arborescence de périphérique, puis cliquez sur

l'onglet OpPanel.

Le type est indiqué au bas de l'écran. W indique un panneau Windows et DL ou OL, un
panneau Linux.
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Signification des indicateurs de statut de la bibliothèque et des
périphériques dans SLC

Icône SLC Signification

Normal

Avertissement

Erreur

Statut d'intégrité d'un périphérique

Ces informations se trouvent dans l'arborescence de périphérique de la page System Details
and Diagnostics.

• Normal - le périphérique de la bibliothèque fonctionne normalement
• Avertissement - le périphérique est hors ligne ou fonctionne en mode dégradé
• Erreur - le périphérique présente un dysfonctionnement

Statut de communication

La partie inférieure gauche de tous les écrans SLC affiche le statut de communication entre
SLC et le contrôleur de la bibliothèque.

• Normal - SLC communique normalement avec le contrôleur de la bibliothèque
• Avertissement - le serveur met plus de 10 secondes à répondre
• Erreur - le serveur met plus de 30 secondes à répondre

Après environ 30 à 60 secondes de perte de communication avec le contrôleur de la
bibliothèque, l'écran de contrôle des pulsations devient gris, puis rouge et affiche :

Heartbeat message not received from the library controller.

Fermez la session de SLC, puis reconnectez-vous afin de restaurer la communication.

Statut d'intégrité de la bibliothèque

Ces informations se trouvent dans la partie inférieure droite de tous les écrans de SLC.

• Normal - tous les périphériques de la bibliothèque fonctionnent normalement
• Avertissement - un ou plusieurs périphériques de la bibliothèque sont hors ligne ou

fonctionnent en mode dégradé
• Erreur - un ou plusieurs périphériques de la bibliothèque présentent un dysfonctionnement

Une fois un problème de périphérique résolu, l'indicateur d'intégrité de la bibliothèque
passe à "Avertissement". L'indicateur ne passera pas sur "Normal" tant que la bibliothèque
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est hors ligne. Si les conditions d'alerte de périphérique ou de statut indiquent plusieurs
problèmes, l'indicateur d'intégrité reflète le plus grave.
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12 
Génération de rapports et de journaux

• Affichage de rapports sur la bibliothèque et les périphériques à l'aide de l'utilitaire de
rapports

• Génération des rapports de capacité active
• Génération de rapports de partitionnement (bibliothèque unique seulement)
• Génération de fichiers de diagnostic pour le support technique Oracle
• Contrôle des événements de bibliothèque

Voir aussi
• Chapitre 11, Affichage des informations sur la bibliothèque et les périphériques
• la section intitulée « Affichage des informations de la cartouche »

Affichage de rapports sur la bibliothèque et les périphériques à
l'aide de l'utilitaire de rapports

Chaque sortie de rapport est une photographie statique des informations au moment de la
génération du rapport. Cliquez sur Update dans l'angle supérieur droit pour actualiser les
informations.

Remarque:

L'exécution de plusieurs instances de SLC sur la même station de travail peut entraîner des incohérences
dans les données des rapports. Il est recommandé qu'un seul utilisateur à la fois génère des rapports SLC.

1. Dans SLC, sélectionnez Tools > Reports.
2. Dans l'arborescence de navigation, développez un dossier de rapports. Sélectionnez un

rapport.

Vous pouvez accéder à des rapports supplémentaires à partir de l'utilitaire Partitions ou
de l'utilitaire Active Capacity. L'utilitaire System Details permet également d'afficher
des informations sur les périphériques.

Tableau 12.1. Rapports SLC
Dossier Rapport Description

Evénements de lecteur Affiche les événements et les erreurs de lecteur. Ce rapport peut contenir jusqu'à
70 entrées.

Statistiques

Evénements de média de
lecteur

Affiche les événements d'erreur de cartouche liés à un lecteur. Ce rapport peut contenir
jusqu'à 500 entrées.
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Dossier Rapport Description

Evénements généraux Affiche un récapitulatif des événements opérationnels de la bibliothèque.

Evénements de média Affiche les erreurs de cartouche. Ce rapport peut contenir jusqu'à 2000 entrées.

Journal Journal d'événements Affiche un journal des événements selon leur gravité (reportez-vous à Gravité).

Tableau des cartouches Affiche l'emplacement, le type de média et l'étiquette des cartouches, ainsi que des
informations de statut.

Tableau de réservation
de périphériques

Affiche des informations sur la réservation de l'ascenseur, du robot et du PTP.

Tableau des lecteurs Affiche l'emplacement, le type et le numéro de série des lecteurs.

Récapitulatif des CAP Affiche l'emplacement des CAP.

Récapitulatif des
cartouches

Affiche l'emplacement, le type de média et l'étiquette de toutes les cartouches de la
bibliothèque.

Récapitulatif des lecteurs Affiche l'emplacement, le type et le numéro de série des lecteurs, ainsi que des
informations sur le code et les périphériques.

Informations sur la
bibliothèque

Affiche la configuration et la version du code de la bibliothèque physique, ainsi que son
état.

Récapitulatif du
statut

Récapitulatif du robot Affiche l'adresse et l'état du robot.

Détails du CAP/lecteur/
robot

Affiche des informations d'identification, la version du code et le statut des
périphériques.

Détails du statut

Détails de la
bibliothèque

Affiche la configuration et la version du code de la bibliothèque physique, ainsi que son
état.

Versions matérielles Affiche le numéro de série de FRU des cartes de contrôleur, des CAP, des robot et des
PTP.

Versions

Versions logicielles Affiche la version du code des cartes de contrôleur, des CAP, des robot et des PTP.

Journal d'audit Journal d'audit des
fonctionnalités

Affiche l'ensemble des activités d'activation de fonctionnalités pendant la durée de vie de
la bibliothèque. Pour afficher uniquement les fichiers d'activation de matériel courants,
reportez-vous à la section intitulée « Affichage des fichiers d'activation de matériel
actuels ».

Message
d'utilisation de
CAP

Messages Affiche les messages d'utilisation de CAP. Pour définir les messages, reportez-vous à
la section la section intitulée « Modification des messages de CAP de chargement en
masse »

Génération des rapports de capacité active
1. Dans SLC, sélectionnez l'onglet Tools > Select Active Cells > View Reports .
2. Sélectionnez un rapport :

• Cartridge and Cell Media Summary - affiche les adresses des emplacements et les
numéros de série des volumes (volsers) des médias dans la zone de capacité active

• Orphaned Cartridge Report - affiche la liste détaillée de toutes les cartouches
orphelines

Génération de rapports de partitionnement (bibliothèque
unique seulement)

1. Dans SLC, sélectionnez l'onglet Tools > Partitions > Reports.
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2. Sélectionnez un type de rapport dans le menu :
• Cartridge Cell and Media Summary — affiche les adresses d'emplacement et les

numéros de série de volume (volsers) du média dans chaque partition
• Orphaned Cartridge Report — affiche les adresses d'emplacement et les numéros de

série de volume (volsers) des cartouches orphelines
• Partition Summary — affiche les ressources allouées à chaque partition
• Partition Details — affiche les détails d'un ID de partition spécifique

Génération de fichiers de diagnostic pour le support technique
Oracle

Votre représentant du support technique Oracle peut vous demander de capturer et de
transférer le fichier de la base d'informations de gestion (MIB) ou d'instantané du journal.

Génération du fichier SNMP MIB de la bibliothèque

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Cliquez sur le dossier Library dans l'arborescence de navigation.
3. Cliquez sur l'onglet TransferFile.
4. Sélectionnez SNMP MIB. Cliquez sur Transfer File.
5. Enregistrez le fichier avec l'extension .txt.
6. Envoyez le fichier par e-mail à votre représentant du support technique Oracle.

Génération du fichier d'instantané du journal de la
bibliothèque

Vous devez enregistrer le journal dans les 15 minutes qui suivent sa génération. Le fichier est
chiffré.

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Cliquez sur le dossier Library dans l'arborescence de navigation.
3. Cliquez sur l'onglet Transfer File.
4. Sélectionnez Log Snapshot.
5. Sélectionnez All Devices ou Selected Device. Si vous choisissez Selected Device,

sélectionnez le périphérique.
6. Cliquez sur Generate Log Snapshot on Library.
7. Cliquez sur Yes et sur OK.
8. Cliquez sur Transfer Log Snapshot To Your Computer.
9. Enregistrez le fichier sous le nom généré automatiquement.
10. Envoyez le fichier par e-mail à votre représentant du support technique Oracle.
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Contrôle des événements de bibliothèque
Le contrôleur de la bibliothèque surveille en continu les opérations de la bibliothèque et
consigne tous les événements. A l'aide de l'utilitaire de contrôle de SLC, vous pouvez ouvrir
un écran de contrôle des événements pour afficher les données des événements ou les envoyer
pour traitement différé vers un fichier. Les écrans de contrôle des événements constituent des
outils utiles pour analyser les causes premières des erreurs.

• Types d'écran de contrôle d'événements
• Démarrage d'un écran de contrôle d'événements
• Enregistrement des données de contrôle des événements dans un fichier
• Affichage des définitions des codes de résultat

Démarrage d'un écran de contrôle d'événements

1. Dans SLC, sélectionnez Tools > Monitors.
2. Développez le dossier Permanent Monitors dans l'arborescence de navigation.
3. Cliquez sur un type d'écran de contrôle des événements (voir la section la section intitulée

« Types d'écran de contrôle d'événements »). Cliquez sur Open.
4. Utilisez le menu Monitor pour mettre en pause, reprendre, arrêter définitivement

ou effacer l'écran de contrôle des événements. Utilisez le menu Spool File pour
enregistrer l'écran de contrôle des événements dans un fichier (voir la section intitulée
« Enregistrement des données de contrôle des événements dans un fichier »).

Remarque:

Pour que plusieurs écrans de contrôle des événements rentrent dans une fenêtre, utilisez le menu Window
situé dans l'angle supérieur droit.

Enregistrement des données de contrôle des événements
dans un fichier

Vous devrez peut-être envoyer le fichier à votre représentant du support technique Oracle
pour qu'il vous aide à diagnostiquer les problèmes.

1. Ouvrez un écran de contrôle des événements (reportez-vous à la section intitulée
« Démarrage d'un écran de contrôle d'événements »).

2. Dans la fenêtre de l'écran de contrôle des événements, sélectionnez Spool File > Start
Spooling.

3. Accédez au répertoire de votre choix, saisissez le nom du fichier, et cliquez sur Save.
4. Pour arrêter l'envoi des données, sélectionnez Monitor > Stop Spooling.

Affichage des définitions des codes de résultat

Les codes de résultat identifient le type d'événement de bibliothèque (ils sont identiques aux
EventId de bibliothèque).
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1. Dans SLC, sélectionnez Tools > Diagnostics. Sélectionnez le dossier Library dans
l'arborescence du périphérique.

2. Cliquez sur l'onglet Search.
3. Dans la liste Search Type, sélectionnez Result Code.
4. Pour rechercher un code de résultat spécifique, saisissez le code complet (les caractères

génériques et les codes partiels ne sont pas valides).

Pour établir la liste de tous les codes de résultat, sélectionnez List All.
5. Cliquez sur Search.

Types d'écran de contrôle d'événements
Il existe quatre types d'écran de contrôle d'événements : All, Error Warn Info, Error and
Warnings et Errors. Pour chaque type d'écran de contrôle, les événements sont consignés en
fonction de leur gravité. Par exemple, l'écran de contrôle Errors consigne uniquement les
événements d'erreur (pour obtenir une description des types d'événement, reportez-vous à
Gravité).

Chaque événement consigné dans l'écran de contrôle contient les informations suivantes :

Heure
Identifie le moment où l'événement s'est produit.
ID de périphérique
Identifie l'adresse de bibliothèque du périphérique correspondant à l'événement.
Utilisateur
Identifie l'utilisateur à l'origine de l'événement. La valeur est "root" pour les activités des
hôtes HLI ou SCSI.
Interface
Identifie le type d'interface du demandeur. La valeur peut être hli, scsi ou par défaut (pour
les demandes SLC ou CLI).
Activité
Identifie la commande émise, comme ''load drive''.
Identificateur de demande
Identifie toutes les demandes de l'interface hôte. Permet d'effectuer le suivi de la
séquence des activités consignées découlant de chaque demande de l'hôte.
Gravité
Identifie l'importance de l'événement. Certaines données d'événement ne sont pas
volatiles, ce qui signifie qu'elles persistent entre les cycles d'alimentation du système.

Erreur : données non volatiles indiquant un incident qui a empêché l'exécution correcte
d'une demande (hôte ou diagnostic).

Avertissement : données non volatiles indiquant un incident qui n'a pas empêché la
bibliothèque d'exécuter les demandes (hôte ou diagnostic). Un avertissement peut
identifier une perte de performances ou une condition qui pourrait entraîner des erreurs
irréversibles.
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Informations : données volatiles fournissant des informations générales sur les
périphériques ou la bibliothèque (état des périphériques, périphérique ajouté, listener
enregistré, numéro de série de tiroir mis à jour, etc.). Ces informations peuvent permettre
d'établir un historique des activités pour l'événement d'avertissement ou d'erreur.

Trace : données volatiles fournissant la trace des activités de diagnostic.
Code du résultat
Identifie le type d'événement de bibliothèque (les codes de résultat sont identiques aux
EventId de bibliothèque). Pour rechercher la signification d'un code de résultat à l'aide
de SLC, reportez-vous à la section intitulée « Affichage des définitions des codes de
résultat » ou au fichier SL8500_FRSxxx_JavaErrorCodes.html qui se trouve dans le
package de code du microprogramme de la bibliothèque.
Texte de résultat
Fournit des informations sur les résultats de la demande ou de l'événement.
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13 
Modification du statut en ligne/hors ligne et

réinitialisation

• Mise hors ligne de la bibliothèque
• Mise en ligne de la bibliothèque
• Mise hors ligne d'un périphérique
• Mise en ligne d'un périphérique
• Réinitialisation de la bibliothèque
• Réinitialisation du panneau opérateur local
• Réinitialisation d'un ascenseur
• Réinitialisation d'un robot

Mise hors ligne de la bibliothèque
Remarque:

Tentez toujours de mettre la bibliothèque hors ligne à l'aide du logiciel ACSLS ou ELS avant d'utiliser
SLC.

1. Mettez hors ligne tous les lecteurs de la bibliothèque (reportez-vous à la section intitulée
« Mise hors ligne d'un périphérique »).

2. Dans SLC, sélectionnez Tools > System Detail.
3. Sélectionnez le dossier Library dans l'arborescence du périphérique.
4. Cliquez sur l'onglet Status, puis sur l'onglet General.
5. Dans le champ Transition Request, cliquez sur Take offline.
6. Cliquez sur Apply. Avant la mise hors ligne de la bibliothèque, toutes les tâches de

bibliothèque non appliquées se terminent.
7. Attendez que le message de confirmation de mise hors ligne s'affiche. Si la bibliothèque

n'est pas mise hors ligne, vérifiez son statut (reportez-vous à la section intitulée
« Affichage du statut opérationnel de la bibliothèque »).

Quand placer la bibliothèque hors ligne :

• Avant de mettre la bibliothèque hors tension
• Avant d'ouvrir une porte d'accès de la bibliothèque
• Lorsque la bibliothèque est inopérante et a besoin d'être entretenue
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Mise en ligne de la bibliothèque
Remarque:

Tentez toujours de mettre la bibliothèque en ligne à l'aide du logiciel ACSLS ou ELS avant d'utiliser SLC.

1. Dans SLC, sélectionnez Tools > System Detail.
2. Cliquez sur Library dans l'arborescence du périphérique.
3. Cliquez sur l'onglet Status, puis sur l'onglet General.
4. Dans le champ Transition Request, cliquez sur Bring online.
5. Cliquez sur Apply.
6. S'il y a lieu, mettez la bibliothèque en ligne pour les hôtes ACSLS et ELS (voir la

documentation du logiciel hôte).

Mise hors ligne d'un périphérique
Remarque:

Tentez toujours de mettre un périphérique hors ligne à l'aide du logiciel de gestion de bandes ACSLS ou
ELS avant d'utiliser SLC.

1. Dans SLC, sélectionnez Tools > System Detail.
2. Développez le dossier du périphérique (CAP, robot ou lecteur). Sélectionnez le

périphérique à modifier.
3. Cliquez sur l'onglet Status.
4. Dans la liste Transition Request, sélectionnez Take Offline. Le système termine toutes

les tâches en cours pour le périphérique avant de mettre celui-ci hors ligne.

Quand le robot se met hors ligne, il se déplace vers l'extrémité du rail et la bibliothèque
ne peut pas l'utiliser. Si la bibliothèque utilise la fonctionnalité de robotique redondante,
le deuxième robot reçoit toutes les demandes.

5. Cliquez sur Apply.

Mise en ligne d'un périphérique
Remarque:

Les périphériques de la bibliothèque qui sont hors ligne et présentent un état d'erreur ne peuvent pas
passer en ligne. La cause de l'erreur doit d'abord être corrigée.

1. Dans SLC, sélectionnez Tools > System Detail.
2. Développez le dossier CAP. Cliquez sur le CAP à modifier.
3. Cliquez sur l'onglet Status.
4. Dans la liste Transition Request, sélectionnez Bring Online.
5. Cliquez sur Apply.
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Réinitialisation de la bibliothèque
La réinitialisation de la bibliothèque implique de recharger le microprogramme à partir de la
mémoire flash et de redémarrer le contrôleur de la bibliothèque.

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Cliquez sur le dossier Library dans l'arborescence de navigation.
3. Cliquez sur Reboot.
4. Tous les autres utilisateurs doivent être déconnectés. Cliquez sur OK.
5. Si la bibliothèque est en ligne, cliquez sur OK pour la mettre hors ligne.
6. Cliquez sur OK pour réinitialiser la bibliothèque.
7. Cliquez sur OK pour mettre fin à la session SLC. Vous ne pouvez pas vous reconnecter à

SLC avant l'initialisation complète de la bibliothèque.

Réinitialisation du panneau opérateur local
Vous devrez peut-être réinitialiser le panneau opérateur local s'il se bloque ou si les
informations d'aide ne s'affichent pas. Vous pouvez effectuer la réinitialisation à partir du
panneau opérateur local ou d'une session SLC distante.

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Sélectionnez la bibliothèque dans l'arborescence de périphériques, puis cliquez sur

l'onglet OpPanel.
3. Cliquez sur le bouton Reboot Operator Panel.
4. En cas de réinitialisation à partir du panneau opérateur local, l'écran se vide. La

réinitialisation est terminée lorsque le panneau opérateur repasse en ligne.

En cas de réinitialisation à partir d'une session SLC distante, le message "Reboot
Complete" indique que la réinitialisation du panneau opérateur local est terminée.

Réinitialisation d'un ascenseur
1. Sélectionnez Tools > Diagnostics.
2. Développez le dossier Elevator, puis sélectionnez un ascenseur.
3. Cliquez sur Reboot.
4. Cliquez sur OK pour réinitialiser l'ascenseur.

Réinitialisation d'un robot
1. Sélectionnez Tools > Diagnostics.
2. Développez le dossier Robot, puis sélectionnez un robot.
3. Cliquez sur Reboot.
4. Cliquez sur OK pour réinitialiser le robot.
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14 
Dépannage

• Dépannage de base
• Exécution d'un autotest de la bibliothèque
• Exécution de l'autotest d'un périphérique
• Diagnostiquer les problèmes robotiques
• Détermination du statut d'une carte de contrôleur
• Effacement des alertes de statut de la bibliothèque
• Exécution d'un basculement RE manuel à l'aide de SLC
• Etalonnage de l'écran tactile
• Dépannage de la connectivité des hôtes

Voir aussi

• Chapitre 13, Modification du statut en ligne/hors ligne et réinitialisation
• la section intitulée « Génération de fichiers de diagnostic pour le support technique

Oracle »
• la section intitulée « Contrôle des événements de bibliothèque »
• Chapitre 15, Maintenance de la bibliothèque

Dépannage de base
Avant d'exécuter des tests de diagnostic ou de contacter le support technique Oracle, passez
en revue les conseils de dépannage suivants.

Le voyant orange d'intervention requise (Service Required) est constamment allumé
A l'aide de SLC, vérifiez l'état d'intégrité de la bibliothèque et des périphériques
connectés (lecteurs, CAP et robots). Reportez-vous à la section Chapitre 11, Affichage
des informations sur la bibliothèque et les périphériques.

Pour vérifier l'état d'intégrité :
1. Connectez-vous à la SLC.
2. Accédez au module System Detail, Tools > System Detail.
3. Dans l'arborescence de navigation, contrôlez les indicateurs suivants : Device Healthy

ou Device Error
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Vérifications supplémentaires :
1. Vérifiez les onglets Status (par exemple, online/offline) et Statistics (par exemple,

uptime, downtime, errors et warnings) pour plus d'informations sur l'intégrité de la
bibliothèque et des périphériques.

2. Assurez-vous que les cartouches sont correctement insérées et orientées dans leurs
emplacements de stockage.

3. Inspectez la table X et retirez tout objet ou débris étranger le cas échéant.
Le voyant indiquant que le CAP est ouvert (CAP Open) clignote
Ouvrez le CAP et assurez-vous que les cartouches sont correctement insérées. Fermez le
CAP.
SLC n'affiche pas les données modifiées ou les informations demeurent statiques
Contrôlez l'icône SLC Heartbeat.
Le voyant orange de panne du robot (Robot Fault) ou de panne de la bibliothèque
(Library Fault) est constamment allumé
1. Vérifiez dans la SLC si des messages d'erreur s'affichent. Inscrivez les messages

d'erreur signalés.
2. Ouvrez la porte avant. Observez et notez l'état des cartouches ainsi que de la main et

des lecteurs de bande.
3. Assurez-vous que les cartouches sont correctement insérées et orientées dans leurs

emplacements de stockage.
4. Assurez-vous que l'emballage a été retiré.
5. Inspectez le sol de la bibliothèque de bandes à la recherche d'objets ou de débris

étrangers. Retirez-les, le cas échéant.
6. Vérifiez le statut des lecteurs de bande.
7. Fermez la porte avant.
8. Assurez-vous que les lecteurs de bande sont correctement insérés et verrouillés à

l'avant, en tirant et en appuyant à l'arrière du tiroir de lecteur. Tout mouvement du
tiroir indique qu'il doit être à nouveau inséré et verrouillé.

L'ordinateur client ne peut pas communiquer avec la bibliothèque ou les lecteurs de
bande
Assurez-vous que les câbles sont correctement branchés à leurs connecteurs à l'arrière de
la bibliothèque, des lecteurs de bande et de l'ordinateur client.
La bibliothèque ne peut pas communiquer avec les lecteurs et le statut des lecteurs
sur la SLC affiche "Not communicating"
Assurez-vous que les câbles sont correctement branchés à leurs connecteurs à l'arrière de
la bibliothèque, des lecteurs et de l'ordinateur client.
Messages de nettoyage ou nettoyages de lecteur répétés ou excessifs
1. Remplacez la cartouche de nettoyage par une nouvelle.
2. Exécutez l'autotest de la bibliothèque et notez les erreurs éventuellement signalées

concernant le lecteur.
3. Exécutez les tests de diagnostic de lecteur basés sur l'ordinateur client.
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Exécution d'un autotest de la bibliothèque
Utilisez les autotests de la bibliothèque pour faciliter le diagnostic des problèmes. Les
autotests de la bibliothèque peuvent être effectués sans interruption (les cartouches sont
renvoyées dans leur emplacement initial) ou avec interruption (les cartouches peuvent être
déplacées vers de nouveaux emplacements).

Remarque:

Avant d'exécuter un test avec interruption, mettez la bibliothèque hors ligne (voir la section la section
intitulée « Mise hors ligne de la bibliothèque »).

1. Vérifiez que les cartouches de diagnostic des lecteurs appropriées se trouvent dans
la bibliothèque (voir la section la section intitulée « Importation ou exportation des
cartouches de nettoyage et de diagnostic »).

2. Dans SLC, sélectionnez Tools > Diagnostics, puis cliquez sur le dossier Library.
3. Cliquez sur l'onglet SelfTest.
4. Dans la liste Mode, sélectionnez le type d'autotest :

• Non-Disruptive : toutes les cartouches qui ont servi au test sont renvoyées dans leurs
emplacements d'origine.

• Disruptive : les cartouches peuvent être déplacées vers de nouveaux emplacements.
Avant l'exécution du test, la bibliothèque doit être mise hors ligne sur tous les hôtes.

5. Cliquez sur Run. Une fois le test terminé, les résultats s'affichent.
6. Pour les tests avec interruption, placez la bibliothèque en ligne pour reprendre les

opérations normales.

Lors d'un autotest, la bibliothèque :

• Vérifie le chemin des communications entre le contrôleur de la bibliothèque, les lecteurs,
les ascenseurs et les robots.

• Exécute des opérations get et put pour vérifier l'intégrité des robots, des ascenseurs et
des CAP. Cela inclut les opérations get et put d'un emplacement système réservé à un
emplacement CAP ou un emplacement de stockage vide aléatoire.

• Réalise un audit complet de la bibliothèque.
• Monte et démonte des cartouches de diagnostic pour tous les lecteurs installés dans la

bibliothèque. L'autotest ne démarre pas si aucune cartouche de diagnostic n'est détectée
dans les emplacements système. Si le système détecte une cartouche de diagnostic
compatible, l'autotest est renouvelé pour chaque type de lecteur. Si le système ne détecte
pas de cartouche de diagnostic pour un type de lecteur, il n'effectue pas l'opération de
montage/démontage pour le lecteur.

Exécution de l'autotest d'un périphérique
Utilisez les autotests des périphériques pour faciliter le diagnostic des problèmes. Un autotest
peut être exécuté sur un CAP, un robot ou un lecteur.
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Remarque:

L'exécution de l'autotest sur un CAP de chargement en masse nécessite une intervention humaine pour
l'ouverture et la fermeture de la porte du CAP.

Exécution de l'autotest sur tous les CAP (CAP de chargement
en masse uniquement)

1. Dans la SLC, sélectionnez Tools >Diagnostics, puis CAP Folder.
2. Dans la liste Mode, sélectionnez Non-Disruptive (les tests avec interruption nécessitent

que la bibliothèque soit hors ligne pour tous les hôtes).
3. Cliquez sur Run.
4. Ouvrez et fermez les portes de CAP comme indiqué. Un message apparaît à la fin du test.

Exécution de l'autotest sur un périphérique individuel

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Développez le dossier du périphérique (CAP, robot, lecteur, PTP ou ascenseur) dans

l'arborescence du périphérique. Sélectionnez le périphérique.

Remarque:

Pour qu'un autotest puisse être exécuté sur un robot, des cartouches de diagnostic doivent être
disponibles dans la bibliothèque (voir la section la section intitulée « Importation ou exportation des
cartouches de nettoyage et de diagnostic »).

3. Dans la liste Mode, sélectionnez Non-Disruptive.
4. Cliquez sur Run. Un message apparaît à la fin du test.

Diagnostiquer les problèmes robotiques
Les actions de diagnostic peuvent permettre de contrôler ou de diagnostiquer des problèmes
robotiques en exécutant une série d'opérations "get" et "put". Le système choisit un robot pour
l'action de diagnostic en fonction des plages minimale et maximale que vous avez définies
pour les adresses cibles et de pool. Plusieurs robots peuvent être sélectionnés si la plage
d'adresses l'exige.

Une action de diagnostic réussie ne réorganise pas les cartouches dans la bibliothèque : le
système renvoie les cartouches dans leurs emplacements d'origine. Il arrive toutefois qu'à la
suite d'échecs d'action de diagnostic, les cartouches restent dans leur nouvel emplacement.

Définition d'une action de diagnostic

Remarque:

Les actions de diagnostic exigent que les ressources des robots soient partagées. Vous ne devez pas
exécuter une action de diagnostic pendant les périodes de pic d'activité.
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Vous pouvez configurer et exécuter plusieurs routines d'action de diagnostic simultanément si
les plages d'adresses cibles et de pool ne se chevauchent pas pour chaque diagnostic.

1. Dans SLC, sélectionnez Tools > Diagnostics. Sélectionnez le dossier Library dans
l'arborescence du périphérique.

2. Cliquez sur l'onglet DiagMove, puis sur l'onglet Manage.
3. Cliquez sur Add dans la section Defined Sequence.
4. Définissez la plage d'adresses cibles (la zone utilisée pour les opérations "get").

a. Sélectionnez un type d'emplacement.
b. Sélectionnez les emplacements de début et de fin de la plage.

5. Cliquez sur Next.
6. Définissez la plage d'adresses sources (la zone utilisée pour fournir des cartouches ou

des emplacements vides si une adresse cible ne contient pas de cartouche ou qu'aucun
emplacement vide n'est disponible).
a. Sélectionnez un type d'emplacement.
b. Sélectionnez les emplacements de début et de fin.

7. Cliquez sur Next.
8. Attribuez un nom à l'action et indiquez un nombre d'actions (entre 1 et 5 000).
9. Sélectionnez un ordre d'accès, un type d'action et activez/désactivez le contrôle de

compatibilité effectué avant l'action (voir ci-dessous pour plus d'informations).
10. Cliquez sur Finish. La nouvelle séquence de diagnostic apparaît dans la section Defined

Sequences. Reportez-vous à la section la section intitulée « Démarrage d'une action de
diagnostic ».

Une action de diagnostic est définie par les éléments
suivants :

• Plage d'adresses cibles : définit la zone utilisée pour exécuter l'opération "get" dans une
action de diagnostic. Les types d'adresse cible valides sont les emplacements de stockage,
les emplacements de stockage de CAP et de lecteur ainsi que les emplacements système,
ou tous ces emplacements.

Remarque:

Toutes les ressources situées dans la plage d'adresses cibles sont réservées. Toutefois, seul
l'emplacement auquel le robot est en train d'accéder pour une opération get/put n'est pas disponible
pour l'hôte.

• Plage d'adresses de pool : définit la zone utilisée pour fournir des cartouches ou des
emplacements vides si une adresse cible ne contient pas de cartouche ou qu'aucun
emplacement vide n'est disponible. Les adresses de pool et cible peuvent se chevaucher.

• Ordre d'accès : détermine comment le robot exécute les opérations get dans la plage
d'adresses cibles. Deux options sont disponibles :
◦ Séquentiel : le robot exécute une opération get en commençant par le premier

emplacement de la plage d'adresses cibles. Le robot continue à visiter les emplacements
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de manière séquentielle sur l'ensemble de la plage jusqu'à ce qu'il ait effectué le nombre
d'actions demandé.

◦ Aléatoire : le robot choisit aléatoirement un emplacement dans la plage d'adresses
cibles afin d'obtenir une cartouche. Le robot peut également visiter plusieurs fois le
même emplacement dans la plage d'adresses cibles afin de se procurer une cartouche.
Cependant, si vous indiquez un nombre suffisant de demandes d'actions, le robot est
assuré de visiter tous les emplacements. La routine à accès aléatoire se termine une fois
que le nombre d'actions demandé est atteint.

Démarrage d'une action de diagnostic

Remarque:

Vous pouvez exécuter plusieurs actions simultanément, tant que les plages d'adresses cibles et de pool
configurées pour les actions ne se chevauchent pas.

Avant d'exécuter une action de diagnostic, vous devez la définir (voir la section la section
intitulée « Définition d'une action de diagnostic »).

1. Dans SLC, sélectionnez Tools > Diagnostics. Sélectionnez le dossier Library dans
l'arborescence du périphérique.

2. Cliquez sur l'onglet DiagMove, puis sur l'onglet Manage.
3. Sélectionnez une action de diagnostic dans la section Defined Sequences. Cliquez sur

Open.
4. Sélectionnez File > Start Sequence.

Enregistrement d'une action de diagnostic

Vous pouvez enregistrer une action de diagnostic définie dans un fichier et l'utiliser
pour restaurer une action supprimée de la bibliothèque, ou pour la copier dans une autre
bibliothèque.

1. Dans SLC, sélectionnez Tools > Diagnostics. Sélectionnez le dossier Library dans
l'arborescence du périphérique.

2. Cliquez sur l'onglet DiagMove, puis sur l'onglet Manage.
3. Dans la section Defined Sequence, sélectionnez une action de diagnostic, puis cliquez sur

Save en haut de l'écran de SLC.

Surveillance des actions de diagnostic ouvertes

Pour démarrer une action de diagnostic, reportez-vous à la section la section intitulée
« Démarrage d'une action de diagnostic ».

1. Dans SLC, sélectionnez Tools > Diagnostics. Sélectionnez le dossier Library dans
l'arborescence du périphérique.
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2. Cliquez sur l'onglet DiagMove, puis sur l'onglet Monitor.
3. Chaque fenêtre d'écran de contrôle indique le statut de l'action :

Indicateurs de statut Valeurs valides

Statut de spool : indique si la sortie de l'action est enregistrée dans un fichier True, False

Etat : état d'exécution de l'action Running, pausing, paused,
stopping, stopped

Intégrité : état d'intégrité de l'action OK, warning, error

Actions terminées : nombre d'actions terminées Nombre

4. Le menu File de chaque fenêtre Monitor permet de démarrer/d'arrêter/de mettre en pause
la séquence, de supprimer la fenêtre de sortie ou de démarrer/d'arrêter l'envoi dans un
fichier pour traitement différé.

Détermination du statut d'une carte de contrôleur
Le statut de la carte de contrôleur est indiqué par des voyants situés sur la carte et affiché
dans SLC (reportez-vous à la section la section intitulée « Affichage du statut et des
propriétés des périphériques »). Vous pouvez utiliser le statut de la carte pour dépanner les
problèmes de la bibliothèque.

Les voyants et leur signification sont identiques pour les deux types de carte (HBC et HBT).

Voyant de la carte de
contrôleur

Définition

ACTIVE - vert La carte fonctionne en tant que carte active et exécute le code actif.

STANDBY - orange La carte fonctionne en tant que carte de secours et exécute le code de secours.

FAULT - rouge Une erreur grave est survenue au niveau de la carte.

EJECT OK - bleu Le représentant du support technique peut déclencher l'éjection d'une carte en toute
sécurité.

Effacement des alertes de statut de la bibliothèque
Vous pouvez uniquement effacer les alertes identifiées par "Clearable" et seulement si le
service est actif sur la bibliothèque.

L'effacement d'une alerte la supprime uniquement de l'affichage Status Module mais ne
résout pas la cause sous-jacente. L'état d'intégrité de la bibliothèque revient sur "Normal" s'il
n'existe aucune autre alerte de périphérique ou de statut. Si l'alerte est soumise à des mises à
jour périodiques, elle réapparaît au cycle de mise à jour suivant.

1. Dans SLC, sélectionnez Tools > System Detail, puis cliquez sur le dossier Library.
2. Cliquez sur l'onglet Status puis sur l'onglet Status Module.
3. Dans la liste Clear Alert Number, sélectionnez le numéro d'alerte à effacer, puis cliquez

sur Apply.
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Exécution d'un basculement RE manuel à l'aide de SLC
Remarque:

Vous pouvez également déclencher un basculement RE à l'aide du logiciel hôte ou de la CLI (reportez-
vous à la section la section intitulée « Comment effectuer un basculement manuel »).

Cette procédure n'est pas disponible sur le panneau opérateur local.

1. Vérifiez que l'état de la carte indique "switch is possible" (voir la section la section
intitulée « Affichage du statut et des propriétés des périphériques »).

2. Dans SLC, sélectionnez Tools > Diagnostics.
3. Sélectionnez le dossier Redundant Electronics
4. Cliquez sur Apply pour lancer le processus de basculement. Si un problème survient

au niveau des cartes de contrôleur de secours de la bibliothèque et des lecteurs, vous ne
pouvez pas poursuivre le basculement.

5. S'il n'y a pas d'erreur, cliquez sur Yes.
6. Cliquez sur OK pour vous déconnecter de SLC.
7. Attendez la fin du basculement pour vous connecter de nouveau à la bibliothèque. Vous

devez spécifier l'adresse IP ou l'alias DNS du nouveau contrôleur actif.

Etalonnage de l'écran tactile
L'alignement de l'écran tactile est étalonné en usine. Si l'écran tactile est mal aligné, vous
pouvez le réétalonner ou le réinitialiser. Le mode d'étalonnage de l'écran tactile dépend du
type et de la version (reportez-vous à la section la section intitulée « Affichage du type du
panneau opérateur local »).

• Si vous disposez d'un panneau opérateur local Linux (DL ou OL), vous pouvez le
réétalonner vous-même ou rétablir les paramètres d'usine par défaut en exécutant les
procédures ci-dessous.

• Si vous disposez d'un panneau opérateur local Windows (W), contactez votre représentant
du support technique Oracle.

Réétalonnage du panneau opérateur local
1. Pour un étalonnage précis, assurez-vous qu'aucun débris ne se trouve sur l'écran tactile.
2. Connectez-vous au panneau opérateur local. Sélectionnez Tools > Calibrate.
3. Cliquez sur Calibrate.
4. Une série de cibles s'affiche. Touchez légèrement du doigt ou à l'aide d'un stylet le centre

de chaque cible.
5. Pour enregistrer les nouveaux paramètres :

a. Appuyez sur les boutons Click Me.

Si les boutons ne s'enfoncent pas, l'écran tactile n'est pas aligné correctement. Pour
annuler les nouveaux paramètres, reportez-vous à l'étape 6.
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b. Cliquez sur OK pour enregistrer les nouveaux paramètres.
6. Pour annuler les nouveaux paramètres :

a. Laissez le délai expirer sans toucher le bouton Click Me.
b. Revenez à l'étape 3 et procédez au réétalonnage.

Le panneau opérateur local se réinitialise automatiquement après l'échec d'un deuxième
étalonnage et restaure l'alignement précédemment enregistré.

Rétablissement du panneau opérateur local configuré en
usine

1. Connectez-vous au panneau opérateur local.
2. Dans SLC, sélectionnez Tools > Calibrate.
3. Cliquez sur Reset Calibration. Le panneau opérateur local se réinitialise.

Dépannage de la connectivité des hôtes
• Utilisez un analyseur de réseau (un périphérique ou un programme qui assure le suivi du

trafic du réseau pour la bibliothèque).
• Affichez les statistiques de port sur le commutateur ou le routeur connecté à la

bibliothèque. Recherchez les erreurs éventuelles.
• Exécutez une trace à l'aide du logiciel de gestion de la bibliothèque qui affiche les paquets

et les transmissions entre les hôtes et la bibliothèque.
• Assurez-vous que deux hôtes distincts ne se disputent pas la gestion d'une bibliothèque

ou d'une partition. Pour voir les connexions hôtes actuelles, reportez-vous à la section
la section intitulée « Affichage du statut opérationnel de la bibliothèque ». Cliquez sur
l'onglet HLI.
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15 
Maintenance de la bibliothèque

• Mise hors tension de la bibliothèque
• Mise sous tension de la bibliothèque
• Entrée dans la bibliothèque sans la porte de sécurité de service en place
• Utilisation du commutateur d'arrêt d'urgence de la robotique
• Montage ou démontage manuels d'une cartouche
• Fonctionnement de la porte de sécurité de service

Voir aussi

• Chapitre 14, Dépannage

Mise hors tension de la bibliothèque
Attention:

Si vous mettez la bibliothèque hors tension sans effectuer la procédure suivante, vous risquez
d'endommager l'équipement ou la cartouche, ou de perdre des données.

1. Assurez-vous que toutes les demandes adressées à la bibliothèques sont terminées.
2. Placez la bibliothèque et les lecteurs hors ligne.
3. Assurez-vous que les lecteurs sont vides en vérifiant l'état du lecteur à l'aide de SLC

(voir la section la section intitulée « Affichage de rapports sur la bibliothèque et les
périphériques à l'aide de l'utilitaire de rapports »).

4. Ouvrez les portes arrière de la bibliothèque.
5. Localisez l'unité de distribution de courant (PDU) dans l'angle inférieur droit à l'arrière de

la bibliothèque et placez l'interrupteur Marche/Arrêt du système sur la position Arrêt (0).
Si la bibliothèque possède une configuration d'alimentation 2N, vous devez mettre hors
tension les deux PDU.

Pour plus d'informations sur les PDU, reportez-vous au SL8500 Overview and Planning
Guide.

Mise sous tension de la bibliothèque
1. Vérifiez que les porte d'accès avant sont fermées et verrouillées
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Remarque:

Si vous ne voulez pas mettre sous tension les robots, les CAP et les ascenseurs, laissez les portes
d'accès ouvertes.

2. Placez l'interrupteur Marche/Arrêt sur la position Marche (ON).

Si la bibliothèque possède une configuration d'alimentation 2N, vous devez mettre sous
tension les deux PDU.

Entrée dans la bibliothèque sans la porte de sécurité de service
en place

Remarque:

L'ouverture de la porte d'accès sans la porte de sécurité en place arrêtera toutes les opérations de la
bibliothèque. Quand la bibliothèque revient en ligne, elle lance un audit complet. Voir aussila section
intitulée « Fonctionnement de la porte de sécurité de service ».

1. Respectez toutes les précautions de sécurité (voir la section la section intitulée
« Précautions de sécurité lors de l'entrée dans la bibliothèque »).

2. Mettez la bibliothèque hors ligne (voir la section la section intitulée « Mise hors ligne de
la bibliothèque »).

3. Déverrouillez et ouvrez la porte d'accès avant. Verrouillez l'ouverture de la porte d'accès
et retirez la clé.

4. Si nécessaire, déplacez les robots du chemin en commençant par le rail du bas. Evitez
d'endommager les composants mécaniques ou électroniques du robot. Le robot doit se
déplacer librement. Ne forcez pas le robot si le mouvement est restreint.

5. Avant de quitter la bibliothèque, vérifiez qu'aucun élément n'est desserré et qu'il n'y a plus
personne.

6. Fermez les portes avec le loquet.
7. Verrouillez les portes et conservez la clé.
8. Mettez la bibliothèque en ligne (reportez-vous à la section la section intitulée « Mise en

ligne de la bibliothèque »).

Précautions de sécurité lors de l'entrée dans la bibliothèque

AVERTISSEMENT:

Pour empêcher la fermeture accidentelle de la porte, verrouillez l'ouverture de la porte d'accès et
retirez la clé.

• Vérifiez que la bibliothèque est hors ligne. N'entrez pas dans la bibliothèque et ne déplacez
pas les robots si vous avez des raisons de croire que ces derniers sont sous tension.

• Ne tentez pas de remplacer les périphériques de sécurité électriques ou mécaniques dans la
bibliothèque.
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• Informez la personne à proximité de la bibliothèque pour lui indiquer que vous allez entrer
dedans.

• Repérez les déclencheurs mécaniques de la porte (poignées jaunes à l'intérieur des portes
d'accès). Si les portes se referment alors que vous êtes dans la bibliothèque, appuyez sur le
déclencheur mécanique pour déverrouiller et ouvrir la porte.

• Tant que vous êtes à l'intérieur de la bibliothèque, laissez les deux portes d'accès avant
ouvertes.

• Gardez en mémoire les restrictions physiques de la bibliothèque. Veillez à ne pas vous
cogner contre les baies ou à y coincer des vêtements (l'espace libre dans le passage n'est
que de 0,4 mètre).

Utilisation du commutateur d'arrêt d'urgence de la robotique
Le commutateur ERS (Emergency Robotics Stop, arrêt d'urgence de la robotique) met
totalement hors tension les robots.

Dans l'hypothèse peu probable où quelqu'un serait coincé dans la bibliothèque et où le
système se remettrait sous tension, des voyants clignoteraient pendant 30 secondes avant
que le robot ne commence à se déplacer. Cela laisse suffisamment de temps à toute personne
à l'extérieur de la bibliothèque d'appuyer sur le commutateur ERS (arrêt d'urgence de la
robotique).

Figure 15.1. Commutateur d'arrêt d'urgence de la robotique

1. Commutateur d'arrêt d'urgence de la robotique (ERS)

Montage ou démontage manuels d'une cartouche
Reportez-vous à la documentation relative au lecteur avant de monter manuellement une
cartouche.

Attention:

Vos mains doivent rester à distance des composants de charge mécaniques et électroniques du lecteur.

1. Enregistrez l'ID de volume, l'emplacement de la cartouche et l'emplacement du lecteur
fournis par le logiciel de gestion de la bibliothèque.
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2. Localisez le lecteur (reportez-vous à la section intitulée « Affichage de rapports sur la
bibliothèque et les périphériques à l'aide de l'utilitaire de rapports »).

3. Localisez la cartouche (reportez-vous à la section intitulée « Localisation des
cartouches »).

4. Orientez la cartouche de sorte que le moteur du hub soit tourné vers le bas et l'étiquette
d'ID de volume soit face à vous.

5. Enfoncez la cartouche dans le lecteur. Ne forcez pas la cartouche. Si vous sentez une
résistance lors de l'insertion de la cartouche, assurez-vous que celle-ci est du type
approprié pour le lecteur.

6. Pour démonter le lecteur, appuyez sur l'interrupteur UNLOAD à l'avant du lecteur.

Si la cartouche n'est pas éjectée, reportez-vous à la documentation relative au lecteur.

Fonctionnement de la porte de sécurité de service
Vous pouvez utiliser SLC pour surveiller le statut de la porte de sécurité (voir la section la
section intitulée « Affichage du statut et des propriétés des périphériques »).

La porte de sécurité est une barrière coulissante qui ferme temporairement la zone gauche
ou droite comprise entre la porte avant et l'arrière de l'assemblage de l'ascenseur. Les
représentants du support technique peuvent activer la porte de sécurité de service avec une clé
de maintenance. Quand la porte de sécurité est en place, un représentant du support technique
peut ouvrir la porte avant pour accéder à un robot en panne sans mettre la bibliothèque hors
ligne.

La bibliothèque continue de fonctionner et de traiter les demandes des hôtes. La bibliothèque
met en attente les demandes de montage des emplacements situés à côté ou derrière la porte
de sécurité jusqu'à ce que le représentant du support technique ait terminé. Une fois la porte
d'accès fermée et verrouillée, la porte de sécurité de service se déplace vers le centre de la
bibliothèque. Les robots reprennent ensuite leurs activités.

Accès à la zone de maintenance de gauche

Avant d'activer la porte de sécurité, le représentant du support technique doit mettre
l'ascenseur de gauche et les CAP de chargement en masse de gauche hors ligne à l'aide de
SLC. Après avoir terminé l'activité de maintenance, le représentant du support technique doit
remettre l'ascenseur de gauche et les CAP de chargement en masse de gauche en ligne.

Accès à la zone de maintenance de droite

Avant d'activer la porte de sécurité, le représentant du support technique doit mettre
l'ascenseur de droite et les CAP de rotation ou de chargement en masse de droite hors ligne
à l'aide de SLC. Après avoir terminé l'activité de maintenance, le représentant du support
technique doit remettre l'ascenseur de droite et les CAP en ligne.
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Annexe A 
Configuration matérielle et logicielle pour les

fonctionnalités de la bibliothèque

Validation de média

• Carte HBT à grande quantité de mémoire
◦ Lors de l'utilisation de RE, les deux cartes HBT doivent être à grande quantité de

mémoire.
• FRS_8.31 et SLC FRS_6.25 au minimum
• Voir aussi : la section intitulée « Conditions requises pour la validation de média »

Partitionnement

• FRS_7.01 et SLC 5.50 au minimum (pour le partitionnement d'une bibliothèque unique)
• FRS_8.31 et SLC 6.25 au minimum (pour le partitionnement d'un complexe de

bibliothèques)
◦ ACSLS 8.3, HSC 6.2 : PTF L1H16SG (VM), ELS 7.0 : PTF L1H15SI (MVS), ELS 7.1 :

PTF L1H16SJ, ELS 7.2 : intégré

Redundant Electronics

• FRS_6.00 et SLC version 4.65 au minimum
• Voir aussi : la section intitulée « Conditions requises pour Redundant Electronics »

Activation du mode ADI

• HBT à grande quantité de mémoire
◦ Lors de l'utilisation de RE, les deux cartes HBT doivent être à grande quantité de

mémoire.
• FRS_8.36 au minimum

Envoi de données de lecteur riches à STA

• Une carte HBT à grande quantité de mémoire est nécessaire pour les lecteurs T10000
exécutant TTI 5.40+ pour envoyer toutes les données à STA. Sans carte HBT à grande
quantité de mémoire, les lecteurs fonctionnent normalement mais STA reçoit uniquement
des données de base.
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Annexe B 
Référence de l'interface de ligne de commande

Cette annexe décrit les commandes de l'interface de ligne de commande (CLI) disponibles
pour un utilisateur Admin. Comme la CLI est basée sur le microprogramme, certaines
commandes ne sont pas disponibles pour votre bibliothèque.

Les commandes de la CLI accessibles à l'administrateur sont les suivantes :

• audit
• capCommand
• cleaning
• config
• date
• drive
• hwActivation
• mediaValidation
• network
• partition
• reControl
• snmp
• ssh
• time
• traceRoute
• version
• whereAmi

audit
Cette commande exécute un audit sur l'ensemble ou une partie de la bibliothèque.

audit
Affiche l'aide de la commande audit, tout comme "help audit".
audit *
Lance un audit physique de l'ensemble de la bibliothèque. Cette commande s'exécute
immédiatement et n'affiche aucun résultat.

Exemple :
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SL8500> audit *
   requestId
   requestId 9
   Done
   Failure Count 0
   Success Count 1
COMPLETED

audit <adresse du périphérique> <adresse>
Effectue un audit physique d'une adresse unique et affiche les résultats.
• <adresse du périphérique> - indique le robot à utiliser au format bibliothèque, rail,

colonne, côté, ligne.
• <adresse> - indique l'emplacement au format bibliothèque, rail, colonne, côté, ligne.

Exemple :

SL8500> audit 1,4,0,1,0 1,4,-45,1,1
   requestId
   requestId 9
   Attributes Media Label #EMPTY..
   Object     Location    1,4,-45,1,1
   Done
   Failure Count 0
   Success Count 1
COMPLETED

audit <adresse du périphérique> <adresse de début> <adresse de fin>
Effectue un audit physique d'une plage d'adresses et affiche les résultats.
• <adresse du périphérique> - indique le robot à utiliser au format bibliothèque, rail,

colonne, côté, ligne.
• <adresse de début> <adresse de fin> - indique l'emplacement de début et de fin qui

doivent faire l'objet de l'audit au format bibliothèque, rail, colonne, côté, ligne. Seule la
ligne est différente dans l'adresse de début et l'adresse de fin.

Exemple :

SL8500> audit 1,4,0,1,0 1,4,-45,1,1 1,4,-45,1,2
   requestId
   requestId 10
   Attributes Media Label #EMPTY..
   Object     Location    1,4,-45,1,1
 
   Attributes Media Label EN34410R
   Object     Location    1,4,-45,1,2
   ...
   Done
   Failure Count 0
   Success Count 5
COMPLETED

audit multiRowScan {enable | disable | print} <adresse du périphérique>
Active ou désactive la fonctionnalité d'audit d'analyse de plusieurs lignes pour augmenter
la vitesse de l'audit.
• print - imprime l'état de l'audit d'analyse sur plusieurs lignes.
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• <adresse du périphérique> - indique le robot à utiliser au format bibliothèque, rail,
colonne, côté, ligne.

Exemple :

SL8500> audit multiRowScan print 1,1,0,1,0
   requestId
   requestId 8401
   Attributes Multi Row Scan enabled
   Object     Robot          1,1,0,1,0
   Done
   Failure Count 0
   Success Count 1
COMPLETED

capCommand
Cette commande permet de gérer les CAP.

capCommand
Affiche l'aide de la commande capCommand, tout comme "help capCommand".
capCommand <enable|disable> <device_address>
Active ou désactive un CAP sur un rail (pour CAP de chargement en masse uniquement).
Certaines situations peuvent empêcher un CAP d'être désactivé, notamment une
réservation par un hôte.
• <adresse du périphérique> - indique le CAP à libérer au format bibliothèque, rail,

colonne, côté, ligne.
capCommand forceUnreserve <adresse du périphérique>
Force la libération d'un CAP. Si des cartouches sont présentes dans le CAP, la réservation
passe à "default". Si aucune cartouche n'est présente dans le CAP, la réservation passe à
"none".
• <adresse du périphérique> - indique le CAP à libérer au format bibliothèque, rail,

colonne, côté, ligne.
capCommand {lock | unlock} <adresse du périphérique>
Verrouille ou déverrouille un CAP indiqué par adresse de périphérique.
• <adresse du périphérique> - indique le CAP à verrouiller/déverrouiller dans la

bibliothèque, au format bibliothèque, rail, colonne, côté, ligne.

cleaning
Cette famille de commandes affiche et contrôle les fonctions de nettoyage et de diagnostic
relatives aux cartouches au sein de la bibliothèque. Seuls les clients disposant de la
fonctionnalité de validation de média doivent utiliser ces commandes.

cleaning
Affiche l'aide de la commande cleaning, tout comme "help cleaning".
cleaning list cleaning
Répertorie toutes les cartouches de nettoyage dans les emplacements système.
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Exemple :

SL8500> cleaning list cleaning
   requestId
   requestId 9001
   Attributes Expired  false
      Label            CLN0080U
      Location         1,1,-52,1,13
      Max Usage Count  100
      Media Type       9840_Cleaning
      Status           ok
      Usage Count      0
Object Cartridge       cleaning

cleaning import <adresse du périphérique CAP> [ to { 1 | 2 | 3 | 4 | * } ]
Importe des cartouches de nettoyage et de diagnostic dans des emplacements système.
Une seule opération d'importation/exportation à la fois est permise. Il faut au moins
9 emplacements système vides pour que les bibliothèques SL8500 permettent
l'importation.
• <adresse du périphérique CAP> - indique le CAP à utiliser pour l'opération

d'importation au format bibliothèque, rail, colonne, côté, ligne.
• to { 1 | 2 | 3 | 4 | * } - indique le rail vers lequel importer la cartouche, si possible

(facultatif)

Exemple :

SL8500> cleaning import 1,2,55,1,0 to 1
   requestId
   requestId 10101
   Message CAP open(ing). Place cartridges to import in CAP, then close CAP.Use
 CONTINUE cmd to proceed...
   Done
   Failure Count 0
   Success Count 0
COMPLETED

cleaning export <adresse du périphérique CAP> cleaning select { 1 | 2 | 3 | 4 |
expired }
Exporte les cartouches de nettoyage sélectionnées. Une seule opération d'importation/
exportation à la fois est permise.
• <adresse du périphérique CAP> - indique le CAP à utiliser pour l'opération

d'exportation au format bibliothèque, rail, colonne, côté, ligne.
• select { 1 | 2 | 3 | 4 | expired } - indique le numéro du rail à partir duquel les cartouches

de nettoyage doivent être exportées.

Exemple :

SL8500> cleaning export 1,2,55,2,0 cleaning select expired
   requestId
   requestId 9601
   Address      1.4.-52.1.12
   Success      Cartridge Exported
   Volume Label CLN002CU
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   Message CAP open(ing). Remove cartridges, then close CAP.Use CONTINUE cmd to
 proceed...
   Done
   Failure Count 0
   Success Count 1
COMPLETED

cleaning export <adresse du périphérique CAP> <adresse de la cartouche>
Exporte une cartouche de nettoyage ou de diagnostic donnée vers le CAP indiqué. Une
seule opération d'importation/exportation à la fois est permise.
• <adresse du périphérique CAP> - indique le CAP à utiliser pour l'opération

d'exportation au format bibliothèque, rail, colonne, côté, ligne.
• <adresse de la cartouche> - indique l'emplacement de la cartouche à exporter au

format bibliothèque, rail, colonne, côté, ligne. La cartouche indiquée doit être dans un
emplacement système et doit être une cartouche de nettoyage ou de diagnostic.

Exemple :

SL8500> cleaning export 1,2,55,2,0 1,4,-52,1,12
   requestId
   requestId 9601
   Address      1.4.-52.1.12
   Success      Cartridge Exported
   Volume Label CLN002CU
   Message CAP open(ing). Remove cartridges, then close CAP.Use CONTINUE cmd to
 proceed...
   Done
   Failure Count 0
   Success Count 1
COMPLETED

cleaning threshold list
Affiche une liste de types de cartouches de nettoyage et leurs seuils d'avertissement.
Chaque cartouche de nettoyage a 4 attributs :
• Index - type de cartouche de nettoyage utilisé par la commande "cleaning threshold

set"
• Media type - type de cartouche de nettoyage utilisé
• Maximum usage count - utilisation maximale recommandée par le fabricant de la

bande
• Warning threshold value - seuil de nombre d'utilisations défini par

l'utilisateur ; lorsqu'une cartouche de nettoyage atteint ce seuil, elle passe dans un état
d'avertissement.

Exemple :

SL8500> cleaning threshold list
   requestId
   requestId 15001
   Attributes
   Object     Index               1
              Media Type          SgtUltrium1_Cleaning
              Recommend Max Usage 100
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              Warning Threshold   0
   Attributes
   Object     Index               3
              Media Type          T10000_Cleaning
              Recommend Max Usage 50
              Warning Threshold   0

cleaning threshold set <valeur du seuil d'avertissement> <numéro d'index de la
liste>
Définit une valeur de seuil d'avertissement pour un type de cartouche de nettoyage en
particulier.
• <valeur du seuil d'avertissement> - doit être un nombre entier pouvant aller jusqu'à 1

000. Une valeur de 0 indique qu'il n'y pas de seuil d'avertissement.
• <numéro d'index de la liste> - type de cartouche de nettoyage spécifié par le numéro

d'index dans la liste tabulaire de la commande "cleaning threshold list".

Exemple :

SL8500> cleaning threshold set 55 11
   requestId
   requestId 15101
   Attributes
   Object      Success true
   Done
COMPLETED

cleaning driveWarning set { on | off }
Définit la marque d'avertissement du nettoyage des lecteurs sur ON ou OFF.
• on - l'état d'intégrité du lecteur est paramétré de manière à ce qu'un avertissement soit

émis lorsque le lecteur nécessite un nettoyage
• off - l'état d'intégrité du lecteur n'est pas affecté si le lecteur nécessite un nettoyage

config
Cette commande affiche la configuration actuelle de la bibliothèque physique ou définit les
paramètres de configuration de la bibliothèque.

config
Affiche l'aide de la commande config, tout comme "help config".
config complexId set {1 - 127}
Définit le complexID utilisé pour SDP pour la bibliothèque dans laquelle la commande
est exécutée uniquement. Si un complexe comporte plusieurs bibliothèques, le
complexID doit être défini individuellement pour chaque bibliothèque dans le complexe.
config complexId set {1 - 127} <adresse de la bibliothèque>
Définit le complexID utilisé pour SDP pour une bibliothèque distante. Si un complexe
comporte plusieurs bibliothèques, le complexID doit être défini individuellement pour
chaque bibliothèque dans le complexe.
• <adresse de la bibliothèque> - indique la bibliothèque au format bibliothèque, rail,

colonne, côté, ligne. Par exemple : 2, 0, 0, 0, 0.
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config complexId clear
Efface le numéro complexID pour une bibliothèque. Cette commande redémarre la pile
réseau, ce qui empêche l'adresse IP ILC SDP de répondre.
config complexId clear <adresse de la bibliothèque>
Efface le numéro complexID pour une bibliothèque distante. Cette commande redémarre
la pile réseau, ce qui empêche l'adresse IP ILC SDP de répondre.
• <adresse de la bibliothèque> - indique la bibliothèque au format bibliothèque, rail,

colonne, côté, ligne. Par exemple : 2, 0, 0, 0, 0.
config complexId print
Affiche le complexID actuel pour la bibliothèque dans laquelle la commande est
exécutée.
config ilc print
Affiche l'état ILC.
config ilc {enable | disable}
Active ou désactive le LAN Inter-Library Communications (ILC). Si une désactivation
est demandée, la bibliothèque doit d'abord être mise hors ligne à l'aide de la commande
"accessState offline <adresse du périphérique>".
config libraryId print
Affiche l'identificateur actuel de cette bibliothèque.
config libraryId set {1 - 32 }
Affecte une valeur comprise entre 1 et 32 à libraryID. La bibliothèque doit être hors ligne
pour cette commande.
config print
Affiche la configuration actuelle de la bibliothèque physique.
config serviceInfo print
Affiche les informations de service de la bibliothèque.
config serviceInfo set
Définit les informations de service : contact 'NomContact' phone 'NuméroTél' streetAddr
'AdresseRue' city 'Ville' state 'Etat' country 'Pays' zip 'CodePostal' description 'données de
description'.

Actuellement, la longueur de chaîne maximale est de 31 caractères. Chaque chaîne doit
être délimitée par des ' ' (apostrophes) pour permettre l'utilisation d'espaces et d'autres
caractères.

Exemple :

SL8500> config serviceInfo set city 'Denver' contact 'Andy' country 'USA'
 description 'Manager' phone '303 222-4444' state 'C0' streetAddr '1 tape drive'
 zip '80027'

requestId
requestId 1512402
Device serviceInfo
Success true
Done
Failure Count 0
Success Count 1



date

100

COMPLETED

date
Cette commande définit la date de la bibliothèque à l'heure Greenwich Mean Time (GMT).

date
Affiche l'aide de la commande date, tout comme "help date".
date print
Affiche la date actuelle du système.
date <MM> / <JJ> / <AAAA>
Définit la date système. Dans un complexe de bibliothèques, la bibliothèque dont le
libraryID = 1 est la bibliothèque maître. Modifie la date de la bibliothèque maître.
• <MM> - mois en deux chiffres
• <JJ> - jours en deux chiffres
• <AAAA> - année en quatre chiffres

drive
Cette commande affiche les informations sur les lecteurs ou exécute les utilitaires de lecteur
comme adiEnable, fastLoad, power et rewindUnload.

drive
Affiche l'aide de la commande drive, tout comme "help drive".
drive adiEnable {on | off | print}
Active, désactive ou affiche l'état de la détection de lecteur avec ADI. Lorsque la
commande est activée, tout lecteur supplémentaire ajouté tente la détection de lecteur
ADI. Pour activer ADI pour tous les lecteurs compatibles ADI dans la bibliothèque, la
bibliothèque doit être réinitialisée.
drive fastLoad {on | off | print}
Active, désactive ou affiche l'état de la fonctionnalité fastLoad. FastLoad modifie le
comportement des montages de lecteur (commandes de déplacement). Lorsque fastLoad
est activé, le robot n'attend pas le chargement complet lors d'une opération "PUT" sur
un lecteur, mais passe immédiatement à l'opération suivante. Modifie également le
comportement de la commande rewindUnload, de sorte qu'elle revient immédiatement,
sans attendre le déchargement du lecteur. L'état de la commande fastLoad s'applique à
tous les lecteurs.

Remarque:

Cette commande affecte uniquement les commandes lancées dans la même session CLI que celle
dans laquelle la commande a été exécutée.

drive print { <adresse du lecteur> | * }
Affiche une synthèse des informations du lecteur : emplacement, état, statut, type, version
du microprogramme, type d'interface, utilisé, numéro de série, état (en ligne/hors ligne),
statut (ok, avertissement, erreur), et fabricant du lecteur.
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• <adresse du lecteur> - indique le lecteur au format bibliothèque, rail, colonne, côté,
ligne.

• * - affiche les informations de lecteur de l'ensemble des lecteurs de la bibliothèque de
bandes.

drive search {on | off} <adresse du lecteur>
Provoque le clignotement du voyant vert sur le tiroir de lecteur. Le clignotement se
poursuit jusqu'au lancement de la commande search off. Utilisée pour localiser le lecteur
au sein d'une bibliothèque.
• <adresse du lecteur> - indique le lecteur au format bibliothèque, rail, colonne, côté,

ligne.

hwActivation
Cette commande active certaines fonctionnalités de la bibliothèque après l'achat d'un permis
d'activation de matériel.

Remarque:

La bibliothèque doit être réinitialisée en cas de désactivation de openVolser, dualRobot, du
partitionnement ou de Redundant Electronics.

hwActivation
Affiche l'aide de la commande hwActivation, tout comme "help hwActivation".
hwActivation addLicenseFile
Ajoute un fichier de licence. Le fichier de licence doit être nommé SL8500_license
_config.dsf. Le chemin d'accès complet est /usr/local/SL8500_license_config.dsf.
hwActivation deleteFile <index>
Efface le fichier de fonctionnalité installé indiqué.
• <index> - précise le numéro de fichier à supprimer, tel qu'indiqué dans la base de

données du module hwActivation du contrôleur de la bibliothèque. Voir "hwActivation
listFiles".

hwActivation listFiles
Répertorie les fichiers de fonctionnalité installés dans la base de données du module
hwActivation du contrôleur de la bibliothèque.
hwActivation print
Répertorie toutes les fonctionnalités installées dans la base de données du module
hwActivation du contrôleur de la bibliothèque.

mediaValidation
Cette commande gère la fonctionnalité de validation de média.

mediaValidation
Affiche l'aide de la commande mediaValidation, tout comme "help mediaValidation".
mediaValidation print { all | poolOnly } { * | @ }
Affiche les emplacements des lecteurs du pool de validation de média.
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• all - répertorie tous les emplacements de lecteur
• poolOnly - répertorie uniquement les emplacements de lecteur dans le pool de

validation de média
• * - affiche uniquement les informations de la bibliothèque cible
• @ - affiche les informations de l'ensemble du complexe
mediaValidation reservation clear <adresse du lecteur>
Supprime la réservation de validation de média pour le lecteur indiqué.
• <adresse du lecteur> - indique le lecteur au format bibliothèque, rail, colonne, côté,

ligne.
mediaValidation stopValidation <adresse du lecteur>
Interrompt une validation en cours. La cartouche est renvoyée vers l'emplacement de
stockage source.
• <adresse du lecteur> - indique le lecteur au format bibliothèque, rail, colonne, côté,

ligne.

network
La commande est utilisée pour configurer et afficher la configuration réseau de la carte de
contrôleur. Pour plus d'informations, reportez-vous au SL8500 Host Connectivity Guide sur
OTN.

network clone [adresse IP du Port 2B] [adresse IP du Port 2A]
Utilisé pour la configuration de Redundant Electronics. Copie toutes les configurations de
port, de routage et de stratégie IP vers le HBC du côté B. Les adresses IP sont remplacées
par celles indiquées dans la commande pour le côté B. Si aucune adresse IP de port n'est
indiquée, elles ne sont pas définies sur le côté B.
network config print
Affiche le côté cible de la bibliothèque (A ou B) défini pour les commandes réseau.
network config side {a | b}
Définit le côté cible de la bibliothèque (A ou B) pour les commandes réseau.
network config clear
Efface la configuration réseau. Cette commande met un terme à la connectivité réseau. La
reconfiguration nécessite l'accès au port série sur la carte HBC.
network export
Exporte le fichier de configuration réseau de la bibliothèque (.lnc) et génère un script
de configuration réseau (.scr). Cette commande peut être uniquement être utilisée
lorsqu'aucune configuration réseau n'a été définie au préalable.
network gateway <adresse IP>
Définit la passerelle par défaut du réseau externe.
network gateway clear
Efface la passerelle par défaut du réseau externe.
network import
Importe le fichier de configuration réseau de la bibliothèque (.lnc).
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network ip <adresse IP>
Définit l'adresse IP du port 2B.
network ip address add <adresse IP> dev {2A | 2B}
Définit l'adresse IP d'un port en particulier.
network ip address del <adresse IP> dev {2A | 2B}
Supprime l'adresse IP d'un port.
network ip address show [dev {2A | 2B}]
Affiche les informations d'adresse actuelles pour un port en particulier ou pour les deux
ports si dev n'est pas précisé.
network ip link set dev {2A | 2B} {up | down}
Définit l'état d'opération d'un port, qui contrôle si un port peut envoyer et recevoir du
trafic Ethernet.
• up - met les ports en ligne
• down - met les ports hors ligne
network ip policy {enable | disable} dev {2A | 2B}
Active ou désactive le routage basé sur stratégie pour le périphérique 2A ou 2B.
network ip policy status
Affiche l'état du routage par stratégie pour les périphériques 2A et 2B.
network ip policy route {add | del} <adresse IP> dev {2A | 2B}
Ajoute ou supprime une route statique à la stratégie du périphérique 2A ou 2B.
network ip policy route {add | del} <adresse IP> via <adresse IP de la passerelle>
dev {2A | 2B}
Ajoute ou supprime une route statique à la stratégie du périphérique 2A ou 2B via la
passerelle.
network ip policy route show [ dev {2A | 2B} ]
Affiche les informations de route basée sur stratégie pour le périphérique 2A ou 2B.
network ip route add default via <adresse IP>
Définit l'adresse IP de routage de passerelle par défaut.
network ip route delete default
Supprime l'adresse IP de routage de passerelle par défaut.
network ip route {add | del} <adresse IP [/netmask] > dev {1A | 1B | 2A | 2B}
Ajoute ou supprime une adresse de routage IP (Internet Protocol) statique pour un hôte
spécifié. Cette commande permet également à un utilisateur de définir le masque de
réseau pour un port en particulier.

Exemple :

SL8500>network ip route add 129.80.81.59/24 dev 1B
COMPLETED

network ip route {add | del} <adresse IP [/netmask] > via <adresse IP de la
passerelle>
Ajoute ou supprime une route statique à une adresse de passerelle IP du réseau de
destination.
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network ip route show [dev {2A | 2B}]
Affiche les informations de table de routage actuelles ou les informations de table de
routage pour un port en particulier.
network name <chaîne de nom d'hôte>
Définit le nom d'hôte.
network netmask <masque de réseau>
Définit le masque de réseau du réseau externe au format xxx.xxx.xxx.xxx.
network print
Affiche la configuration réseau actuelle pour les ports Ethernet externes (2A et 2B).

partition
Cette commande affiche l'état actuel ou désactive la fonctionnalité de partitionnement.

partition
Affiche l'aide de la commande partition, tout comme "help partition".
partition autoClean set { * | <ID de la partition> }
Définit le nettoyage automatique dans la partition spécifiée (0 correspond à une
bibliothèque non partitionnée).
partition attribute status { * | <ID de la partition> }
Affiche les attributs d'état d'une partition unique spécifiée ou de l'ensemble des partitions.
partition disable
Désactive le partitionnement dans la bibliothèque.
partition getCapacity
Affiche les valeurs de capacité d'une bibliothèque ou d'une partition définie.
partition status
Affiche l'état de partitionnement actuel.
partition setCapacity { <ID de la partition> , <capacité> }
Définit la capacité pour la partition désignée. La capacité des partitions existantes qui ne
sont pas répertoriées par cette commande est définie sur zéro.

Exemple :

SL8500> partition setCapacity 1,200 2,50 3,600
   requestId 7601
   Done
   Failure Count 0
   Success Count 1
COMPLETED

partition setNonPartitionedHLI
Définit la partition sur hli0. Si des lecteurs sont présents dans le pool de validation de
média, ceux-ci doivent être retirés au préalable. Si cette commande est exécutée dans un
complexe, toutes les bibliothèques sont définies sur hli0.
partition set state {online | offline} <ID de la partition>
Définit l'état actuel (en ligne/hors ligne) de la partition spécifiée.
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reControl
Cette commande contrôle/active Redundant Electronics et extrait les états de Redundant
Electronics du contrôleur de la bibliothèque.

reControl
Affiche l'aide de la commande reControl, tout comme "help reControl".
reControl status [ <adresse de la bibliothèque> | * ]
Extrait l'état Redundant Electronics.
• <adresse de la bibliothèque> - indique la bibliothèque au format bibliothèque, rail,

colonne, côté, ligne. Par exemple : 2, 0, 0, 0, 0.
• * - extrait l'état de toutes les bibliothèques d'un complexe

snmp
Cette commande configure le protocole SNMP (Simple Network Management Protocol).
Pour plus d'informations, reportez-vous au SNMP Reference Guide sur OTN.

ssh
Cette commande contrôle la configuration pour le démon/serveur SSH situé sur le HBC.
Il s'agit de l'utilitaire de protocole utilisé par SLC et d'autres applications diverses pour se
connecter au contrôleur de la bibliothèque.

ssh print
Affiche les paramètres du protocole de démon SSH actuels.
ssh set version1and2
Définit la restriction de protocole de démon SSH sur v1 et v2 (il s'agit du paramétrage par
défaut). Le serveur SSH redémarre.
ssh set version2
Définit la restriction de protocole de démon SSH uniquement sur v2.

time
Cette commande définit l'heure de la bibliothèque au format d'heure militaire.

time
Affiche l'aide de la commande time, tout comme "help time".
time print
Affiche l'heure actuelle du système.
time <HH> : <MM>
Définit l'heure système. La résolution temporelle est d'une minute. Dans un complexe
de bibliothèques, la bibliothèque dont le libraryID = 1 est la bibliothèque maître. Il faut
modifier l'heure sur la bibliothèque maître.
• <HH> - heures en deux chiffres
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• <MM> - minutes en deux chiffres
time <HH> : <MM> : <SS>
Définit l'heure système. La résolution temporelle est d'une seconde. Dans un complexe
de bibliothèques, la bibliothèque dont le libraryID = 1 est la bibliothèque maître. Il faut
modifier l'heure sur la bibliothèque maître.
• <HH> - heures en deux chiffres
• <MM> - minutes en deux chiffres
• <SS> - secondes en deux chiffres

traceRoute
Cette commande trace la route réseau vers une adresse IP spécifiée.

traceRoute <adresse IP>
Exécute la commande traceRoute vers l'adresse IP indiquée.

version
Cette commande affiche la version client et les versions des logiciels pour le(s)
périphérique(s) indiqué(s).

version print [ <adresse du périphérique> | *]
Affiche la version logicielle du code d'un périphérique ou de l'ensemble des
périphériques.
• <adresse du périphérique> - indique le périphérique au format bibliothèque, rail,

colonne, côté, ligne.

whereAmi
Cette commande affiche les informations système et de carte logique relatives à la
bibliothèque et à la carte sur lesquelles la commande Redundant Electronics est en cours
d'exécution.

whereAmi
Affiche les informations relatives à l'endroit où la commande est exécutée.

Exemple :

SL8500> whereAmI
   Host Name: gulibtst02b
   Port 2B IP Address: 172.20.151.24
   Library Type: SL8500
   HBC side: B
   Active side: B
COMPLETED
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Annexe C 
Référence de l'adressage de la bibliothèque

Remarque:

Sauf mention contraire, gauche et droite font référence à l'affichage de la bibliothèque depuis le côté du
CAP (face avant).

• Conversion d'une adresse d'emplacement du format HLI au format de bibliothèque à l'aide
de SLC

• Comparaison des schémas d'adressage
• Présentation des éléments structurels utilisés dans l'adressage
• Schéma d'adressage de la bibliothèque interne
• Schéma d'adressage HLI-PRC
• Numérotation matérielle physique des lecteurs de bande
• Adresses IP internes réservées

Conversion d'une adresse d'emplacement du format HLI au
format de bibliothèque à l'aide de SLC

Vous pouvez utiliser SLC pour convertir une adresse de bibliothèque interne (bibliothèque,
rail, colonne, côté, ligne) en adresse HLI (LSM, panneau, ligne, colonne) utilisée par ACSLS
et ELS.

1. Dans SLC, sélectionnez Tools > Diagnostics. Sélectionnez le dossier Library dans
l'arborescence du périphérique.

2. Cliquez sur l'onglet Search.
3. Sélectionnez Location.
4. Sélectionnez les critères de recherche dans la liste déroulante, puis entrez l'adresse (les

caractères génériques sont incorrects).
5. Dans la liste déroulante Requester, sélectionnez hli0 si vous avez entré une adresse HLI

ou sélectionnez default si vous avez entré une adresse de bibliothèque interne.
6. Cliquez sur Search.
7. Si vous avez entré une adresse HLI, l'adresse de bibliothèque interne s'affiche dans

la colonne Address des résultats de recherche. Si vous avez entré une adresse de
bibliothèque interne, cliquez sur . . . pour voir l'adresse HLI.
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Comparaison des schémas d'adressage

• Schéma d'adressage de la bibliothèque interne (bibliothèque, rail, colonne, côté, ligne) :
utilisé par les communications du microprogramme et internes pour représenter tous les
périphériques et emplacements de la bibliothèque.
◦ Commence par 1 et utilise des numéros négatifs.
◦ La colonne indique l'emplacement horizontal dans la bibliothèque
◦ La numérotation des lignes de paroi extérieure va de 1 à 13, et celle de paroi intérieure

de 1 à 14.
• Schéma d'adressage HLI-PRC (LSM, panneau, ligne et colonne) : utilisé par les clients

HLI tels qu'ACSLS et ELS pour représenter les emplacements et les composants de la
bibliothèque.
◦ Commence par 0 et utilise uniquement des numéros positifs.
◦ La colonne indique le côté gauche ou droit de la bibliothèque
◦ La numérotation des lignes de paroi extérieure va de 0 à 12, et celle de paroi intérieure

de 13 à 26.
• Numérotation matérielle physique des lecteurs de bande : emplacements de lecteur

affectés par la carte HBC.
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Figure C.1. Adressage de la bibliothèque interne par rapport à HLI-PRC (vue du
haut de la bibliothèque)

Présentation des éléments structurels utilisés dans l'adressage

Parois

• Chaque côté de la bibliothèque (gauche/droit) a une paroi intérieure et une paroi extérieure.

Baies standard

• Baies à 14 emplacements sur la paroi intérieure
• Baies à 13 emplacements sur la paroi extérieure

Baies spéciales

• Baies à 8 emplacements au-dessus du PTP
• Baies à 8 emplacements sous les supports d'arrêt pour la porte de sécurité de service
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• Baies à 4 emplacements sur les ascenseurs et les PTP
• Baies à 3 emplacements aux extrémités de chaque rail
• Baies à 12 emplacements pour le magasin CAP de chargement en masse

Rails (LSM)

Chaque bibliothèque possède quatre rails robotiques. Pour l'adressage HLI, chacun de ces
rails est considéré comme un module de stockage de bibliothèque (LSM).

Colonnes (Panneaux)

Les colonnes (équivalent des panneaux dans l'adressage HLI-PRC) font référence à
l'emplacement horizontal d'un composant dans la bibliothèque (similaire aux colonnes dans
une feuille de calcul). Les colonnes spéciales incluent :

• Les angles, car il n'y a pas de paroi intérieure
• Les PTP car les six premiers emplacements sont inaccessibles à cause des PTP
• Les panneaux PTP, car l'emplacement de la première cartouche (sous le port) est réservé

comme emplacement de dépose Redundant Robotics (deux pour chaque rail, un à chaque
extrémité)

Schéma d'adressage de la bibliothèque interne
• Présentation de l'adressage de la bibliothèque interne
• Adressage de la bibliothèque interne de lecteur
• Adressage interne des CAP de rotation
• Adressage interne de PTP
• Adressage interne de l'ascenseur
• Adressage interne du robot

Présentation de l'adressage de la bibliothèque interne

L'adressage de la bibliothèque interne désigne l'emplacement utilisant les paramètres Library
(bibliothèque), Rail (rail), Column (colonne), Side (côté), Row (ligne) (L,R,C,S,W).

• Bibliothèque : numéro de la bibliothèque au sein d'un complexe de bibliothèques (toujours
1 pour une bibliothèque unique)

• Rail : rails robotiques numérotés de 1 à 4 de haut en bas.
• Colonne : emplacement horizontal d'un périphérique ou d'un emplacement. La

numérotation des colonnes commence au centre des baies de lecteur et est incrémentée de
+1 à droite ou de -1 à gauche en remontant vers l'avant de la bibliothèque :
◦ +1 est juste à droite du centre des baies de lecteurs.
◦ -1 est juste à gauche du centre des baies de lecteurs.
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◦ Les premières colonnes contenant les cartouches de bande sont +3 et -3.
• Côté : indique les parois intérieure et extérieure, les robots gauche ou droit ou les de

rotation gauche ou droit.
◦ Paroi extérieure = 1, paroi intérieure = 2
◦ Robot gauche = 1, robot droit = 2 (dans des configurations robotiques non redondantes,

le côté est toujours égal à 1)
◦ CAP de rotation droit = 1, CAP de rotation gauche = 2 (pour les CAP de chargement en

masse, le côté est toujours égal à 1)
• Ligne : emplacement vertical d'un périphérique ou d'un emplacement. Les lignes sont

numérotées en consécutif de haut (de 1) en bas (à 13 (paroi extérieure) et 14 (paroi
intérieure)).

Les composants (tels que les CAP, les ascenseurs, les PTP et les robots) disposent de règles
d'adressage uniques :

• Une valeur de ligne égale à 0 indique que l'adresse fait référence au périphérique et non à
un emplacement du périphérique.

• La valeur du côté n'est pas nécessairement directement corrélée avec les parois intérieures
et extérieures.

• La valeur de la colonne des ascenseurs et des CAP dépend du nombre de modules
d'extension de stockage de la bibliothèque.

Adressage de la bibliothèque interne de lecteur

Les lecteurs ont toujours une valeur de colonne comprise entre -2 et 2, une valeur de côté de 1
et une valeur de ligne comprise entre 1 et 4.
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Figure C.2. Adressage de la bibliothèque interne de lecteur de bande (vue
avant de la bibliothèque)

Adressage interne des CAP de rotation
• Rail et ligne :

◦ Lors de la numérotation du périphérique, la valeur du rail est égale à 2 et la valeur de la
ligne est égale à 0.

◦ Lors de la numérotation d'un emplacement spécifique, le rail fait référence au rail
adjacent au magasin CAP (les valeurs peuvent être comprises entre 2 et 4) et la ligne est
l'emplacement dans le magasin CAP (les valeurs peuvent être comprises entre 1 et 13).

• Colonne : la valeur de la colonne est le nombre de colonnes accessibles par le client plus
3. Dans une bibliothèque sans SEM, il existe 11 colonnes accessibles par le client, la valeur
de la colonne de CAP est donc égale à 14.

• Côté :
◦ CAP droit = valeur de côté égale à 1
◦ CAP gauche = valeur de côté égale à 2

Exemple

Pour l'adresse du microprogramme 1, 3, 22, 2, 10 : la valeur de la bibliothèque est égale à 1.
Le rail est le troisième à partir du haut (3). La bibliothèque contient un SEM (19 colonnes
accessibles par le client plus 3 = 22). Le CAP est sur le côté gauche (2). L'emplacement est le
dixième dans le magasin CAP.
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Adressage interne de CAP de chargement en masse

Figure C.3. Baies d'emplacements de CAP de chargement en masse

Légende de la figure

1. Baies de CAP de chargement en masse (12 emplacements chacune)
2. Trois baies de pack
3. Cellules système réservées
4. Porte de sécurité de service (SSD)

Adressage de CAP de chargement en masse :

• Rail : numéro du rail adjacent au CAP (1 à 4).
• Ligne : lors de la numérotation du périphérique, la valeur de ligne est égale à 0. Lors de la

numérotation d'un emplacement spécifique, la valeur de ligne correspond à l'emplacement
dans le magasin CAP (1 à 12).

• Colonne : les magasins CAP occupent les trois dernières colonnes de la bibliothèque. Si la
bibliothèque contient un SEM, il y a 19 colonnes accessibles par le client. En conséquence,
les magasins CAP seraient dans les colonnes 20, 21 et 22.

• Côté : a toujours une valeur égale à 1.

Exemple

Pour l'adresse du microprogramme 1, 3, 22, 2, 10 : la valeur de la bibliothèque est égale à 1.
Le rail est le troisième à partir du haut (3). La bibliothèque contient un SEM (19 colonnes
accessibles par le client, la colonne 22 étant la colonne le plus à l'extérieur). Le CAP est sur le
côté gauche (2). L'emplacement est le dixième dans le magasin CAP.

Adressage interne de PTP

• Rail : la valeur (1 à 4) fait référence au rail adjacent au PTP.
• Colonne : PTP droit = valeur de colonne égale à +6, PTP gauche = valeur de la colonne

égale à -6.
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• Côté : la valeur du côté est toujours égale à 1 car les PTP sont situés sur les parois
extérieures.

• Ligne :
◦ Lors de la numérotation du périphérique, la valeur de la ligne est égale à 0.
◦ Lors de la numérotation d'un emplacement spécifique, la ligne est l'emplacement dans le

PTP (1 ou 2).

Exemple

Pour l'adresse du microprogramme 1, 2, -6, 1, 0 : la valeur de la bibliothèque est égale à 1. Le
PTP est le deuxième rail en partant du haut (2). Il est sur le côté gauche (colonne -6), paroi
extérieure (côté 1) et l'adresse fait référence au périphérique (0).

Adressage interne de l'ascenseur

• Rail : la valeur est toujours égale à 0, puisque les ascenseurs ne correspondent pas à un rail
particulier.

• Colonne : nombre de colonnes accessibles par le client plus 2. Dans une bibliothèque sans
SEM, il existe 11 colonnes accessibles par le client, la valeur de la colonne de l'ascenseur
est donc égale à 13.

• Côté : la valeur est toujours égale à 2 car les ascenseurs se trouvent sur la paroi intérieure.
• Ligne :

◦ Lors de la numérotation du périphérique, la valeur de la ligne est égale à 0.
◦ Lors de la numérotation d'un emplacement spécifique, la ligne est l'emplacement dans

l'ascenseur (1 à 4).

Exemple

Pour l'adresse du microprogramme 1, 0, 21, 2, 4 : la valeur de la bibliothèque est égale à 1.
Les ascenseurs s'étendent sur tous les rails (0). La bibliothèque contient un SEM (19 colonnes
accessibles par le client plus 2 = 21). L'ascenseur se trouve sur la paroi intérieure (côté 2) et
l'adresse fait référence au quatrième emplacement dans l'ascenseur.

Adressage interne du robot

• Rail : la valeur (1 à 4) fait référence au rail sur lequel se trouve le robot.
• Colonne : la valeur est toujours égale à 0.
• Côté :

◦ S'il n'y a qu'un robot par rail, la valeur est toujours égale à 1.
◦ Pour les configurations de robot redondantes, le robot gauche = 1 et le robot droit = 2.

• Ligne :
◦ Lors de la numérotation du périphérique, la valeur de la ligne est égale à 0.
◦ Lors de la numérotation d'un emplacement spécifique, la ligne est la valeur de

l'emplacement (1).
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Exemple

Pour l'adresse du microprogramme 1, 1, 0, 2, 0 : la valeur de la bibliothèque est égale à 1. Le
robot est sur le rail supérieur (1). Le robot s'étend sur toutes les colonnes (0). Il s'agit du robot
droit dans un système robotique redondant (2) et l'adresse fait référence au périphérique (0).

Schéma d'adressage HLI-PRC
• Présentation du schéma d'adressage HLI-PRC
• Numérotation HLI du complexe de bibliothèques
• Adressage HLI-PRC de lecteur

Présentation du schéma d'adressage HLI-PRC

L'adressage HLI-PRC commence par 0, utilise uniquement des nombres positifs et a quatre
paramètres : LSM (Library Storage Module), Panel (panneau), Row (ligne) et Column
(colonne).

• LSM : chaque rail est considéré comme un module de stockage de bibliothèque (LSM)
distinct. Les LSM sont numérotés de 0 à 3 (de haut en bas).

Les bibliothèques dans un complexe sont identifiées par LSM (voir la section la section
intitulée « Numérotation HLI du complexe de bibliothèques » [116]).

• Panneau : indique la position horizontale dans la bibliothèque. Les panneaux s'étendent
sur la largeur de la bibliothèque pour inclure les deux côtés (gauche et droit) et les deux
parois (intérieure et extérieure) de chaque module de stockage de bibliothèque. Panneau 0
= CAP. Panneau 1 = lecteurs. Panneau 2 à n = emplacements de stockage.

Tableau C.1. Numérotation des panneaux pour diverses configurations de
bibliothèque

Configuration Numérotation des panneaux

Bibliothèque de base RIM CIM

2 à 7 8 à 10

Un module d'extension RIM SEM CIM

2 à 7 8 à 15 16 à 18

Deux modules d'extension RIM SEM SEM CIM

2 à 7 8 à 15 16 à 23 24 à 26

Cinq modules d'extension RIM SEM SEM SEM SEM SEM CIM

2 à 7 8 à 15 16 à 23 24 à 31 32 à 39 40 à 47 48 à 50

• Ligne : il s'agit de l'emplacement vertical d'une cartouche de bande. Les lignes sont
numérotées de manière consécutive de haut en bas. Parois extérieures = 0 à 12. Parois
intérieures = 13 à 26.

• Colonne : indique le côté gauche ou droit de la bibliothèque (vue avant). Gauche = 0. Droit
= 1.
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Numérotation HLI du complexe de bibliothèques

Dans un complexe de bibliothèques, le nombre de LSM augmente de manière séquentielle
avec chaque bibliothèque supplémentaire. La numérotation LSM se poursuit selon le schéma
suivant pour un nombre de bibliothèques pouvant aller jusqu'à dix :

• Bibliothèque 1 : LSM 0 à 3
• Bibliothèque 2 : LSM 4 à 7
• Bibliothèque 3 : LSM 8 à 11

Lors de l'ajout d'une bibliothèque à un complexe, vous devez l'ajouter de droite à gauche (vue
du côté CAP de la bibliothèque). Si vous l'ajoutez de gauche à droite, la renumérotation des
LSM requiert une reconfiguration des hôtes.

Figure C.4. Exemple de planification PTP

1. Méthode recommandée pour l'ajout d'une bibliothèque à gauche, qui augmente la
numérotation LSM de manière séquentielle.

2. Méthode avec interruption, qui requiert une reconfiguration de la numérotation LSM.
3. Nouvelle bibliothèque
4. PTP reliant des bibliothèques existantes

Adressage HLI-PRC de lecteur

Pour les lecteurs, la valeur du panneau est toujours égale à 1, la valeur de la colonne est
toujours égale à 0 et la valeur de la ligne est toujours comprise entre 0 et 15.
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Figure C.5. Adressage HLI-PRC de lecteur de bande (vue avant de la
bibliothèque)

Numérotation matérielle physique des lecteurs de bande

La carte HBC affecte un numéro de matériel physique compris entre 1 et 64.
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Figure C.6. Numérotation matérielle physique des lecteurs de bande (vue
arrière de la bibliothèque)
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Figure C.7. Comparaison de la numérotation des lecteurs de bande (vue avant de la
bibliothèque)

Adresses IP internes réservées
Adresse IP Description

10.0.0.0./24 Réseau de périphériques interne.

10.0.11.0/24 Réseau ILC. Adresses IP d'hôte basées sur l'identificateur de bibliothèque.

10.x+2.11.0/24 ou

10.(1...253) + 2.11.0/24

Définition d'alias SDP. X = identificateur complexe (1...253).

10.0.4.0/24 Réseau de périphériques Rail 0.

10.0.3.0/24 Réseau de périphériques Rail 1.

10.0.2.0/24 Réseau de périphériques Rail 2.

10.0.1.0/24 Réseau de périphériques Rail 3.
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Annexe D 
Présentation de Redundant Electronics

La fonctionnalité Redundant Electronics facultative fournit une protection par basculement
pour le contrôleur de la bibliothèque. Si le contrôleur de la bibliothèque ou le contrôleur des
lecteurs présente des erreurs, les opérations seront basculées sur le contrôleur de secours.
Le contrôleur de la bibliothèque et le contrôleur des lecteurs installés dans le même panier à
carte sont toujours basculés simultanément.

La fonction RE permet à un représentant du support technique Oracle de remplacer une carte
défectueuse lorsque la bibliothèque est en ligne et réduit au minimum les interruptions des
opérations lors de la mise à niveau des microprogrammes.

Remarque:

Toute référence à HBCR est également valable pour HBC.

• Conditions requises pour Redundant Electronics
• Exemples de configuration de Redundant Electronics
• Basculement en cas d'incident
• Facteurs qui interdisent le basculement RE
• Facteurs qui déclenchent un basculement automatique
• Comment effectuer un basculement manuel
• Mise à niveau des microprogrammes avec RE

Voir aussi :

• la section intitulée « Exécution d'un basculement RE manuel à l'aide de SLC »

Conditions requises pour Redundant Electronics
• Deux cartes de contrôleur de bibliothèque (HBCR)
• Deux cartes de contrôleur des lecteurs (HBT)

Remarque:

Pour que le mode ADI puisse être activé, les deux cartes doivent être des cartes HBT à grande quantité
de mémoire.

Si la validation de média est utilisée, Oracle recommande que les deux cartes HBT soient à grande
quantité de mémoire.



Exemples de configuration de Redundant Electronics

122

• Microprogramme SL8500 version FRS_6.00 et SLC version 4.65 au minimum
• Fichier d'activation du matériel activé à l'aide de la CLI

Exemples de configuration de Redundant Electronics
Chaque carte de contrôleur de la bibliothèque requiert sa propre adresse IP unique. Pour
la fonctionnalité TCP/IP double, chaque carte requiert 2 adresses IP uniques : une pour le
port principal (2B) et une pour le port secondaire (2A). Ainsi, une bibliothèque dotée des
fonctionnalités Redundant Electronics et TCP/IP double requiert quatre adresses IP uniques.

Sur chaque carte de contrôleur, les ports 2A et 2B doivent se trouver dans deux domaines
de diffusion distincts. Cependant, le port 2B sur la carte active et le port 2B sur la carte de
secours peuvent se trouver sur le même domaine de diffusion. Cette règle est également
valable pour les ports 2A.

Figure D.1. Exemples de configuration de Redundant Electronics

Voir aussi : Annexe E, Présentation de la fonctionnalité TCP/IP double et Annexe F,
Présentation de la fonctionnalité TCP/IP multiple .

Basculement en cas d'incident
Lors d'un basculement de carte de contrôleur, le contrôleur actif de la bibliothèque tente
de terminer toutes les tâches en cours et copie la base de données des cartouches sur la
carte du contrôleur de secours. Si la base de données ne peut pas être copiée (généralement
uniquement en cas de panne soudaine), vous devez exécuter un audit après le basculement
(reportez-vous à Chapitre 10, Audit de la bibliothèque). La bibliothèque replace les
cartouches en transit dans leurs emplacements initiaux. Les cartouches qui ne peuvent pas
être renvoyées dans leur emplacement initial sont placées dans un emplacement système pour
la récupération de l'hôte (voir la documentation du logiciel hôte).

Une fois toutes les tâches en cours terminées ou expirées, les cartes changent de rôle. Le
contrôleur de secours devient actif et le contrôleur précédemment actif devient le contrôleur
de secours. Si le contrôleur de secours précédemment actif ne peut pas activer le logiciel de
secours, le contrôleur présente un état d'erreur.
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Impact d'un basculement sur les utilisateurs

• Les utilisateurs du logiciel de gestion de bandes (Symantec ou Virtual Storage Manager) ne
remarquent pas d'interruption.

• Les applications de l'hôte HLI placent les demandes en file d'attente au cours du processus
de basculement, et ces dernières sont traitées une fois le basculement terminé. Pour
ACSLS, seules les demandes de montage et de démontage sont affectées (voir la
documentation du logiciel hôte).

• Les connexions de SLC et de la CLI sont interrompues. Vous devez rétablir les connexions
à la bibliothèque à l'aide de l'adresse IP ou de l'alias DNS du contrôleur de bibliothèque qui
vient d'être activé (le contrôleur de secours précédent).

Facteurs qui interdisent le basculement RE
• Le contrôleur de secours de la bibliothèque ou le contrôleur des lecteurs présente un état de

panne ou d'éjection.
• Le code de secours n'est pas en cours d'exécution sur les cartes de contrôleur de secours de

la bibliothèque ou des lecteurs.
• Un microprogramme est en cours de téléchargement ou une carte est en cours

d'initialisation.

Facteurs qui déclenchent un basculement automatique
Un basculement automatique peut être déclenché par le contrôleur actif ou le contrôleur de
secours de la bibliothèque.

Le contrôleur actif de la bibliothèque lance un basculement automatique quand :

• La carte de contrôleur des lecteurs qui lui est associée n'est pas installée ou qu'elle ne
communique pas.

• Il détecte une erreur logicielle interne irrémédiable.

Le contrôleur de secours de la bibliothèque lance un basculement automatique si le contrôleur
actif ne fonctionne pas normalement.

Comment effectuer un basculement manuel
Avant de lancer un basculement manuel, vous devez vérifier que les contrôleurs de secours de
la bibliothèque et des lecteurs fonctionnent correctement. Vous pouvez initier un basculement
manuel à l'aide de :

• Gestion des bandes de l'hôte (ACSLS ou ELS) : vous pouvez déclencher le basculement
depuis le contrôleur actif ou de secours de la bibliothèque. Le contrôleur de secours de la
bibliothèque accepte uniquement les demandes HLI set host path group et force
switchover.
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• SLC : le basculement est uniquement lancé depuis le contrôleur actif de la bibliothèque
(voir la section la section intitulée « Exécution d'un basculement RE manuel à l'aide de
SLC »).

• Interface de ligne de commande (CLI) : le basculement peut être lancé depuis le
contrôleur actif ou le contrôleur de secours de la bibliothèque par un représentant du
support technique Oracle.

Vous pouvez souhaiter procéder à un basculement manuel après l'installation initiale des
cartes de secours, après la mise à niveau d'un microprogramme, ou régulièrement pour
vérifier le fonctionnement correct de la fonction de basculement. Il est impossible de basculer
manuellement les contrôleurs de la bibliothèque sans basculer également les contrôleurs des
lecteurs : les contrôleurs sont toujours basculés par paires.

Mise à niveau des microprogrammes avec RE
Pour les bibliothèques dotées de la fonctionnalité RE, les mises à niveau du microprogramme
perturbent très peu le fonctionnement normal. La bibliothèque charge et décompresse le
nouveau code en même temps sur les cartes de contrôleur actives et de secours et sur tous
les périphériques. Puis, elle active le code et réinitialise les contrôleurs et la plupart des
périphériques. Dans la plupart des cas, la bibliothèque ignore l'initialisation du Robot.

Le fonctionnement de la bibliothèque n'est pas interrompu par le chargement, la
décompression et l'activation du code, tant que la bibliothèque n'est pas réinitialisée. Lors
du processus de réinitialisation (qui prend environ 10 minutes), les applications de l'hôte
(ACSLS et ELS) mettent en file d'attente toutes les demandes de montage et de démontage.
Une fois la réinitialisation terminée, les demandes en attente sont soumises au contrôleur de
la bibliothèque.

Reportez-vous à la section Annexe G, Mise à niveau du microprogramme de la bibliothèque
pour plus d'informations sur le téléchargement et l'activation du microprogramme.
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Annexe E 
Présentation de la fonctionnalité TCP/IP double

La fonctionnalité TCP/IP double fournit deux connexions entre l'hôte et la bibliothèque à
l'aide du port principal 2B et du port secondaire 2A de la carte HBC/HBCR. En cas d'échec
de la connexion principale à l'hôte, la bibliothèque utiliser automatiquement la connexion
secondaire.

• Conditions minimales requises pour la fonctionnalité TCP/IP double
• Utilisation d'un réseau partagé
• Configuration de la fonctionnalité TCP/IP double
• Exemples de configuration TCP/IP

Voir aussi
• Annexe D, Présentation de Redundant Electronics
• Documentation ACSLS ou ELS

Conditions minimales requises pour la fonctionnalité TCP/IP
double

• ACSLS 7.1 avec PUT0701 pour Solaris ou AIX. Oracle recommande ACSLS 8.1 ou
version supérieure.

• NCS 6.2 avec les PTF suivants pour HSC/MVS/VM: SOS620 L1H168G, SMS620
L1H168F et MSP: MSP PTF LF620DL.

• Tous les ports du commutateur ou du routeur doivent être configurés pour négocier
automatiquement. Les ports SL8500 sont configurés pour négocier automatiquement par
défaut et prennent en charge des vitesses comprises entre 10 et 100 Mbits/s.

• Fichier d'activation de matériel (voir le Chapitre 3, Activation des fonctionnalités
facultatives)

Utilisation d'un réseau partagé
Remarque:

Oracle recommande l'utilisation d'un réseau privé pour un throughput maximal, une contention des
ressources minimale et une sécurité accrue.

Si vous devez utiliser un réseau partagé :

• Connecter directement la bibliothèque à un commutateur ou un routeur qui filtre le trafic
(de diffusion) non dirigé.
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• Placer la bibliothèque sur son propre sous-réseau. Cela peut protéger la bibliothèque de la
réception de messages de diffusion.

• Utiliser un commutateur ou un routeur géré pour :
◦ Définir des priorités sur les ports afin d'accorder une priorité plus élevée à l'hôte et à la

bibliothèque.
◦ Fournir une bande passante dédiée entre l'hôte et la bibliothèque.
◦ Créer un VLAN entre l'hôte et la bibliothèque.

• Utiliser un réseau privé virtuel (VPN) pour isoler le trafic entre l'hôte et la bibliothèque
d'autres interférences, telles que les diffusions insignifiantes.

Problèmes de diffusions de réseau sur un réseau partagé

Les diffusions envoyées à tous les noeuds de réseau peuvent être dirigées vers la bibliothèque.
Lorsque la bibliothèque reçoit ces diffusions insignifiantes, elle ne peut pas traiter
efficacement les demandes. Par conséquent, l'hôte peut perdre la connexion à la bibliothèque.

Le trafic réseau important peut également submerger le contrôleur Ethernet sur la carte HBC/
HBCR. Par conséquent, le contrôleur est sans cesse réinitialisé.

Inondations ARP sur un réseau partagé

Le processeur de la bibliothèque SL8500 peut être submergé par des inondations de
diffusions ARP (Address Resolution Protocol). Nous vous recommandons de connecter la
bibliothèque derrière un commutateur ou un routeur.

Configuration de la fonctionnalité TCP/IP double
Remarque:

Avant de configurer la fonctionnalité TCP/IP double, rassemblez les informations relatives au réseau, au
routage et aux adresses IP fournies par l'administrateur ou utilisez la commande network ip appropriée.

• Configuration de la bibliothèque pour la fonctionnalité TCP/IP double
• Configuration d'un hôte ACSLS pour la fonctionnalité TCP/IP double
• Configuration d'un hôte ELS pour la fonctionnalité TCP/IP double

Configuration de la bibliothèque pour la fonctionnalité TCP/IP
double

Utilisez la commande route pour gérer les tables de routage. Définissez les routages pour les
ports 2A et 2B vers les hôtes.

1. A l'aide de l'interface de ligne de commande, mettez les deux ports hors ligne :

SL8500> network ip link set dev 2A down

SL8500> network ip link set dev 2B down
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2. Ajoutez les nouvelles adresses IP et les nouveaux masques de sous-réseau pour les deux
ports :

SL8500> network ip address add IP_address/netmask dev 2A

SL8500> network ip address add IP_address/netmask dev 2B

3. Pour rendre effective la modification, mettez les deux ports en ligne :

SL8500> network ip link set dev 2A up

SL8500> network ip link set dev 2B up

4. Saisissez la configuration du routage du réseau pour chaque port :
• Pour les hôtes multiples, ajoutez l'adresse IP et le masque de réseau pour chaque hôte :

SL8500> network ip route add IP_address/netmask dev 2A

SL8500> network ip route add IP_address/netmask dev 2B

• Pour un hôte unique, aucune valeur de masque de réseau n'est requise :

SL8500> network ip policy route add host_IP_address dev 2A

SL8500> network ip policy route add host_IP_address via gateway_IP_address dev 2A

SL8500> network ip policy enable 2A |2B

SL8500> network ip policy status

5. Vérifiez la configuration.

SL8500> network ip address show

SL8500> network ip route show

SL8500> network ip policy route show dev 2A |2B

6. Vérifiez la précision de la date et de l'heure.

SL8500> time

time print

time HH: MM

time HH:MM:SS

7. Testez la configuration pour vous assurer que vous pouvez accéder à la bibliothèque par
le biais des deux ports.

Configuration d'un hôte ACSLS pour la fonctionnalité TCP/IP
double
Pour le serveur ACSLS, vous devez utiliser la commande acsss_config ou l'utilitaire
config Dynamic Configuration pour configurer les deux interfaces réseau sur deux sous-



Exemples de configuration TCP/IP

128

réseaux distincts. Utilisez la commande route pour définir les deux routages sur le serveur
ACSLS. Une seconde connexion physique améliore la fiabilité.

1. Mettez à jour les tables de routage du serveur ACSLS en suivant les instructions de la
documentation ACSLS. S'il existe une interface réseau unique sur le serveur ACSLS,
aucun routage spécial n'est requis sur l'hôte.

2. A l'aide de l'invite de commande UNIX sur le serveur ACSLS, utilisez la commande
Dynamic Config pour ajouter une connexion de port à la bibliothèque SL8500.
a. Assurez-vous qu'ACS est en ligne ou en mode diagnostic vers ACSLS.
b. Utilisez config port acs_id pour ajouter un port.
c. Si ce n'est pas déjà le cas, mettez ACS en ligne vers ACSLS.

3. Pour supprimer ou remplacer une adresse IP existante par un port différent :
a. Interrompez ACSLS à l'aide de la commande kill.acsss (pour 7.3 et inférieur) ou

acsss disable (pour 8.0 et supérieur).
b. Configurez les nouveaux ports à l'aide de la commande acsss_config.
c. Rétablissez ACSLS en ligne à l'aide de la commande rc.acsss (pour 7.3 et

inférieur) ou acsss enable (pour 8.0 et supérieur).

Pour plus d'informations, reportez-vous au ACSLS Administrator's Guide.

Configuration d'un hôte ELS pour la fonctionnalité TCP/IP
double

1. Mettez à jour les tables de routage du mainframe IBM en suivant les instructions de la
documentation ELS. S'il existe une interface réseau unique sur le mainframe IBM, aucun
routage spécial n'est requis sur l'hôte.

2. Sur la console du mainframe IBM ou PARMLIB, utilisez l'instruction de contrôle
LMUPATH pour définir les pièces jointes LMU réseau.

3. Spécifiez un second paramètre LMUADDR pour définir les fonctionnalités TCP/IP double.
ELS détermine automatiquement si la connexion est TCP/IP double ou LMU double.

4. Mettez l'ACS hors ligne, exécutez la commande LMUPDEF et remettez l'ACS en ligne
pour sélectionner l'instruction LMUPATH mise à jour qui inclut la seconde connexion.

Pour plus d'informations, consultez la documentation d'ELS.

Exemples de configuration TCP/IP

• Exemple de la fonctionnalité TCP/IP double ACSLS et de sous-réseaux partagés
• Exemple de fonctionnalité TCP/IP double d'ACSLS via un réseau public
• Exemple de fonctionnalité TCP/IP double d'ACSLS High Availability
• Voir aussi la section la section intitulée « Exemples de configuration de Redundant

Electronics » pour consulter un exemple de RE et de TCP/IP double.
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Exemple de la fonctionnalité TCP/IP double ACSLS et de
sous-réseaux partagés

Dans cet exemple, le serveur ACSLS et la bibliothèque partagent deux sous-réseaux distincts.
La bibliothèque SL8500 utilise une relation biunivoque avec les interfaces réseau sur le
serveur ACSLS. La carte d'interface réseau sur le sous-réseau 192.168.0/23 se connecte au
port 2B tandis que la carte d'interface réseau sur le sous-réseau 192.168.1/23 se connecte au
port 2A.

Routage

Vous pouvez forcer une relation à l'aide des commandes route UNIX. Pour plus
d'informations, reportez-vous au ACSLS Administrator's Guide.

Figure E.1. Fonctionnalité TCP/IP double d'ACSLS avec des sous-réseaux
partagés

Exemple de fonctionnalité TCP/IP double d'ACSLS via un
réseau public

Dans cet exemple, le serveur ACSLS contient deux interfaces réseau qui se trouvent sur deux
sous-réseaux distincts. Les deux interfaces passent par un réseau public et dans deux sous-
réseaux différents avant de se connecter à la bibliothèque SL8500. Cette configuration utilise
les mêmes commandes que le premier exemple.

Figure E.2. Fonctionnalité TCP/IP double d'ACSLS
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Exemple de fonctionnalité TCP/IP double d'ACSLS High
Availability

L'exemple suivant est un environnement ACSLS High Availability (HA) qui requiert la
fonctionnalité TCP/IP double. Le but de l'environnement High Availability (HA) est de
disposer de deux serveurs ACSLS, l'un actif et l'autre de secours. Dans cette configuration,
deux serveurs ACSLS connectent six interfaces réseau (trois sur chaque serveur) à deux sous-
réseaux distincts. Un troisième sous-réseau se connecte à deux serveurs ACSLS via un réseau
public.

Pour plus d'informations sur les fonctionnalités ACSLS HA et TCP/IP double, reportez-vous
au ACSLS Administrator's Guide.

Routage

Vous devez séparer les interfaces réseau de la bibliothèque SL8500 sur deux sous-réseaux
différents lorsque vous utilisez ACSLS HA. Les deux serveurs ACSLS utilisent des interfaces
réseau différentes, c'est pourquoi vous devez ajouter des entrées de routage personnalisées
aux deux serveurs ACSLS HA. Ajoutez les adresses IP des deux serveurs à la configuration
de la bibliothèque SL8500.

Tables de routage

Ajoutez des entrées personnalisées aux tables de routage sur le serveur ACSLS. Toutefois,
toutes les entrées de table de routage personnalisées sont perdues après la réinitialisation du
serveur ACSLS. Pour conserver les entrées de table de routage personnalisées, créez des
scripts pour ajouter des routes personnalisées. Placez les scripts dans la structure de répertoire
rc pour une exécution automatique lors de l'initialisation.

Pour plus d'informations, reportez-vous au ACSLS Administrator's Guide.

Figure E.3. Fonctionnalité TCP/IP double d'ACSLS High Availability
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Exemple ELS/HSC et TCP/IP double

L'exemple suivant présente une configuration recommandée pour les systèmes de mainframe
utilisant la fonctionnalité TCP/IP double. L'hôte du mainframe contient deux interfaces
réseau qui se trouvent sur deux sous-réseaux distincts. Chaque connexion transite par un
réseau public puis se connecte à deux sous-réseaux différents avant d'atteindre la bibliothèque
SL8500.

Pour plus d'informations, reportez-vous à la documentation d'ELS.

Figure E.4. Fonctionnalité TCP/IP double d'ELS/HSC



132



Annexe F. Présentation de la fonctionnalité TCP/IP multiple · 133

Annexe F 
Présentation de la fonctionnalité TCP/IP multiple

La fonctionnalité TCP/IP multiple permet aux hôtes de se connecter à plusieurs bibliothèques
dans un complexe. Si la connexion à une bibliothèque du complexe échoue, l'hôte peut
toujours communiquer via les autres bibliothèques du complexe. Les hôtes ACSLS prennent
en charge jusqu'à 15 connexions et les hôtes ELS jusqu'à 32 connexions.

• Conditions minimales requises pour la fonctionnalité TCP/IP multiple
• Recommandations concernant la configuration
• Exemples de configuration TCP/IP multiple

Voir aussi :

• Annexe E, Présentation de la fonctionnalité TCP/IP double
• Annexe D, Présentation de Redundant Electronics
• Documentation ACSLS et ELS

Conditions minimales requises pour la fonctionnalité TCP/IP
multiple

• Un complexe de bibliothèques
• Microprogramme SL8500 version FRS_3.97 et SLC version 3.38
• ACSLS 7.1 ou 7.1.1 avec PUT0701 (HA 2.0 requiert également PTF 6514766). ACSLS 8

.1 ou version ultérieure requis pour prendre en charge 15 connexions à la bibliothèque.
• ELS version 7.0 avec PTF L1H168H, ou ELS version 7.1 avec PTF L1H168I
• Fichier d'activation de matériel (voir le Chapitre 3, Activation des fonctionnalités

facultatives)

Recommandations concernant la configuration
• Utilisez toujours plusieurs sous-réseaux pour la redondance.
• Pour une seule connexion entre le serveur ACSLS et chaque SL8500, aucune table de

routage n'est nécessaire.
• Pour une bibliothèque avec une fonctionnalité TCP/IP double ou multiple, utilisez la CLI

pour configurer le routage pour le port 2A. Assurez-vous que les ports 2A et 2B sont sur
des domaines de diffusion distincts.

• Pour ELS, utilisez l'instruction de contrôle LMUPATH pour définir plusieurs paramètres
LMUADDR. Les paramètres sont des adresses IP pour les connexions TCP/IP multiples.
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Dans l'exemple suivant, l'hôte est connecté à quatre bibliothèques SL8500.

LMUPATH ACS(00)LMUADDR(123.456.789.012,123.456.789,

013,123.456.789.014,123.456.789.015)

Exemples de configuration TCP/IP multiple
Figure F.1. Connexions TCP/IP multiples à un complexe de bibliothèques

Figure F.2. Connexions TCP/IP doubles et multiples à un complexe de
bibliothèques

Pour plus d'informations, reportez-vous à la section Annexe E, Présentation de la
fonctionnalité TCP/IP double.
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Annexe G 
Mise à niveau du microprogramme de la

bibliothèque

Contactez le support Oracle pour mettre à niveau le microprogramme. Seuls les représentants
du service Oracle doivent installer le nouveau microprogramme de la bibliothèque.

Remarque:

Le téléchargement et l'activation du code ne sont pas disponibles sur le panneau opérateur local.

Le microprogramme de la bibliothèque ne contient pas de mises à niveau de code du lecteur
(voir la documentation spécifique au lecteur).

• Téléchargement du code dans le contrôleur de la bibliothèque
• Activation du code sur le contrôleur de la bibliothèque

Téléchargement du code dans le contrôleur de la bibliothèque
1. Localisez le package de mise à niveau du microprogramme (fichier .jar) à l'adresse :

http://edelivery.oracle.com
2. Téléchargez le code sur votre système.
3. Connectez-vous à SLC.

Si vous mettez à niveau un complexe SL8500, vous pouvez vous connecter à n'importe
quelle bibliothèque du complexe. La mise à niveau se télécharge simultanément sur toutes
les bibliothèques du complexe à partir d'une seule session de SLC.

4. Sélectionnez Tools > Diagnostics, puis sélectionnez le dossier Library dans
l'arborescence du périphérique.

5. Cliquez sur l'onglet Load Code.
6. Localisez le package du microprogramme.
7. Vérifiez le contenu et le nom du fichier. Cliquez sur Load.

Le processus de téléchargement peut durer une dizaine de minutes.
8. Vérifiez que le package s'est correctement décompressé (un 0 s'affiche en regard de

l'étiquette Failed).

Activation du code sur le contrôleur de la bibliothèque
Seuls les représentants du service Oracle doivent installer le nouveau microprogramme de la
bibliothèque. Pour obtenir de l'aide, contactez le support technique Oracle.

http://edelivery.oracle.com
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Remarque:

Une réinitialisation de la bibliothèque est nécessaire pour activer le code. Planifiez l'activation en
conséquence.

1. Téléchargez et décompressez le code (voir la section la section intitulée « Téléchargement
du code dans le contrôleur de la bibliothèque »).

2. Dans SLC, sélectionnez Tools > Diagnostics, puis sélectionnez le dossier Library dans
l'arborescence du périphérique.

3. Cliquez sur l'onglet Activate Code.
4. Dans la liste Target, sélectionnez le package de code que vous souhaitez activer (dans ce

cas, SL8500 Code).
5. Dans la section Available Versions, sélectionnez la version de code à activer. Cliquez sur

Activate.

Attention:

ALTERATION POSSIBLE DE FICHIERS INTERNES. Ne réinitialisez aucun périphérique dans la
bibliothèque et n'exécutez aucune opération sur la bibliothèque pendant l'activation du code.

6. Lorsque le processus d'activation se termine, cliquez sur OK pour réinitialiser la
bibliothèque.

7. Cliquez sur OK pour terminer la session de SLC. Après la fin de l'initialisation de la
bibliothèque, reconnectez-vous à SLC.
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Annexe H 
Contrôle des contaminants

Cette annexe décrit le processus de contrôle des contaminants.

Contaminants présents dans l'environnement
Dans la mesure où les particules en suspension dans l'air risquent d'endommager les
bibliothèques de bandes, lecteurs de bande et supports de bande, il est crucial de surveiller
la concentration des contaminants dans les salles informatiques. Si la plupart des particules
inférieures à dix microns ne sont pas visibles à l'oeil nu dans la plupart des conditions, elles
n'en restent pas moins les plus nuisibles. L'environnement de fonctionnement doit donc
respecter les exigences suivantes :

• Environnement ISO 14644-1 Classe 8.
• La masse totale des particules en suspension dans l'air doit être inférieure ou égale à

200 microgrammes par mètre cube.
• Niveau de gravité G1 selon ANSI/ISA 71.04-1985.

Actuellement, Oracle exige la norme ISO 14644-1 approuvée en 1999, mais exigera toutes
ses mises à jour à mesure de leur approbation par l'organe réglementaire de l'ISO. La norme
ISO 14644-1 s'intéresse principalement à la taille et à la quantité des particules ainsi qu'à la
méthodologie de mesure adéquate, mais n'aborde pas la masse globale des particules. Par
conséquent, l'exigence en termes de limitations de la masse totale est également nécessaire,
car même si une salle informatique ou un centre de données répond à la norme ISO 14644-1,
le type spécifique de particules en suspension risque d'endommager les équipements qui s'y
trouvent. En outre, la spécification ANSI/ISA 71.04-1985 traite des contaminations sous
forme gazeuse, certains produits chimiques en suspension dans l'air étant plus dangereux.
Ces trois exigences correspondent à celles établies par d'autres fournisseurs de stockage sur
bande.

Niveaux exigés en matière de qualité de l'air
Les particules, les gaz et autres contaminants sont susceptibles d'avoir un impact sur le
fonctionnement soutenu du matériel informatique. Les effets peuvent aller d'une interférence
intermittente à une panne réelle de composant. De par sa conception, la salle informatique
doit répondre à un niveau de propreté élevé. Les poussières, gaz et vapeurs en suspension
doivent être maintenus dans les limites définies aux fins de réduire au maximum leurs
éventuels effets sur le matériel.

Les niveaux de particules en suspension dans l'air doivent être conformes aux limites de la
norme Environnement ISO 14644-1 Classe 8. Cette norme définit des classes de qualité de
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l'air pour les zones propres en fonction de la concentration des particules en suspension. En
ordre de grandeur, cette norme fixe un nombre de particules inférieur à celui de l'air normal
dans un environnement de bureau. En général, les particules inférieures à dix microns sont
nuisibles au matériel de traitement de données, car elles existent en grand nombre et peuvent
facilement contourner le système de filtration de l'air interne de nombreux composants
sensibles. Le matériel informatique exposé à un grand nombre de particules submicroniques
met en péril la fiabilité du système, représentant une menace pour les pièces amovibles, les
contacts sensibles et les composants que la corrosion peut dégrader.

Une concentration excessive de certains gaz risque également d'accélérer la corrosion
et de provoquer la panne des composants électroniques. Dans les salles informatiques,
les contaminants sous forme gazeuse constituent un problème particulier en raison de la
sensibilité du matériel et du recyclage quasi complet de l'air ambiant. Dans la salle, la menace
des contaminants est aggravée par le caractère cyclique du flux d'air. Les niveaux d'exposition
qui ne sont pas préoccupants dans un environnement aéré attaquent à maintes reprises
le matériel dans une salle dont l'air est recyclé. L'isolation empêchant toute exposition
de l'environnement informatique au monde extérieur risque également de multiplier les
influences nuisibles ignorées dans la salle.

Les composés chlorés, l'ammoniac et ses dérivés, les oxydes de soufre et les hydrocarbures
sont au nombre des gaz particulièrement nocifs pour les composants électroniques. En
l'absence de limites appropriées d'exposition du matériel, des limites d'exposition constituant
un risque pour la santé s'imposent.

Bien que les sections suivantes décrivent en détail quelques pratiques d'excellence permettant
de conserver un environnement conforme à la norme ISO 14644-1 Classe 8, vous devez
observer certaines précautions élémentaires :

• Aliments et boissons sont à proscrire dans la zone ;
• Les cartons, le bois ou les matériaux d'emballage doivent être stockés dans la zone propre

du centre de données ;
• Une zone distincte doit être consacrée au déballage des nouveaux équipements des caisses

et cartons ;
• Tout travail de construction ou perforation dans le centre de données doit être interdit tant

que les équipements sensibles et l'air qui leur est destiné ne sont pas isolés. Les travaux
de construction génèrent une concentration de particules élevée, au-delà des critères de
la norme ISO 14644-1 Classe 8 dans une zone localisée. Les murs secs et le plâtre sont
particulièrement nuisibles aux équipements de stockage.

Sources et propriétés des contaminants
Dans une salle, les contaminants peuvent prendre de nombreuses formes et provenir de
nombreuses sources. Tout processus mécanique risque de produire des contaminants
dangereux et d'agiter les contaminants sédimentés. Pour être considérée comme un
contaminant, une particule doit répondre à deux critères de base :

• Elle doit posséder les propriétés physiques susceptibles d'endommager le matériel ;
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• Elle doit pouvoir migrer dans des zones où elle est susceptible de provoquer des dommages
physiques.

Seuls le moment et l'endroit permettent de distinguer un contaminant réel d'un contaminant
potentiel. En suspension dans l'air, les matières particulaires risquent de migrer vers des zones
où elles peuvent provoquer des dégâts. Pour cette raison, la concentration des particules
atmosphériques représente une mesure utile de la qualité environnementale de la salle
informatique. En fonction des conditions locales, les particules d'un millier de microns
peuvent s'élever dans l'air, mais leur vie active est très courte et elles sont retenues par la
plupart des dispositifs de filtration. Les particules submicroniques sont plus dangereuses pour
le matériel informatique sensible, car elles restent suspendues dans l'air plus longtemps et
sont plus susceptibles de contourner les filtres.

Activité des opérateurs
Le mouvement humain constitue probablement la source de contamination la plus importante
dans une salle informatique par ailleurs propre. Un mouvement normal est susceptible
de déloger des fragments tissulaires, tels que des cheveux ou des pellicules, ou les fibres
textiles des vêtements. L'ouverture et la fermeture de tiroirs ou de panneaux, ou toute activité
de métal sur métal risquent de produire de la limaille. Le simple fait de marcher risque
de soulever les contaminants sédimentés, qui peuvent alors s'élever dans l'air et devenir
dangereux.

Déplacement de matériel
L'installation et la reconfiguration matérielles impliquent une activité importante sur le sous-
plancher ; facilement délogés, les dépôts contaminants s'élèvent dans l'air et rejoignent le flux
d'air d'alimentation du matériel de la salle. Le danger est plus important encore lorsque le
sous-plancher n'est pas vitrifié. Le béton non vitrifié répand de fines particules de poussière
dans le flux d'air et présente des risques d'efflorescence (dépôts de sels minéraux sur le
plancher dus à l'évaporation ou à la pression hydrostatique).

Air extérieur
S'il n'est pas correctement filtré, l'air extérieur à l'environnement contrôlé peut introduire
de nombreux contaminants. Les contaminants post-filtration dans les conduites peuvent
être délogés par le flux d'air et introduits dans l'environnement matériel. Le risque est
particulièrement important dans les systèmes de climatisation de flux descendant dans
lesquels le vide du sous-plancher fait office de conduite d'alimentation d'air. Lorsque la
structure est contaminée ou que les dalles de béton ne sont pas vitrifiées, de fines particules
(efflorescence ou poussière de béton) risquent d'être transportées directement vers le matériel
de la salle.

Eléments stockés
Le stockage et la manutention de matériaux ou fournitures non utilisés peuvent constituer
des sources de contamination. Lors de leur déplacement ou manipulation, les boîtes en
carton ondulé ou les palettes de bois répandent des fibres. Les éléments stockés ne sont
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pas que sources de contamination ; leur manipulation dans les zones contrôlées de la salle
informatique peut soulever les contaminants sédimentés.

Influences extérieures
Un environnement sous pression négative risque de laisser s'infiltrer les contaminants
provenant des espaces de bureaux adjacents ou de l'extérieur du bâtiment par les interstices
dans les portes ou fissures dans les murs. L'ammoniac et les phosphates sont fréquemment
associés aux processus agricoles et de nombreux agents chimiques peuvent être produits dans
les zones de fabrication. Lorsque ces industries sont présentes à proximité des installations
du centre de données, la filtration chimique peut se révéler nécessaire. Le cas échéant, il est
conseillé d'évaluer les conséquences éventuelles des émissions automobiles, des poussières de
carrières et d'usines de fabrication de produits de maçonnerie, et des brumes marines.

Activité de nettoyage
Des méthodes de nettoyage inappropriées peuvent également dégrader l'environnement.
De nombreux produits chimiques utilisés pour le nettoyage normal ou de bureau sont
susceptibles d'endommager les équipements informatiques sensibles. L'utilisation des
produits chimiques éventuellement dangereux répertoriés à la section la section intitulée
« Equipement et procédures de nettoyage » est déconseillée. Le dégagement gazeux de
ces produits ou leur contact direct avec les composants matériels risque de provoquer des
défaillances. Certains traitements biocides utilisés dans les systèmes de traitement de l'air des
bâtiments ne conviennent pas non plus aux salles informatiques, soit parce que les produits
chimiques qu'ils contiennent peuvent endommager les composants, soit parce qu'ils ne sont
pas conçus pour une utilisation dans le flux d'air d'un système de recyclage de l'air. Un balai-
serpillère ou un aspirateur muni d'un filtre inadéquat peuvent également être sources de
contamination.

Il est essentiel de prendre les mesures adéquates pour empêcher les contaminants (particules
métalliques, poussières atmosphériques, vapeurs de solvants, gaz corrosifs, suie, fibres
en suspension ou sels) d'entrer dans l'environnement de la salle informatique ou d'y être
générés. En l'absence de limites d'exposition du matériel, il est conseillé d'appliquer le seuil
d'exposition humaine défini par les organismes OSHA, NIOSH ou ACGIH.

Effets des contaminants
Les interactions destructives entre les particules en suspension et les instruments
électroniques peuvent se manifester de différentes façons. Les interférences dépendent
du moment et de l'endroit où survient l'incident critique, des propriétés physiques du
contaminant et de l'environnement dans lequel le composant est placé.

Interférences physiques
Les particules solides d'une résistance à la traction égale ou supérieure à 10 % de celle
du composant peuvent enlever du matériau de la surface du composant par abrasion ou
incrustation. Les particules molles n'endommageront pas le composant, mais peuvent
s'accumuler et nuire à son fonctionnement. Si ces particules sont collantes, elles peuvent



Conditions ambiantes

Annexe H. Contrôle des contaminants · 141

recueillir d'autres matières particulaires. Même des particules très petites peuvent avoir une
incidence négative si elles s'agglutinent sur une surface collante ou s'agglomèrent suite à une
accumulation de charge électrostatique.

Défaillance due à la corrosion
La corrosion ou un contact intermittent dus à la composition intrinsèque des particules ou à
l'absorption de vapeur d'eau et de contaminants gazeux par les particules peuvent également
provoquer des défaillances. La composition chimique du contaminant peut revêtir une
grande importance. Le sel, par exemple, peut se dilater par absorption de la vapeur d'eau
contenue dans l'air (nucléation). Dans un environnement suffisamment humide, un dépôt
de sels minéraux à un emplacement sensible risque d'augmenter de volume et d'entraver un
mécanisme ou de provoquer des dommages en formant des solutions salines.

Courts-circuits
Sur les cartes de circuit imprimé ou autres composants, l'accumulation de particules
risque de créer des pistes conductrices. Bien qu'elles ne soient pas conductrices par
nature, de nombreuses particules peuvent absorber une importante quantité d'eau dans
des environnements où le degré hygrométrique est élevé. Les problèmes provoqués par
les particules électroconductrices peuvent aller d'un dysfonctionnement intermittent à des
défaillances d'exploitation en passant par des dommages réels occasionnés aux composants.

Défaillance thermique
L'encrassement précoce des dispositifs filtrés entraîne une restriction du flux d'air, susceptible
de provoquer une surchauffe interne et un écrasement de tête. Sur les composants matériels,
une accumulation importante de poussière risque également de former une couche isolante
susceptible de provoquer des défaillances thermiques.

Conditions ambiantes
Un niveau élevé de propreté doit être maintenu pour toutes les surfaces situées à l'intérieur
de la zone contrôlée du centre de données. Toutes les surfaces doivent être nettoyées
régulièrement par des professionnels ayant suivi une formation à cet effet, comme indiqué à
la section la section intitulée « Equipement et procédures de nettoyage ». Un soin particulier
doit être porté aux espaces en dessous du matériel et à la grille du faux-plancher. Les
contaminants situés à proximité des entrées d'air du matériel peuvent être plus facilement
déplacés vers des zones où ils risquent de provoquer des dommages. Les particules
accumulées sur la grille du faux-plancher peuvent s'élever dans l'air lorsque les dalles sont
soulevées pour accéder au sous-plancher.

Le vide du sous-plancher dans un système de climatisation à flux descendant sert de plénum
d'alimentation en air. Cette zone est pressurisée par les climatiseurs et l'air climatisé est
ensuite introduit dans les espaces matériels à travers les panneaux de plancher perforés. Ainsi,
l'air circulant des climatiseurs vers le matériel doit d'abord traverser le vide du sous-plancher.
Des conditions inadéquates dans le plénum d'alimentation d'air risquent d'avoir de graves
conséquences sur l'état des zones matérielles.
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Dans un centre de données, le vide du sous-plancher se limite souvent à un espace où il
est pratique de faire passer les câbles et les canalisations. Gardez à l'esprit qu'il constitue
également un conduit et que la propreté de l'espace sous le faux-plancher doit être maintenue
à un niveau élevé. Les matériaux de construction qui se dégradent, l'activité des opérateurs ou
les infiltrations provenant de l'extérieur de la zone contrôlée sont quelques-unes des sources
de contamination. Des dépôts se forment souvent aux endroits où les câbles et autres éléments
de sous-plancher constituent des barrages d'air permettant aux particules de s'accumuler.
Lorsque ces éléments sont déplacés, les particules sont réintroduites dans le flux d'air et
transportées directement vers le matériel.

Les matériaux de construction endommagés ou mal protégés constituent des sources
fréquentes de contamination du sous-plancher. Au fil du temps, le béton, les blocs de
maçonnerie, le plâtre ou le gypse se détériorent et répandent de fines particules dans l'air. La
corrosion sur les éléments du sous-plancher et les surfaces des climatiseurs de post-filtration
peut également poser un problème. Une décontamination minutieuse, adéquate et régulière
du vide du sous-plancher permet d'éliminer ces contaminants. Seuls les aspirateurs dotés de
filtres HEPA (High Efficiency Particulate Air, haute efficacité pour les particules de l'air)
doivent être utilisés dans le cadre de la procédure de décontamination. Les aspirateurs équipés
de filtres inadéquats ne retiennent pas les particules fines, qui défilent à grande vitesse dans
l'unité d'aspiration avant d'être propulsées dans l'air.

Le béton non vitrifié et autres matériaux de maçonnerie subissent une dégradation constante.
Les enduits d'étanchéité et les durcisseurs utilisés en construction sont conçus pour protéger
le plancher des déplacements nombreux ou pour le préparer à l'application de matériaux de
revêtement ; ils ne sont pas destinés aux surfaces intérieures d'un plénum d'alimentation d'air.
Bien qu'une décontamination régulière permet d'éliminer les particules libres, les surfaces
continuent de subir une dégradation lente et l'activité provoque l'usure du sous-plancher. Dans
l'idéal, toutes les surfaces du sous-plancher doivent être correctement scellées au moment de
la construction. Si tel n'est pas le cas, des précautions spéciales doivent s'appliquer quant aux
surfaces de l'espace en ligne.

Il est crucial de n'utiliser que les matériaux et la méthodologie adéquats dans le processus
d'encapsulation. En effet, des procédures ou enduits d'étanchéité inadéquats risquent de
dégrader les conditions qu'ils sont censés améliorer et de détériorer par là même la fiabilité
et l'exploitation du matériel. Les précautions suivantes s'appliquent lors de l'encapsulation du
plénum d'alimentation d'air dans l'espace en ligne :

• Appliquez la substance d'encapsulation manuellement. La vaporisation est totalement
inadaptée dans un centre de données en ligne. Elle propulse l'enduit d'étanchéité dans le
flux d'air et risque d'encapsuler les câbles au plancher.

• Utilisez une substance d'encapsulation pigmentée. La pigmentation permet de voir la
substance d'encapsulation lors de son application, ce qui garantit une couverture complète
et permet d'identifier les zones endommagées ou exposées au fil du temps.

• La substance d'encapsulation doit présenter une grande flexibilité et une faible porosité
pour couvrir de manière efficace les textures irrégulières de la zone à traiter et réduire au
minimum la migration de l'humidité et les dommages que l'eau peut provoquer.
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• La substance d'encapsulation ne doit pas libérer de contaminants nocifs sous forme
gazeuse. De nombreuses substances utilisées dans l'industrie présentent une teneur élevée
en ammoniac ou contiennent des produits chimiques nuisibles pour le matériel. Il est peu
probable que ce dégagement gazeux provoque des défaillances immédiates et désastreuses,
mais ces produits chimiques contribuent souvent à la corrosion des contacts, têtes et autres
composants.

Une encapsulation réussie du sous-plancher d'une salle informatique en ligne est une tâche
difficile et délicate. Toutefois, elle peut être réalisée en toute sécurité si vous appliquez
les matériaux et procédures qui conviennent. Evitez d'utiliser le faux-plafond pour
l'alimentation ou la reprise du système d'aération du bâtiment. Difficile à nettoyer, cette zone
est particulièrement sale. La surface des structures est souvent recouverte de revêtements
ignifuges fibreux, et les dalles de plafond et l'isolant sont également sujets à la diffusion de
particules. Avant même la filtration, cette exposition inutile risque de nuire aux conditions
environnementales de la salle. Il est également important que le vide du plafond ne soit pas
pressurisé, car de l'air non filtré pourrait s'infiltrer dans la salle informatique. Des colonnes ou
enveloppes de câbles pénétrant dans le sous-plancher et le faux-plafond peuvent provoquer la
pressurisation du faux-plafond.

Zones d'exposition
Toutes les zones d'exposition potentielles du centre de données doivent être traitées en
vue de réduire au maximum les influences éventuelles provenant de l'extérieur de la zone
contrôlée. La pressurisation positive de la salle informatique permet de limiter l'infiltration
des contaminants. Toutefois, la réduction des brèches dans le périmètre de la salle est tout
aussi importante. Pour conserver votre environnement dans les meilleures conditions, prenez
en compte les points suivants :

• Toutes les portes doivent être parfaitement ajustées à leur encadrement.
• Vous pouvez utiliser des joints et balais de porte pour éliminer les espaces vides.
• Evitez les portes automatiques dans les zones où leur ouverture peut se déclencher par

mégarde. Un autre moyen de contrôle consiste à placer à distance un déclencheur de porte
de manière à ce que le personnel de manutention puisse ouvrir les portes facilement. Dans
les zones particulièrement sensibles ou celles où le centre de données est exposé à des
conditions indésirables, il peut être judicieux d'installer des sas. Un double ensemble de
portes muni d'un tampon permet de limiter l'exposition directe aux conditions extérieures.

• Scellez toutes les entrées séparant le centre de données des zones adjacentes.
• Evitez de partager le plafond de la salle informatique ou le plénum du sous-plancher avec

les zones adjacentes qui ne sont pas strictement contrôlées.

Filtration
La filtration constitue un moyen efficace d'éliminer les particules en suspension dans
un environnement contrôlé. Il est important que tous les appareils de traitement de l'air
du centre de données soient filtrés de manière adéquate afin de garantir le maintien des
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conditions optimales dans la salle. Le refroidissement des processus à l'intérieur de la salle est
recommandé dans le cadre du contrôle de l'environnement. Les refroidisseurs de processus
font recirculer l'air ambiant. L'air des zones de matériel transite dans les unités où il est
filtré et refroidi, puis introduit dans le plénum du sous-plancher. Le plénum étant pressurisé,
l'air climatisé entre de force dans la salle par les dalles perforées, avant de retourner vers
le climatiseur. La conception et la configuration de la circulation de l'air associées à un
dispositif classique de traitement d'air dans les salles informatiques présentent un taux de
renouvellement d'air supérieur à celui des climatiseurs de confort. L'air y est donc filtré
plus souvent que dans un environnement de bureau. Une filtration idoine peut capturer une
grande quantité de particules. Les filtres installés dans les climatiseurs de recirculation de
la salle informatique doivent offrir un taux de rendement minimal de 40 % (norme 52.1 de
l'ASHRAE sur l'efficacité en matière de particules de poussière atmosphérique). L'installation
de préfiltres de faible qualité doit permettre de prolonger la durée de vie des filtres principaux
plus onéreux.

L'air introduit dans la zone contrôlée de la salle informatique pour la ventilation ou la
pressurisation positive doit d'abord passer par un dispositif de filtration haute performance.
Dans des conditions idéales, l'air provenant de sources extérieures au bâtiment doit être filtré
selon un taux de filtration HEPA d'un rendement de 99,97 % (DOP Efficiency MILSTD-282)
ou plus. Il est conseillé de protéger les coûteux filtres à haute efficacité par plusieurs couches
de préfiltres que vous changerez plus fréquemment. Les préfiltres de faible rendement
(efficacité en matière de particules de poussière atmosphérique de 20 %) doivent constituer
la première ligne de défense. La seconde batterie de filtres doit se composer de filtres de
type "sac" ou plissés d'un rendement compris entre 60 et 80 % de l'efficacité définie par
l'ASHRAE en matière de particules de poussière atmosphérique.

Tableau H.1. Pourcentages de filtration

Taux d'efficacité en matière
de particules de poussière
atmosphérique défini par la
norme 52-76 de l'ASHRAE

3,0 microns 1,0 micron 0,3 micron

25 - 30 % 80 % 20 % < 5 %

60 - 65 % 93 % 50 % 20 %

80 - 85 % 99 % 90 % 50 %

90 % > 99 % 92 % 60 %

DOP 95 % N/D > 99 % 95 %

Les filtres de faible rendement se révèlent pratiquement inefficaces pour éliminer les
particules submicroniques de l'air. Il est également important que les filtres utilisés présentent
la taille correspondant aux dispositifs de traitement de l'air. En effet, des interstices autour des
panneaux risquent de laisser l'air contourner le filtre lorsqu'il circule à travers le climatiseur.
Tous les espaces et ouvertures doivent être remplis à l'aide de matériaux appropriés, tels que
des panneaux en acier inoxydable ou des assemblages de filtre personnalisés.
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Pressurisation positive et ventilation
Il est nécessaire de prévoir une entrée d'air provenant de l'extérieur du système de la salle
informatique pour répondre aux exigences en termes de pressurisation positive et de
ventilation. Le centre de données doit être conçu pour une pressurisation positive, dont ne
disposent pas les zones adjacentes moins strictement contrôlées. La pressurisation positive
des zones plus sensibles est un moyen efficace de contrôler l'infiltration des contaminants au
travers des petites brèches présentes dans le périmètre de la salle. Les systèmes de pression
positive visent à exercer des forces d'air extérieures sur les portes et autres points d'accès dans
l'enceinte du centre de traitement afin de réduire l'infiltration des contaminants dans la salle
informatique. La quantité d'air introduite dans l'environnement contrôlé doit être minimale.
Dans les centres de données comportant plusieurs salles, les zones les plus sensibles doivent
être les plus pressurisées. Il est cependant très important que l'air utilisé pour la pressurisation
positive ne nuise pas aux conditions environnementales de la salle. Il est essentiel que l'entrée
d'air provenant de l'extérieur de la salle informatique soit filtrée et climatisée de manière
adéquate dans le cadre de paramètres acceptables. Ces paramètres peuvent être moins stricts
que les conditions souhaitées pour la salle dans la mesure où l'entrée d'air doit être minimale.
L'identification précise de limites acceptables doit reposer sur la quantité d'air introduite et les
effets éventuels sur l'environnement du centre de données.

Dans la mesure où un système de climatisation en circuit fermé équipe la plupart des centres
de données, il est nécessaire d'introduire une quantité minimale d'air afin de satisfaire
aux exigences de ventilation des occupants de la salle. En général, les zones des centres
de données présentent une faible densité de population ; la quantité d'air nécessaire à la
ventilation est donc minimale. Dans la plupart des cas, la quantité d'air nécessaire à la
pressurisation positive dépasse probablement celle nécessaire à la ventilation de la salle.
En règle générale, une quantité d'air extérieur inférieure à 5 % doit être suffisante pour
la ventilation d'appoint (manuel de l'ASHRAE : Applications, Chapitre 17). Un volume
de 15 CFM d'air extérieur par occupant ou station de travail doit suffire aux besoins de
ventilation de la salle.

Equipement et procédures de nettoyage
Même les centres de données les mieux conçus doivent faire l'objet d'un entretien constant.
Le maintien des conditions dans les limites souhaitées risque d'exiger des efforts importants
dans les centres de données dont la conception présente des défauts ou a fait l'objet de
compromis. La performance matérielle est un facteur important de la nécessité de maintenir
un niveau élevé de propreté dans le centre de données.

La sensibilisation des opérateurs est un autre point à prendre en considération. Le maintien
d'un niveau élevé de propreté permet de mieux sensibiliser les occupants aux exigences et
restrictions qui s'appliquent à leur présence dans le centre de données. Les occupants et les
visiteurs du centre de données tiendront l'environnement contrôlé en haute considération et
seront plus enclins à agir comme il se doit. Un environnement maintenu à un niveau élevé
de propreté et de manière structurée et organisée inspire également le respect des occupants
et des visiteurs de la salle. Les clients potentiels qui visiteront la salle interprèteront l'aspect
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général de la salle comme le reflet d'un engagement global envers l'excellence et la qualité.
Un calendrier de nettoyage efficace doit comporter des actions précises sur les long et moyen
termes. Elles peuvent se résumer comme suit :

Tableau H.2. Planification du nettoyage d'un centre de données

Fréquence Tâche

Actions quotidiennes Ramassage des déchets

Actions hebdomadaires Entretien du faux-plancher (aspirateur et serpillière humide)

Actions trimestrielles Décontamination du matériel

Décontamination des surfaces de la salle

Actions semestrielles Décontamination du vide du sous-plancher

Décontamination du climatiseur (le cas échéant)

Tâches quotidiennes

Ce cahier des charges se concentre sur le retrait des déchets et rebuts quotidiens de la salle.
En outre, il peut être nécessaire de passer chaque jour l'aspirateur dans les salles d'impression
ou les pièces dans lesquelles l'activité des opérateurs est importante.

Tâches hebdomadaires

Ce cahier des charges est principalement axé sur l'entretien du système de faux-plancher. Tout
au long de la semaine, les accumulations de poussières et les taches souillent le faux-plancher.
Le faux-plancher tout entier doit être nettoyé au moyen d'un aspirateur et d'une serpillière
humide. Indépendamment de leur utilisation, tous les aspirateurs utilisés dans le centre de
données doivent être équipés de la filtration HEPA (High Efficiency Particulate Air, haute
efficacité pour les particules de l'air). Les équipements dotés de filtres inadéquats ne sont pas
en mesure de retenir les particules plus petites. Au contraire, ils ne font que les agiter, ce qui
dégrade l'environnement qu'ils sont censés améliorer. Il est important que les serpillières et
les chiffons ne peluchent pas.

Les solutions de nettoyage utilisées dans le centre de données ne doivent pas constituer de
menace pour le matériel. Les solutions susceptibles d'endommager le matériel comportent les
produits suivants :

• Ammoniac
• Chlore
• Phosphate
• Javel
• Produits pétrochimiques
• Décapants et rénovateurs.

Il est également important de s'en tenir aux concentrations recommandées. En effet, un agent
approprié risque de provoquer des dommages en cas de concentration inappropriée. La
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solution doit être conservée en bonne condition tout au long du processus et les applications
excessives doivent être évitées.

Tâches trimestrielles

Le cahier des charges trimestriel implique un calendrier de décontamination exhaustif et
détaillé. Il ne doit être mené que par des professionnels expérimentés du contrôle de la
contamination des salles informatiques. Ces opérations doivent être réalisées entre trois
et quatre fois par an, en fonction des niveaux d'activité et de la présence de contaminants.
Toutes les surfaces de la salle, y compris les placards, rebords, étagères, rayons et
équipements de support, doivent faire l'objet d'une décontamination en profondeur. Les
étagères en hauteur et les appareils d'éclairage ainsi que les zones généralement accessibles
doivent être traités et nettoyés comme il se doit. Les surfaces verticales, telles que les
fenêtres, cloisons en verre, portes, etc., doivent être soigneusement nettoyées. Lors du
processus de décontamination des surfaces, il convient d'utiliser des chiffons imprégnés d'une
substance absorbant les particules. Dans le cadre de ces activités, toute étoffe ou tout chiffon
à poussière classique est à proscrire, tout comme les produits chimiques, cires et dissolvants.

Les dépôts de contaminants doivent être éliminés de l'ensemble des surfaces extérieures du
matériel, y compris les surfaces horizontales et verticales. Les grilles d'entrée et de sortie
d'air de l'unité doivent également être traitées. Ne nettoyez pas les surfaces de contrôle
de l'unité ; elles peuvent être décontaminées en insufflant de l'air légèrement comprimé.
Apportez un soin particulier au nettoyage des claviers et des commandes associées à la
sécurité des personnes. Pour nettoyer les surfaces du matériel, utilisez des chiffons ayant
subi un traitement spécial. Passez un produit d'entretien optique et un chiffon antistatique
sur les écrans. N'utilisez pas de produits chimiques dissipatifs de charge électrostatique sur
le matériel informatique ; leur causticité risque d'endommager la plupart des équipements
délicats. Dans la mesure où le matériel informatique est conçu pour dissiper la charge
électrostatique, aucun traitement supplémentaire n'est nécessaire. Après avoir décontaminé en
profondeur toutes les surfaces et tout le matériel de la salle, passez l'aspirateur HEPA et une
serpillière humide comme décrit en détail dans la section Tâches hebdomadaires.

Tâches trimestrielles

Le vide du sous-plancher doit être décontaminé tous les 18 ou 24 mois en fonction de
l'état des surfaces du plénum et du degré d'accumulation des contaminants. Tout au long
de l'année, le vide du sous-plancher subit un volume important d'activités à l'origine de
nouvelles accumulations de contaminants. Bien que les activités hebdomadaires de nettoyage
du plancher décrites ci-dessus permettent de réduire en grande partie les accumulations
de contaminants, une certaine quantité de poussières migre des surfaces au vide du sous-
plancher. Il est important de maintenir le degré élevé de propreté du sous-plancher, qui sert
de plénum d'alimentation d'air du matériel. Pour réduire la contamination croisée, mieux
vaut effectuer le traitement de décontamination du sous-plancher dans un délai assez bref.
Le personnel chargé de cette opération doit avoir reçu une formation complète afin d'évaluer
la priorité et la connectivité des câbles. Chaque zone exposée du vide du sous-plancher doit
faire l'objet d'une inspection et d'une évaluation individuelle en termes de déplacement et de
manipulation de câbles. Avant de déplacer des câbles, vérifiez que toutes les connecteurs de
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type enfichage ou rotation sont correctement branchés. Menez toutes les activités concernant
le sous-plancher en prenant en compte la distribution de l'air et la charge au sol. Dans le
but de maintenir l'intégrité du faux-plancher et les conditions psychrométriques, gérez avec
précaution le nombre de dalles que vous retirez du système de plancher. Dans la plupart des
cas, l'ouverture dans le faux-plancher ne doit pas dépasser 2,23 mètres carrés (six dalles) pour
chaque équipe de travail à tout moment. Le système de grille d'appui du faux-plancher doit
également être décontaminé en profondeur ; aspirez d'abord les débris détachés, puis passez
une éponge humide sur les résidus accumulés. Le cas échéant, les joints en caoutchouc et
la structure métallique composant le système de grille doivent être retirés et nettoyés avec
une éponge humide. Notez et signalez tout état inhabituel du vide du plancher, comme par
exemple les surfaces, câbles, dalles et suspensions endommagés.

Activités et processus
Dans le cadre du maintien des conditions d'un centre de données, l'isolation est un facteur
primordial. Toute activité inutile doit être évitée dans le centre de données, dont l'accès
doit être réservé au personnel indispensable. Les activités périodiques, telles que les
visites, doivent être limitées et les déplacements doivent s'effectuer à distance du matériel
afin d'éviter tout contact accidentel. L'ensemble du personnel travaillant dans la salle, y
compris les employés temporaires et le personnel d'entretien, doit recevoir une formation
sur les points sensibles de base du matériel afin d'éviter toute exposition inutile. Les zones
contrôlées du centre de données doivent être parfaitement isolées de toute activité générant
des contaminants. Dans l'idéal, les salles d'impression, salles de tri, centres de commande
ou toute autre zone dans laquelle les niveaux d'activité humaine ou mécanique sont élevés
ne doivent pas présenter d'exposition directe au centre de données. Les accès à ces zones ne
doivent pas nécessiter de déplacements via les zones principales du centre de données.
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Glossaire
2N Configuration d'alimentation facultative assurant une redondance

d'alimentation CA et CC. Il y a une alimentation pour quatre lecteurs de
bande et une alimentation pour chaque robot. Cette configuration requiert
une seconde source d'alimentation CA pour prendre en charge une PDU
système supplémentaire. Les quatre racks auxiliaires sont alimentés. Voir
aussi N+1.

ADI Interface du lecteur d'automatisation. Prend en charge les données riches
pour StorageTek Tape Analytics.

Adresse de baie de
lecteurs

Nombre entier à dix chiffres compris entre 01 et 64 qui représente les
emplacements physiques dans lesquels sont insérés les assemblages de tiroirs
de lecteurs.

Ascenseur Périphérique qui transporte les cartouches verticalement. La bibliothèque
SL8500 contient deux ascenseurs qui déplacent les cartouches entre les rails
de la bibliothèque.

Audit Inventaire des emplacements des cartouches dans toutes les zones de la
bibliothèque, incluant les emplacements dans la zone de stockage et la zone
réservée. Des audits sont effectués lorsque :

• La bibliothèque est initialisée lors de la mise sous tension.
• Une porte d'accès, ou les deux, sont ouvertes et fermées sans activer la

porte de sécurité de service.
• Une demande d'audit physique est effectuée via SLC.

Voir aussi Audit de l'hôte, Audit physique, Audit de vérificationet Audit
virtuel.

Audit de l'hôte Processus de mise à jour des ID de volume et emplacements de cartouche
dans une base de données hôte. L'audit est initié par une commande de l'hôte.

Audit de vérification Les audits de vérification sont appelés à partir de la console SLC et
permettent de valider le statut d'un emplacement de cartouche ou d'une plage
d'emplacements spécifique.

Audit physique Des audits physiques ont lieu lorsque les robots :

• Scannent les emplacements de cartouche dans la bibliothèque.
• Vérifient les volumes.
• Mettent à jour l'inventaire de la carte de contrôle de la bibliothèque.
• Définissent le statut de l'emplacement de la cartouche sur "true".
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Audit virtuel Les audits virtuels sont appelés à partir de la SLC et affichent uniquement
l'inventaire des cartouches dans l'écran de la console (local ou distant).

Baie d'unités Boîtier métallique installé dans le module des lecteurs et de système
électronique servant au montage d'assemblages de tiroir de lecteur de bande.
Le module des lecteurs et de système électronique contient jusqu'à quatre
assemblages de baies et chaque baie inclut jusqu'à 16 assemblages de tiroirs
de lecteurs de bande.

Baie de cartouches Boîtier en plastique contenant plusieurs cartouches quand elles ne sont pas
en cours d'utilisation. Les parois intérieures de la bibliothèque SL8500 se
composent de baies à 14 emplacements et les parois extérieures de baies à 13
emplacements.

Baie de lecteurs Section de la baie de lecteurs contenant un tiroir de lecteurs de bande.

Basculement Déplacement vers un chemin secondaire ou redondant en cas d'échec du
chemin principal.

Bibliothèque à domicile Bibliothèque qui fournit l'alimentation, le signal et les lignes de contrôle aux
mécanismes PTP (Pass-Thru Port). Il s'agit de la bibliothèque de droite d'un
complexe de bibliothèques dans la vue de face.

Bibliothèque extérieure Bibliothèque SL8500 toujours située sur le côté gauche d'une Bibliothèque
à domicile, dans la vue de face. La bibliothèque extérieure ne fournit pas
d'alimentation, ne contrôle pas le port PTP et n'en assure pas la récupération.

CAP Voir Port d'accès aux cartouches (CAP, Cartridge Access Port).

Capacité Capacité de stockage de la bibliothèque de bandes. Voir aussi Capacité active
et Capacité installée.

Capacité achetée Nombre total d'emplacements de stockage autorisés pour l'activation. La
valeur est définie par le fichier d'activation de matériel. Voir aussi Capacité
allouée et Capacité active.

Capacité active Nombre d'emplacements de stockage que la bibliothèque est autorisée
à utiliser pour le stockage. Ce nombre ne peut pas dépasser la Capacité
installéeni la Capacité achetée. Identique à Capacité allouée.

Capacité allouée Nombre d'emplacements actifs. La capacité allouée ne peut pas dépasser la
Capacité achetée définie par le fichier d'activation matérielle. Identique à
Capacité active. Voir aussi Capacité non allouée.

Capacité installée Nombre d'emplacements de stockage physiquement présents dans la
bibliothèque.

Capacité non allouée Nombre d'emplacements de stockage disponibles pour l'activation de
capacité. Cette valeur est égale à la Capacité achetée moins la Capacité
allouée.
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Capacité physique Nombre d'emplacements de stockage dans la bibliothèque. Comparer
avecCapacité active.

Cartouche Conteneur de bandes magnétiques qui peut être monté dans un lecteur pour
lire ou écrire des données. La bibliothèque utilise des cartouches de données,
de diagnostic et de nettoyage.

Cartouche de diagnostic Cartouche utilisée pour les routines de diagnostic d'un lecteur.

Cartouche de données Cartouche utilisée pour stocker les données.

Cartouche de nettoyage Cartouche de bande permettant de nettoyer le chemin de bande dans un
lecteur. Les cartouches de nettoyage sont spécifiques du lecteur et doivent
être remplacées après un nombre limité d'utilisations.

Cartouche orpheline Dans les bibliothèques de bandes partitionnées, une cartouche se trouvant
dans un emplacement ou un lecteur non affecté (c'est-à-dire un emplacement
ou un lecteur non affecté à une partition définie). Les cartouches peuvent
devenir orphelines quand les limites de la partition sont modifiées, les
partitions sont supprimées ou les cartouches sont déplacées manuellement
vers des emplacements non affectés ou inaccessibles.

CLI Interface de ligne de commande.

Commutateur de
mécanismes de
verrouillage

Commutateur permettant d'interrompre l'alimentation vers les mécanismes de
la bibliothèque, à l'exception des lecteurs de bande, lorsque la porte avant est
ouverte.

Commutateur ERS
(Emergency Robotics
Stop)

Commutateur situé sur le pavé numérique du CIM qui met totalement hors
tension les robots.

Complexe de
bibliothèques

Deux bibliothèques SL8500 ou plus connectées entre elles à l'aide d'un PTP
(Pass-Thru Port).

Contrôleur de la
bibliothèque

Carte HBC/HBCR de la bibliothèque contrôlant les opérations et établissant
la communication avec le panneau opérateur.

Customer Interface
Module (CIM)

Module frontal de la bibliothèque de bandes SL8500 qui contient le panneau
à écran tactile et qui permet au personnel de maintenance d'accéder aux baies
de la bibliothèque et aux baies de service.

DEM Voir Drive and Electronics Module (DEM).

Drive and Electronics
Module (DEM)

Module d'une bibliothèque SL8500 hébergeant le module de contrôle
du système électronique, les unités de distribution de courant (PDU), les
alimentations électriques, les racks auxiliaires, l'équipement et les lecteurs de
bande pour la bibliothèque. Le module est situé à l'arrière de la bibliothèque.
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dWWN Voir WWN dynamique.

ECM Voir Electronics Control Module (ECM).

Ejection Voir Exportation.

Electronics Control
Module (ECM)

Module incluant les cartes HBK, HBC/HBCR et HBT. ECM qui traite les
commandes à partir d'un assemblage de système hôte, coordonne les activités
des composants de la bibliothèque et surveille les entrées de statut à partir
des capteurs et des commutateurs.

ELS Voir Enterprise Library Software.

Emplacement Emplacement de stockage pour une cartouche dans la bibliothèque.

Emplacement actif Emplacement de stockage pouvant être utilisé pour le stockage de
cartouches.

Emplacement inactif Emplacement de stockage désactivé et ne pouvant pas être utilisé pour le
stockage de cartouches.

Emplacements
sélectionnés

Emplacement de stockage qui ne peut pas actuellement être utilisée pour
le stockage de cartouches, mais qui sera automatiquement activée par le
contrôleur de la bibliothèque lorsque la capacité activée sera augmentée.

Enfichable à chaud Fonctionnalité permettant à un représentant du service technique Oracle
de remplacer un composant système alors que le système est encore
sous tension. Cette fonctionnalité permet d'effectuer des opérations de
maintenance et de mise à niveau matérielles sans interrompre la disponibilité
des sous-systèmes. Par opposition à Remplacement à chaud.

Enterprise Library
Software

Produits logiciels permettant d'automatiser les opérations sur bande pour les
clients du mainframe.

ERS Voir Commutateur ERS (Emergency Robotics Stop).

Exportation La bibliothèque place une cartouche dans un emplacement de CAP afin que
l'opérateur puisse retirer la cartouche de la bibliothèque. Identique à Ejection.

Façade avant Partie externe du module d'interface client, située entre les portes d'accès, qui
contient le pavé numérique et le panneau opérateur local.

Format LTO (Linear Tape
Open)

Ensemble de normes de format de données créé pour permettre l'échange
mutuel de données entre les différents fournisseurs de lecteurs de bande LTO
Ultrium. Ces normes permettent le partage de cartouches de données.

FRU Unité remplaçable sur site.

Get Activité lors de laquelle un robot récupère une cartouche à partir d'un
emplacement ou d'un lecteur.
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HLI/PRC Interface de la bibliothèque de bandes de l'hôte (HLI)/Panneau, ligne,
colonne (PRC)

ID de volume ID de volume affecté à une cartouche. Identique à VOLSER.

Importation Processus d'insertion d'une cartouche dans le port d'accès aux cartouches
afin qu'elle puisse être introduite dans un emplacement de stockage par la
bibliothèque.

Insertion Voir Importation.

Interface de bibliothèque
de bandes primaires (PLI)

Chemin des communications entre le panneau opérateur et le contrôleur de la
bibliothèque.

Interface de transport de
bande (TTI)

Interface permettant de contrôler et de suivre le mouvement des bandes.

LCM Voir Library Content Manager (LCM).

Lecteur de bande Périphérique électromécanique qui déplace une bande magnétique et met en
oeuvre des mécanismes d'écriture et de lecture de données depuis et vers la
bande.

Lecteur de bande virtuel
(VTD, virtual tape drive)

Emulation d'un transport physique dans le VTSS semblable à un transport
de bandes physique vers le MVS. Les données écrites dans un VTD sont
réellement écrites dans le périphérique de stockage d'accès direct (DASD).
Le VTSS comporte 64 VTD effectuant des montages virtuels de VTV.

Library Content Manager
(LCM)

Logiciel assurant la gestion du contenu pour les environnements mainframe
de bandes automatisés. Fonctionne avec le composant logiciel de l'hôte, un
gestionnaire de stockage virtuel et votre système de gestion de bandes.

LTO Voir Format LTO (Linear Tape Open).

Magasin Baie amovible contenant des cartouches et placée dans le port d'accès aux
cartouches (CAP).

MIR Media Information Region (MIR). Sorte de plan ou de répertoire de
l'emplacement des données utilisateurs sur le média physique. Cette
fonctionnalité permet au lecteur d'optimiser l'accès aux données utilisateur,
et d'économiser ainsi un temps précieux lors de l'accès aux données. Les
données MIR se trouvant sur une bande chiffrée ne sont pas chiffrées.

Module contrôleur avant Module hébergeant le contrôleur pour les ascenseurs, les CAP, les plaques
tournantes et les barrières de sécurité.

Module de stockage
de bibliothèque (LSM,
Library Storage Module)

Composant de bibliothèque connecté à d'autres LSM d'un complexe de
bibliothèques par un PTP. Identique à un rail SL8500.
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N+1 Configuration d'alimentation standard qui assure la redondance de
l'alimentation CC en ajoutant une alimentation de partage de charge à chaque
réseau électrique CC. Il y a une alimentation pour deux robots plus une
alimentation redondante et une alimentation pour huit lecteurs plus une
alimentation redondante. Il y a deux PDU : une PDU système et une PDU N
+1. Seuls les racks auxiliaires 2 et 4 sont alimentés. Voir aussi 2N.

Panneau opérateur Voir Panneau opérateur tactile.

Panneau opérateur de la
bibliothèque

Voir Panneau opérateur tactile.

Panneau opérateur tactile Affichage à écran plat avec interface à écran tactile et ordinateur monté sur
panneau. Cette fonctionnalité est intégrée à l'avant de la bibliothèque.

Pavé numérique Interface située sur le CIM. Le pavé numérique contient les boutons
d'ouverture/de fermeture de CAP, les verrous de la porte de sécurité et le
bouton ERS.

PDU Voir unité de distribution de courant (PDU, Power Distribution Unit).

Piste Chemin horizontal parcouru par un robot.

PLI Voir Interface de bibliothèque de bandes primaires (PLI).

Port d'accès aux
cartouches (CAP,
Cartridge Access Port)

Port bidirectionnel intégré au panneau de la porte de la bibliothèque utilisé
pour importer ou exporter des cartouches.

Porte d'accès Porte située de chaque côté du CIM permettant au personnel d'accéder à la
bibliothèque.

Porte de sécurité de
service (SSD)

Barrière motorisée qui se lève et se baisse. Cette porte sépare les zones de
maintenance de l'assemblage d'interface avant du reste de la bibliothèque.
La porte SSD permet au personnel de service de réparer ou de remplacer des
mécanismes de la bibliothèque en toute sécurité alors que la porte d'accès
avant est ouverte et fermée sans nuire à la plupart des opérations en cours
dans la bibliothèque.

PTP Voir PTP (Pass-Thru Port).

PTP (Pass-Thru Port) Périphérique électromécanique qui permet à un module de stockage
d'une bibliothèque de faire passer une cartouche à un autre module de
stockage de bibliothèque adjacent dans le même complexe. Un Complexe
de bibliothèques est un groupe de bibliothèques connectées via des PTP. Les
bibliothèques SL8500 sont reliées par quatre PTP, car il y a quatre rails. Voir
aussi Bibliothèque à domicile et Bibliothèque extérieure.
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Put Activité au cours de laquelle un robot place une cartouche dans un
emplacement ou un lecteur.

Rail (1) Partie de l'ensemble de pistes supérieur du robot qui fournit l'alimentation
et les communications au robot. (2) Tous les emplacements et lecteurs de
cartouche accessibles par le biais d'un rail.

RE Voir Redundant Electronics (RE).

Redundant Electronics
(RE)

Fonctionnalité offrant une protection par basculement dans les bibliothèques
d'entreprise. RE utilise deux ensembles de cartes contrôleurs de la
bibliothèque. A tout moment, un ensemble est actif tandis que l'autre fait
office d'ensemble de secours. Le contrôleur de bibliothèque actif peut
basculer vers le contrôleur de secours en réponse à une commande du logiciel
ACSLS ou de SLC. Le basculement automatique peut être initié par la
bibliothèque en cas d'échec d'une carte de la bibliothèque.

Remplacement à chaud Retrait et remplacement d'un composant système alors que le système est
sous tension et que des opérations sont en cours.

Remplacement en ligne Remplacement ou maintenance d'un module alors que des opérations sont en
cours dans la bibliothèque. Le technicien peut être contraint de mettre hors
tension le module avant de le retirer ou de le remplacer.

RIM Voir Robotics Interface Module (RIM).

Robot Mécanisme de déplacement horizontal le long d'une piste pour le transport
des cartouches de bandes depuis et vers d'autres emplacements de la
bibliothèque.

Robotics Interface Module
(RIM)

Module contenant les rails courbés et les assemblages de PTP (Pass-Thru
Port).

sous-système de stockage
de bandes virtuel (VTSS,
virtual tape storage
subsystem)

Tampon du DASD contenant des volumes virtuels (VTV) et des lecteurs
virtuels (VTD). Le VTSS est un périphérique matériel STK RAID 6
avec microcode pris en charge permettant l'émulation de transport. Le
périphérique RAID peut lire et écrire des données de bande depuis/vers un
disque et lire et écrire des données depuis/vers un RTD.

TCP/IP double Fournit deux connexions hôtes distinctes entre le logiciel hôte (ACSLS ou
HSC) et le contrôleur de la bibliothèque.

TCP/IP multiple Utilisation des connexions TCP/IP vers plusieurs bibliothèques afin de
fournir des chemins de communication redondants entre le logiciel hôte
(ACSLS ou HSC) et un Complexe de bibliothèques SL8500.

Tiroir de lecteur Châssis métallique, câbles, cartes électroniques et lecteur de bande utilisés
pour interfacer le lecteur de bande vers la bibliothèque de bande. Le tiroir de
lecteurs contient la carte de contrôleur des lecteurs (HBD ou LOD).
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TTI Voir Interface de transport de bande (TTI).

unité de distribution de
courant (PDU, Power
Distribution Unit)

Périphérique permettant de distribuer l'alimentation CA du réseau à partir
d'un seul collecteur vers plusieurs prises de courant. Plusieurs unités de
distribution de courant CA fournissent une disponibilité optimisée car
l'alimentation est maintenue si l'une de ces unités (ou leur autre source de
courant si elles utilisent des sources CA distinctes) n'est plus alimentée.

Virtual Storage Manager
(VSM, gestionnaire de
stockage virtuel)

Solution de stockage permettant de virtualiser des volumes et des transports
dans le tampon d'un sous-système de stockage de bandes virtuel en vue d'une
utilisation des médias et du transport améliorée.

Virtual Tape Control
System (VTCS, système de
contrôle de bandes virtuel)

Code de l'hôte primaire permettant de contrôler l'activité et les informations
relatives aux VTSS, VTV, RTD et MVC.

VOLSER Numéro de série du volume. Identique à ID de volume.

Volume de bande virtuel
(VTV)

Partie du tampon du DASD reconnue comme un volume de bande réel par le
système d'exploitation. Les données sont écrites et lues à partir du VTV et le
VTV peut être migré vers et rappelé à partir d'une bande réelle.

VSM Voir Virtual Storage Manager (VSM, gestionnaire de stockage virtuel).

VTCS Voir Virtual Tape Control System (VTCS, système de contrôle de bandes
virtuel).

VTD Voir Lecteur de bande virtuel (VTD, virtual tape drive).

VTSS Voir sous-système de stockage de bandes virtuel (VTSS, virtual tape storage
subsystem).

World Wide Name
(WWN, nom universel)

Adresse 64 bits qui identifie de façon unique chaque périphérique et
fournisseur ; il est comparable à l'adresse MAC d'une interface Ethernet.
Chaque port d'un réseau Fibre Channel doit posséder un nom universel
WWN unique. Le nom universel WWN n'est pas simplement une adresse
matérielle physique. Il sert également d'adresse logique pour les noeuds de
réseau SAN. La configuration du réseau SAN est modifiée dès lors que le
matériel relié est modifié. Si un périphérique défectueux est remplacé, le nom
universel du noeud change et force ainsi la reconfiguration du réseau SAN.
Il existe trois noms universels pour les différentes baies de lecteurs : noeud,
port A et port B.

WWN Voir World Wide Name (WWN, nom universel).

WWN dynamique Lorsque cette fonction est activée, dWWN nomme les emplacements de
lecteur de la bibliothèque de bandes au lieu des périphériques. Si un lecteur
est remplacé, le nouveau lecteur se voit attribuer le même nom que celui
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qu'il remplace, ce qui élimine la nécessité de devoir reconfigurer le système.
dWWN attribue des noms aux différents emplacements de lecteur de bande
plutôt qu'aux périphériques.

Zone de maintenance Zone située entre les portes d'accès du module d'interface client et la barrière
de sécurité. Dans la zone de maintenance, un robot redondant ou inutilisable
peut être stocké à des fins de maintenance et d'autres mécanismes peuvent
être réparés ou remplacés.

Zone de stockage de
bandes

Zone de la bibliothèque où les cartouches sont stockées.



158



Index · 159

Index
A
ACSLS

Fonctionnalité TCP/IP double et configuration
High Availability, 130
Fonctionnalité TCP/IP double et routage High
Availability, 130
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Téléchargement, 23
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Statut, 62
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Arrêt d'urgence de la robotique
Utilisation, 89
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Audits
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physiques, 57, 57, 58
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Vérifié, 58

Autotests
Bibliothèque, 79, 79, 79
CAP, 79

Robot, 79
Autotests de la bibliothèque, 79

Exécution, 79, 79

B
Basculement de la bibliothèque en ligne, 74
Basculement de la bibliothèque hors ligne, 73
Bibliothèque

Entrée dans la bibliothèque, 88
Mise en ligne, 74
Mise hors tension, 87, 87
Montage d'une cartouche, 89
Partitions

Opérations sur les CAP, 41
Placement en mode manuel, 73
Précautions d'entrée, 88

C
CAP

Affichage des informations de synthèse, 62
Affichage des propriétés, 62
Affichage du statut, 62
Autotest, 79
Fermeture, 41
Insertion de cartouches, 39
Mise en ligne, 74
Mise hors ligne, 74
Mode manuel, 43
Modes, 43
Partitions de la bibliothèque, 37
Réservations, 37

CAP manuel, 43
Capacité

Activation, 
Bibliothèque non partitionnée, 27
Bibliothèque unique, 27, 28
Complexe de bibliothèques, 28
Hôtes HLI, 30

Capacité active, 
Bibliothèque unique, 27, 28
Complexe de bibliothèques, 28
Hôtes HLI, 30
Rapports, 68

Cartouches
Affichage des informations, 68
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Déplacement depuis un emplacement spécifique,
47
Déplacement par ID de volume, 47
Déplacements de récupération, 47
Ejections, 40
Insertion dans le CAP, 39
Insertion dans une cellule ou un lecteur, 51
Insertions, 39
Inspection, 51
Liste, 68
Localisation par adresse, 48, 48
Localisation par ID de volume, 48, 48
Manipulation, 51
Montage, 89
Nettoyage de la partie extérieure, 51
Non étiquetées, 51
Orphelines, 30
Stockage, 52

Cartouches de diagnostic
Autotests de la bibliothèque, 79
Description, 49
Exportation, 50
Importation, 49
Tâches de gestion, 49

Cartouches de nettoyage, 51
Cartouches orphelines, 30

Bibliothèques partitionnées, 38
Clé

Ouverture des portes d'accès avant, 88
Codes de résultat

Etablissement de la liste, 70
Complexe de bibliothèques

Affichage du statut, 61
Localisation des cartouches, 48
Propriétés, 62

Configuration de la bibliothèque
Affichage, 62

Contrôleur de la bibliothèque
Affichage de Redundant Electronics, 63, 63
Propriétés, 62

Contrôleur des lecteurs, 62

D
Dépannage, 77
Déplacements de récupération, 47
Diffusions de réseau, 126

E
Ecrans de contrôle des événements

Affichage, 70
Mise en attente de données dans un fichier, 70
Tâches, 70

Entrée dans la bibliothèque, 88

F
Fichier d'activation de matériel

Affichage des fonctionnalités actuelles, 24
Fichier d'instantané de journal

Processus de génération, 69
Processus de transfert, 69

Fichier MIB
Processus de transfert, 69

Fichiers de diagnostic pour le support, 69
Fonctionnalités activées

Affichage des fonctionnalités actuelles, 24
Capacité, 
Fichiers, 23
Partitionnement, , , 
Redundant Electronics, , 

I
ID de connexion, 22
Inondations ARP, 126
Installation

Fichier d'activation de matériel, 24
Interface HLI

Affichage du statut des ports, 61
Interfaces hôtes

HLI. Voir Interface HLI., 61

J
Journaux

Journal d'audit des fonctionnalités, 68

L
Lecteurs

Affichage des informations de synthèse des
lecteurs, 63
Affichage des propriétés des lecteurs, 63
Affichage du statut, 63
Données de réseau, 63
Mise en ligne, 74
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Mise hors ligne, 74
Mise sous tension et hors tension, 87
Montage d'une cartouche, 89
Statut des voyants, 63

Liaison des ports, 61

M
Mises à niveau du microprogramme de la
bibliothèque, 

Activation, 135
Téléchargement, 135

Mises en garde
Solvants pour le nettoyage d'une cartouche, 52

Mode d'insertion automatique, 43
Mode manuel

Entrée dans la bibliothèque, 88
Montage d'une cartouche, 89
Placement de la bibliothèque en mode manuel, 73
Restrictions physiques, 88

Mots de passe
Activation, 21
Modification, 22

N
Nettoyage des lecteurs

Description, 45

O
Opérations d'éjection, 40
Opérations d'insertion, 39
Opérations manuelles

Précautions de sécurité, 88
Générales, 88

Oracle Technical Network, 15
OTN, 15

P
Panneau opérateur local

Alignement d'usine, 84
Connexion, 22
Réétalonnage, 84

Partitionnement, , , 
Partitions

Présentation, , , 
Partitions de la bibliothèque

Cartouches orphelines, 38

Réservations des CAP, 37
Suppression, 34

Placement de la bibliothèque en mode manuel, 73
Porte d'accès principal

Audits, 59
Porte de sécurité

Fonctionnement, 90
Informations de synthèse, 62
Propriétés, 62
Tâches de surveillance, 62

Ports
Statut, 61

Ports PTP (Pass-thru Port)
Localisation des cartouches, 48

Précautions de sécurité, 88
Générales, 88

PTP
Propriétés, 62
Statut, 62

Public, 15

R
Rapport

Capacité activée, 68
Cartouches orphelines, 68

Rapport sur les événements de lecteur, 67
Rapport sur les événements de média de lecteur, 67
Rapport sur les statistiques d'événements généraux,
68
Rapports

Evénements de lecteur, 67
Journal d'audit des fonctionnalités, 68
Récapitulatif des cartouches, 68
Tableau des cartouches, 68

Rapports SL Console
Evénements de lecteur, 67
Evénements de média de lecteur, 67
Evénements généraux, 68

Rapports sur la bibliothèque
Affichage, 67
Enregistrement des données dans un fichier, tâches
de rapport de SL Console, 67
Recherche, 67

Redundant Electronics
Basculement manuel, 84
Tâches, 63



162
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Bibliothèque, 75
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Affichage des informations de synthèse, 62
Affichage du statut, 62
Autotest, 79
Basculement en ligne, 74
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Propriétés, 62
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S
SL Console

Accès initial, 21
ID de connexion, 22
ID utilisateur, 22
Modification des mots de passe, 22
Mot de passe d'activation, 21, 21
Problèmes de communication, 64
Sécurité, 22

SL Console autonome
Connexion, 21

SLConsole
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Présentation, 
Téléchargement, 17
Web, 19

SLConsole autonome
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SLConsole Web
Connexion, 21
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Présentation, 19, 19
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Transfert du fichier MIB de la bibliothèque, 69
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Affichage, 61

Statut des périphériques
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Suppression

Activation de matériel, 24
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TCP/IP double

Définition, 125
Routage d'ACSLS, 129
Sous-réseaux distincts d'ACSLS, 129
Tâches de configuration, 126

TCP/IP multiple
Recommandations concernant la configuration,
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Téléchargement
Activation de matériel, 23

Tiroirs des lecteurs
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Transfert du fichier d'instantané de journal, 69

U
User ID (ID utilisateur)

Types, 22
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